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CHAPTER 1

Becoming Familiar with Parallels Plesk
Panel
Parallels Plesk Panel offers an easy and convenient graphical user interface that
enables you to start your hosting business quickly and maintain it effortlessly. With
Panel, you set up your hosting offers, manage customer accounts, and do other tasks
to run and grow your business. Your customers benefit from using Panel too since it
gives them a complete set of tools for creating and editing their websites. For serving
both resellers and customers, the Panel GUI is divided into two parts:




Server Administration Panel.
In this panel, you set up and maintain your business. Here you create hosting plans
and customer accounts, manage subscriptions, and so on. For a comprehensive
overview of operations available to you in the Server Administration Panel, see the
section Acquainting Yourself with the Panel Interface (on page 7).
Control Panel.
When someone subscribes to one of your hosting plans, Panel sets up an account
for the subscriber. Under this account, the customer can add domain names and
mailboxes, edit website content, and carry out other hosting management routines.
Customers perform these operations in a separate panel called the Control Panel.
To learn more about operating in the Control Panel, refer to the section Website
Management (on page 55).

So, after logging in to Panel, customers see the Control Panel while resellers see the
Server Administration Panel. This is for convenience, to separate the administration of
customer accounts from administration of websites and hosting services.
However, you will need to go to the Control Panel in the following cases:


To assist customers with performing their tasks. In this case, you log in to the
Control Panel on a customer's behalf.



To create and manage your own websites. In this case, you create your own
subscription and log in to the Control Panel using your account.

The links that let you log in to the Control Panel using your own and your customers'
accounts are located in the list of subscriptions (Server Administration Panel > Hosting
Services group of the navigation pane > Subscriptions.)
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Your Panel Account and Subscriptions
When you subscribe to a reseller plan, you get a reseller account in Panel. This
account stores your profile information and is linked to your subscription - the package
of hosting resources that you lease for reselling and use for your own needs.
Your account has a unique username and a password that you use to log in to Panel.
You can change these at any time. The section Managing Your Profile (on page 9)
explains how to do it.
To allow you to easily monitor the current state of your resources and services (for
example, disk space currently consumed by your account and your customers), Panel
automatically calculates the resource usage and displays it to you on the appropriate
pages. To learn how to track the usage of your hosting resources and services, refer to
the section Viewing Your Subscription Properties (on page 10).

In this chapter:
Acquainting Yourself with the Panel Interface.................................................... 7
Managing Your Profile ....................................................................................... 9
Viewing Your Subscription Properties................................................................ 10
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Acquainting Yourself with the Panel Interface
When you log in to Parallels Plesk Panel, you see the Home page with a summary on
allocated and used resources.
The top banner area provides the following links:


A link with your name. Click this if you need to update your contact information. Find out
more about updating contact information in the section Managing Your Profile (on page 9).



Log out. This is where you close your session when you have finished working with the
Panel.



Help. This provides context-sensitive help with a search function.

The navigation pane on the left provides access to the following sets of functions:




Home. This is where you start working with the Panel. On this page, you can see the
following elements.


Overview. This widget contains information about your hosting package and provides
links to the detailed information about available hosting resources and your
permissions. The section Viewing Your Subscription Properties (on page 10) provides
information that helps you understand the Panel resources and learn how to view the
set of resources that you can use or sell.



My Subscriptions. This is where you see a list of your own websites hosted on the
Panel server.

Customers. This is where you perform operations on customer accounts. Particularly, you
can accomplish the following tasks from this page:


Create, modify, suspend, unsuspend, and remove user accounts.



View traffic usage reports.



Domains. This is where you view information about hosted websites and their domain
names, and go to the Control Panel for managing them.



Subscriptions. This is where you manage customer subscriptions to your services.
Subscription is a way a customer obtains services and resources provided by a service
plan.



Service Plans. This is where you manage your service plans. Service plan is a set of
resources and services provided to hosting service customers by means of subscriptions.
There are also service plan add-ons that extend the amount of resources and services
provided with a subscription.



Tools & Utilities. This is where you configure and manage system services, and view
resource usage statistics.



Profile. This is where you fill in your contact information. Learn more about the contact
information and other profile settings in the section Managing Your Profile (on page 9).



Change Password. This is where you change your password for logging in to the Server
Administration Panel.



Interface Preferences. This is where you set interface language and skin. Learn more about
changing Panel appearance in the section Changing Interface Settings.
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To see information about a tool or an item on the page, place the mouse pointer over an item
without clicking it, and a small tooltip box appears with supplementary information regarding
that item.
The main working area on the right provides access to the tools available for the section
currently selected in the navigation pane. Additional operations are accessible from the More
Actions menus.
To navigate through Parallels Plesk Panel, you can use a path bar: a chain of links that
appears in the right part of the screen, below the banner area.
To return to a previous screen, use the shortcuts in the path bar, or the Up Level icon in the
upper-right corner of the screen.
To sort a list by a certain parameter in ascending or descending order, click on the
parameter's title in the column heading. The order of sorting will be indicated by a small
triangle displayed next to the parameter's title.
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Managing Your Profile
Your account in Panel stores your access credentials and contact information such as e-mail,
address, and phone number. Depending on how you subscribed to a Panel reseller plan, you
can choose your username and password yourself or receive them from your hosting
provider. To change your account password, click the Change Password link in the navigation
pane. Your username can only be changed by your provider. If you forget your password and
cannot log in to Panel, click the Forgot Your Password? link on the login page. Then enter your
username and the e-mail specified in your contact information into the corresponding fields.
When you fill in this information, Panel will send your password to the specified e-mail
address.
If the contact details in your profile require updating, or you want to add or remove some of
them, click the Profile link in the navigation pane or the link with your name at the top of the
page and Panel will take you to a page where you can manage the details.
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Viewing Your Subscription Properties
The number of hosting resources and services available to you for reselling or to use for your
own needs is defined by your reseller subscription. A subscription can limit the use of a
resource to a certain value, for example, allow you to consume 75 GB of disk space.
Alternatively, it can allow a resource to be used without limits. In addition, the subscription
defines what services you can use and what server management actions you can perform:
manage DNS zones, access application catalogs, and so on.
To view the information about your subscription, click the My resources and permissions overview
link on the Home page.
The subsections of this section tell you more about reseller subscription properties:


Panel resources sold in reseller subscriptions: Section Viewing Resources (on page 11).



Permissions and services: Section Viewing Permissions (on page 13).



IP Addresses: Section Viewing IP Addresses (on page 14).

Next in this section:
Viewing Resources............................................................................................ 11
Viewing Permissions ......................................................................................... 13
Viewing IP Addresses ....................................................................................... 14
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Viewing Resources
This section lists Panel resources included in reseller subscriptions. To view the resources
allotted for your account, go to Home > My resources and permissions overview.
Overselling policy
Defines if you can sell more resources than allocated to you with the plan. If overselling is
allowed, you are governed by actual resource usage instead of initial resource allocation. If
overselling is prohibited, you can create only the number of service subscriptions limited to
the total amount of disk space or traffic provided to you with your plan.
Overselling is a marketing strategy based on the following scheme: a reseller, who was
allotted, for example, ten gigabytes of disk space, allocates five gigabytes of disk space for
each of their customers, assuming that none of them will actually use all of their allocated
disk space.
Domains
The total number of subscriptions that you can create for your customers and for your own
purposes.
Subdomains
The total number of subdomains that can be hosted within the subscription.
Domain aliases
The total number of additional alternative domain names that can be used for websites within
the reseller subscription.
Disk space
The total amount of disk space that can be used by your own websites and sites of your
customers. It includes disk space occupied by all files related to your reseller subscription:
contents of websites, databases, applications, mailboxes, log files and backup files.
Traffic
The amount of data that can be transferred from the subscription's websites and FTP/Samba
shares during a month.
Additional FTP accounts
The maximum number of FTP accounts used to access the files and folders hosted with a
subscription.
Databases (Unix hosting)
The total number of databases that can be created on the Panel database servers and used
by the subscription's websites.
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MySQL databases and Microsoft SQL Server databases (Windows hosting)
The maximum number of MySQL and Microsoft SQL Server databases respectively that can
be created on the database servers registered in the Panel and used by websites hosted
with the subscription.
MySQL databases quota and Microsoft SQL databases quota (Windows hosting)
The maximum total amount of disk space (in megabytes) that the MySQL and Microsoft SQL
Server databases respectively can occupy.
Mailboxes
The total number of mailboxes that can be hosted within the subscription.
Mailbox size
The maximum amount of disk space that can be allocated to a mailbox for storing e-mail
messages and auto-reply attachment files. You will not be able to specify the bigger mailbox
size in your service plans.
Mailing lists
The total number of mailing lists that can be hosted with the subscription.
Customers
The maximum number of customer accounts that you can create and serve.
Web users
The total number of personal web pages that can be hosted on the websites within
subscription. This service is mostly used in educational institutions that host non-commercial
personal pages of their students and staff. These pages usually have addresses like
http://example.com/~webuser.
Java applications
The total number of Java applications or applets that can be hosted on websites within the
subscription
Sites published with Presence Builder
The total number of websites that can be created, published, and then edited with Presence
Builder.
Mobile sites
The total number of websites that can be hosted with the UNITY Mobile online service, which
optimizes sites for viewing on mobile devices.
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FrontPage accounts (Windows hosting)
The maximum number of Microsoft FrontPage accounts that can be used within the
subscription.
Shared SSL links (Windows hosting)
The total number of shared SSL links that can be used within the subscription.
IIS application pools (Windows hosting)
The total number of dedicated IIS application pools that can be allocated for websites
created within the reseller subscription.
ODBC connections (Windows hosting)
The total number of ODBC connections that can be used within the subscription.
ColdFusion DSN connections (Windows hosting)
The total number of ColdFusion DSN connections that can be used within the subscription.

Viewing Permissions
Your permissions either denote the operations available to you as a reseller in the Panel, or
define which services and privileges can be enabled in the subscriptions of your customers.
If a particular permission in your reseller subscription is set to Off, then a service subscription
will not provide the corresponding service or a privilege. A disabled permission also means
that you are prohibited to perform the designated action in the Control Panel. For example, if
your subscription does not provide a privilege to use Scheduler (Scheduler management is Off),
then none of your subscribers will be able to use it, and neither will you.
Reseller-specific privileges (the ones that do not affect service subscriptions you create for
your customers) are as follows:


Subscription creation in Server Administration Panel and domain creation in Control Panel. Shows
whether you can create hosting service subscriptions, add domains, create websites, and
set up web forwardings.



Ability to use API RPC. Shows whether you can remotely manage Web sites through
custom applications. The remote API is an interface that can be used for developing
custom applications integrated with Web sites, which could be used, for instance, for
automating setup of hosting accounts and provisioning of services for customers
purchasing hosting services from your site. To learn more, refer to the Parallels Plesk Panel
11.5: API RPC Protocol Reference.



Access to the Panel. Shows that you can use the Panel graphical user interface.



Customer account creation. Lets you create user accounts and subscriptions for your
customers in the Panel.



Allow overselling. Lets you set up oversell policy, meaning that you yourself can define if
overselling is allowed to you or not.
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Overselling allows you to sell more resources than is allocated with a plan. If overselling
is allowed, a reseller is governed by actual resource usage instead of initial resource
allocation. Overselling is a marketing strategy based on the following scheme: a reseller,
who was allotted, for example, ten gigabytes of disk space, allocates five gigabytes of
disk space for each of their customers, assuming that none of them will actually use all of
their allocated disk space.
Meanings of the other permissions are the same as in the service subscriptions (on page
24).
To view the full list of your subscription permissions, go to Home > My resources and
permissions overview > Permissions tab.

Viewing IP Addresses
To view the IP addresses included in your hosting package, go to Tools & Utilities > IP
Addresses. Your IP addresses are listed and the following supplementary information is given:


An icon in the S (Status) column shows
if your IP address is properly configured on
the network interface. If your IP address was removed from the network interface by your
provider, an icon will show .



An icon in the T (Type) column shows
if you were allotted a dedicated IP address, and
if the address is shared among other customers of your service provider. A dedicated
IP address is not used by other users, so you can use it to host either:


A single e-commerce website secured with Secure Sockets Layer encryption.

or


A number of websites that do not need Secure Sockets Layer encryption.

Note: Shared IP addresses should be used for hosting only non e-commerce websites.


The Certificate column shows which SSL certificate (for what domain name) is tied to an
IP address.



The FTP over SSL column (on Windows-based servers) shows whether it is possible to use
secure FTP connection (FTP over SSL) on one of the domains hosted on this IP address.



The Hosting column shows a number of websites hosted on an IP address. To view the
domain names of these websites, click the number in the Hosting column.

You can perform the following operations on IP addresses:


Change IP allocation type. You can mark your IP addresses as shared or dedicated
before you use them for hosting websites. This allows the Panel to distinguish between
them and to not let you use a dedicated IP address for several customers at once. A
dedicated IP address can be used in subscriptions of a single customer, while a shared
IP address can be shared among different customers' subscriptions. Note that SSL
protection with authentic digital certificates and Anonymous FTP services are available
only to a dedicated hosting account on a dedicated IP address. Shared hosting accounts
can also have SSL protection, but visitors of such protected sites will receive error
messages in their browsers.



Assign an SSL certificate to an IP address. This will assign the selected SSL certificate to
all websites hosted on that IP address.
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Select a default website. Because users can refer to a web resource on your server by
typing an IP address and there can be several websites hosted on that address, the
Panel needs to know which of the sites to show in such cases. The Panel automatically
assigns the first website created on an IP address as the default website; however, you
can select any other website and make it default.

 To change an IP address allocation type (shared, dedicated), assign another
SSL certificate to an IP address, or select the default website:
1. Go to Tools & Utilities > IP Addresses, and click the IP address you need.
2. Make the required changes, and click OK.
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CHAPTER 2

Understanding Service Plans and
Subscriptions
When you start your hosting reselling business, you should define how you will offer
your hosting resources and services to customers. Parallels Plesk Panel lets you
organize your business by means of service plans and subscriptions.
A service plan is a combination of hosting resources that you sell to your customers.
For example, a plan can provide customers with the web hosting service, five gigabytes
of disk space on the server, and ten gigabytes of data transfers each month.
There are also add-on plans that let you offer additional resources and services to
subscribers, such as, for example, an additional gigabyte of disk space.
When customers want to host a website on a Panel-managed server, they subscribe to
a plan that offers the resources they need. In other words, a subscription is a set of
resources defined by a plan and available to a certain customer.
The section Properties of Hosting (Add-on) Plans and Subscriptions provides a complete list
of Panel server resources and services that you can include in your hosting plans.

Allocation of Resources and Services
Service plans define potential services; the Panel does not check if a service or a
resource that a service plan should provide is actually available, whether in the system
in general or in your reseller subscription. For example, when creating a plan, you can
choose to allow subscribers to connect to the server shell over SSH even if your
subscription does not provide the Management of access to the server over SSH privilege. In
such a case, the Panel will let you do this and will show no error or warning messages.
Subscriptions provide actual resources and services that are allocated during the
creation of each subscription.
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Relations Between Subscriptions and Service/Add-on Plans
Normally, a subscription is associated with a service plan, and this association is
reflected in a list of subscriptions: each subscription name contains the service plan
name in parentheses at the end. The amount of resources and services provided with a
subscription can be extended by associating the subscription with add-on plans. A
subscription can be associated with several add-ons, but each add-on can be added to
the subscription only once.
It is also possible to have subscriptions that are not associated with any service plans
or add-on plans. We call such subscriptions custom subscriptions, and their names are
extended with "(Custom)" in the list of subscriptions. Having a custom subscription may
be useful if you want to provide services on specific terms that differ from the usual
offerings in your business model.
At any time, you can change the association between a subscription and plans in the
following ways:



Associate the subscription with another service plan.
Add and remove add-on plans.



Remove the subscription association with the service plan and add-ons.

Syncing Service Plans and Subscriptions
When you change the properties of a service plan, Panel automatically applies the
changes to all subscriptions to this plan. If you want to prohibit automatic updating of a
certain subscription, you can lock this subscription. To learn how to configure the
synchronizing (or syncing) of your plans with subscriptions, see the section Syncing
Subscriptions and Plans (on page 40).

In this chapter:
Properties of Hosting Plans, Add-ons and Subscriptions ................................... 18
Syncing Subscriptions and Plans ...................................................................... 40
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Properties of Hosting Plans, Add-ons and
Subscriptions
Properties of a hosting plan and subscription are grouped as follows:


Resources
Includes validity period, policy on overusing resources, system resources like disk space
and traffic, and service resources like websites, subdomains, mailboxes, databases and
so on.



Permissions
Includes provided services and privileges.
Note: Some permissions prevent settings of the following services from syncing (on page
40). See the details in the Permissions section (on page 24).



Hosting Parameters
Includes parameters of the provided hosting service.



Mail
Includes parameters of the provided mail service.



DNS
Specifies if the DNS zones of the subscription's domains should be master or slave.
Note: In case the DNS zone management privilege is provided, this parameter is not synced,
and subscribers can set up this parameter on a per-domain basis.



Performance
Includes parameters that affect performance of all services provided with the plan.



Logs & Statistics
Includes settings of how statistics and logs of the plan's subscriptions should be stored.

Note: Hosting, Mail, DNS, Performance, Logs & Statistics parameters are fully visible and editable
in the Administrative Panel only for service plans. For subscriptions, these parameters are
available only in the Control Panel. To view or modify the parameters of a particular
subscription, go to Subscriptions and click Control Panel to the right of the subscription name.
Also note that the availability of these parameters to a subscriber depends on the
permissions.


Applications
Lets you select which applications available to you should be provisioned to your
customers.

Next in this section:
Visibility of Hosting Features in the Control Panel ............................................. 20
Resources ......................................................................................................... 20
Permissions....................................................................................................... 24
Hosting Parameters........................................................................................... 28
Mail ................................................................................................................... 37
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DNS .................................................................................................................. 38
Performance...................................................................................................... 38
Logs & Statistics ................................................................................................ 39
Applications ....................................................................................................... 39
Additional Services ............................................................................................ 39
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Visibility of Hosting Features in the Control Panel
Since version 10.4, Panel hides from customers those hosting features that are not provided
in their subscription. The visibility of GUI elements responsible for a certain feature is
determined by permissions and resource limits of a subscription. Note that when you (as the
administrator) log in to the customer's Control Panel, you see GUI elements regardless of
customer's permissions. The table below explains GUI visibility logic.

Resource Limit > 0

Visible to a
Customer

Visible to the
Administrator

Yes

Yes

No

Yes

No

No

No

No

Permission = True
Resource Limit > 0
Permission = False
Resource Limit = 0
Permission = True
Resource Limit = 0
Permission = False

For example, when the number of Domains in a subscription is 10 and the Domains management
permission is off, a customer does not see the Add New Domain button in the Control Panel.
Nevertheless, this button is available to the administrator that logs in to the customer's
Control Panel.

Resources Without Numerical Limits
If the resource type is logical or in other words, it can be just switched on or off (such as
scripting language support), its visibility is controlled by a certain permission only. For
example, if the Hosting settings management permission is granted, a customer is able to toggle
the support of various scripting languages for their site. If the permission is not granted, the
customer sees the list of languages that are switched on for their site in the read only mode.
The disabled languages are not shown in the list.
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Resources
Resources (located at Service Plans > select a plan > Resources tab) define what system
resources are provided with the subscription.
Overuse policy
Defines what happens if the subscription's usage of disk space and traffic reaches limit
values:


Overuse is not allowed will suspend the subscription only if you select the checkbox Suspend
subscription when its disk space or traffic usage goes beyond the limit. If you do not select it,
websites will not be suspended; only a notice will be sent to the subscribers.
You can set up sending of notifications as soon as usage of disk space or traffic reaches
a particular value (the Notify upon reaching options), in order to prevent subscriptions from
suspension. The notifications will be sent according to the server notifications policy.



Overuse is allowed will let the subscription operate properly.
The option When limit on usage of a resource is reached, send e-mail according to the server
notification settings triggers sending notifications according to the server notifications
policy.

Note: The overuse policy does not apply to the limits set on size of mailboxes. Therefore,
even if you enable overuse, be sure to allocate enough disk space to mailboxes.
Disk space
The total amount of disk space allocated to the subscription. It includes disk space occupied
by all files related to the subscription: content of websites, databases, applications,
mailboxes, log files, and backup files.
Traffic
The amount of data that can be transferred from the subscription's websites and FTP/Samba
shares during a month.
Notify upon reaching
Available only if overuse is not allowed. This sets the soft quota for disk space or traffic
usage in order to prevent subscriptions from suspension. When the quota is reached, the
Panel sends notifications to users' e-mail addresses specified in Settings > Notifications:
Resource usage limits exceeded by subscription.
Sites published with Presence Builder
The number of websites that can be published with Presence Builder.
Domains
The total number of domain names that the subscriber will be able to host within the
subscription. This includes websites, web forwarding configurations that point to websites
hosted on other servers, and domain names on which a website or web forwarding is not yet
set up (domains with no hosting).
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Mobile sites
The total number of websites that can be hosted with the UNITY Mobile online service, which
optimizes sites for viewing on mobile devices. UNITY Mobile hosts the optimized site copies
on their own servers.
How it works:
1. A user creates a website with the domain name example.com and clicks the link Create
Mobile Site in the Control Panel.
2. The user is prompted to specify a domain name for access to the mobile site copy. The
user specifies mobile.example.com.
3. The Panel connects to the UNITY Mobile hosting servers, sets up an account with UNITY
Mobile for the domain name mobile.example.com.
4. The user’s browser opens the UNITY Mobile website, where the user is automatically
logged in to their account and prompted to import their website from the Panel-managed
server.
5. After the site is imported and optimized for mobile viewing, it becomes accessible by the
address mobile.example.com. The Panel’s DNS server keeps a CNAME record pointing
to the site on a UNITY Mobile server.
The user can now perform the following operations on mobile site using links in the
Control Panel:


Open site editor.



Change mobile site name.



Remove mobile site.

For more information about UNITY Mobile services, visit their website at
http://www.unitymobile.com.
For instructions on managing mobile sites through the Control Panel, refer to the Customer's
Guide, section Setting Up Mobile Sites.
Subdomains
The total number of subdomains that the subscriber will be able to host within the
subscription.
Domain aliases
The total number of additional alternative domain names that the subscriber will be able to
use for their websites.
Mailboxes
The total number of mailboxes that the subscriber can host within the subscription.
Mailbox size
The amount of disk space that is allocated to each mailbox in a subscription for storing e-mail
messages and auto-reply attachment files.
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Total mailboxes quota (available only for Windows hosting)
The total amount of disk space in megabytes available for all mailboxes within the
subscription.
Mailing lists
The total number of mailing lists that the subscriber can host within the subscription.
Additional FTP accounts
The maximum number of FTP accounts used to access the files and folders created within a
subscription. This number does not include an account that is always created during the
subscription creation.
Databases (Unix hosting)
The total number of databases that can be created on the Panel database servers and used
by the subscription's websites.
MySQL databases and Microsoft SQL Server databases (Windows hosting)
The maximum number of MySQL and Microsoft SQL Server databases respectively that can
be created on the Panel database servers and used by the subscription's websites.
MySQL databases quota and Microsoft SQL databases quota (Windows hosting)
The maximum amount of disk space (in megabytes) that the subscription's MySQL or
Microsoft SQL Server databases can occupy respectively.
Validity period/Expiration Date
The term for a subscription.
In service plan properties, it is Validity period: it is used only when a subscription is created:
the Panel derives the subscription expiration date from it.
In subscription properties, it is Expiration date: At this date, the subscription will be suspended,
meaning that all sites within the subscription will be suspended, their Web, FTP and mail
services will no longer be accessible to the Internet users, and the subscriber and their users
will not be able to log in to the Control Panel.
Subscriptions are not renewed automatically, so to bring a subscription's services back to
operation, you will need to manually activate the subscription (on page 48).
Java applications
The total number of Java applications that can be hosted on the subscription's websites.
Web users
The total number of personal Web pages that the subscriber can host for other users under
their websites. This service is mostly used in educational institutions that host noncommercial personal pages of their students and staff. These pages usually have addresses
like http://example.com/~webuser.
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FrontPage accounts (Windows hosting)
The maximum number of Microsoft FrontPage accounts that the subscriber can create within
the subscription.
Shared SSL links (Windows hosting)
The total number of shared SSL links that the subscriber can use within the subscription.
ODBC connections (Windows hosting)
The total number of ODBC connections that the subscriber can use within the subscription.
ColdFusion DSN connections (Windows hosting)
The total number of ColdFusion DSN connections that the subscriber can use within the
subscription.

Permissions
Permissions (located at Service Plans > select a plan > Permissions tab) define what privileges
and services are provided with the subscription.
DNS zone management
Allows the subscriber to manage the DNS zones of their domains.
Note: If this permission is granted, then the DNS service settings are not synced.
Hosting settings management
Allows modifying parameters of the hosting service provided with the subscription: changing
hosting account features, setting up custom web server settings, and switching on or off
support for programming and scripting languages, custom error documents, SSL support,
and (Windows only) Microsoft FrontPage support. In addition, it allows you to toggle the
following permissions: Hosting performance settings management and Common PHP settings
management.
Note: If this permission is granted, then the mentioned hosting parameters are not synced.
Common PHP settings management
Allows the subscriber to adjust common PHP settings individually for each website
(subdomain) in their subscription.
Note: If this permission is granted, then the common PHP settings are not synced.
Setup of potentially insecure web scripting options that override provider's policy. Allows the
subscriber to override the hosting security policy, if it is applied by the provider.
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Management of access to server over SSH (Linux hosting)
Allows the subscriber to access the server shell over SSH under their system user account.
Also, lets the subscriber set up such hosting parameter as SSH access to server shell under the
subscription's system user.
Note: If this permission is granted, then the mentioned hosting parameter is not synced.
Management of access to server over Remote Desktop (Windows hosting)
Allows the subscriber to access the server via Remote Desktop protocol.
Anonymous FTP management
Provides the anonymous FTP service, which lets the subscriber set up a directory shared
over FTP protocol and available to anonymous users. A subscription should reside on a
dedicated IP address in order to provide this service.
Scheduler management
Allows the subscriber to schedule running of scripts or utilities.
Spam filter management
Lets the subscriber customize filtering settings of the SpamAssassin spam filter.
Antivirus management
Allows the subscriber to change settings of the server-side protection of incoming and
outgoing mail from viruses.
Data backup and restoration using the server repository
Allows the subscriber to back up and restore their websites, and use the storage on the
server for keeping backups.
Data backup and restoration using a personal FTP repository
Allows the subscriber to back up and restore their websites, and use external FTP servers for
storing their backups.
Web statistics management
Allows the subscriber to select which Web statistics engine should be used, and whether
reports should be accessible via a specific password-protected directory.
Note: If this permission is granted, then the mentioned hosting parameter is not synced.
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Log rotation management
Allows the subscriber to adjust the cleanup of processed log files for their sites. Also, allows
the subscriber to remove log files.
Note: If this permission is granted, then the Logs & Statistics parameters (on page 39) are not
synced.
Access to Application Catalog
Provides the subscriber with access to prepackaged applications that can be installed on
websites. If you select this option, be sure to select the PHP support checkbox on the Hosting
Parameters tab.
You can view a list of applications available from your provider by doing the following:
1. Set up your own website by using a plan or a custom subscription that grants access to
the Application Catalog.
2. Go to the Server Administration Panel > Subscriptions, and click the Manage Hosting link
corresponding to your domain name. The Control Panel will open in a new browser
window or tab.
3. In the Control Panel, go to the Applications tab > All Available Applications.
There is also a page in the Server Administration Panel, where you can view and update
installed applications, and purchase license keys for commercial applications at Parallels
Online Store: Tools & Utilities > Application Vault.
For instructions on installing applications and license keys, refer to the Customer's Guide,
section Using Website Applications.
Domains management
Allows the subscriber to add domains, create websites and set up web forwarding.
Subdomains management
Allows the subscriber to set up additional websites accessible by <subdomain>.<domain>
addresses.
Domain aliases management
Allows the subscriber to set up additional alternative domain names for their websites.
Additional FTP accounts management
Allows the subscriber to manage FTP accounts for accessing the subscription's files and
folders.
Java applications management
Allows the subscriber to install Java applications on their websites.
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Mailing lists management
Allows the subscriber to use mailing lists provided by the GNU Mailman software.
Note: If this permission is granted, then the Enable mailing lists parameter (on page 37) is not
synced.
Hosting performance settings management
Allows the subscriber to adjust performance PHP settings individually for each website
(subdomain) in their subscription. In addition, lets the subscriber set up the limits on
bandwidth usage and number of connections to their websites.
Note: If this permission is granted, then the following settings are not synced: PHP
performance settings, performance settings (on page 38) for bandwidth usage and the number
of connections.
IIS application pool management (Windows hosting)
Provides the subscriber with a dedicated IIS application pool and the means to manage it:
enable or disable it, and set up the maximum amount of CPU power that the pool may use.
Note: If this permission is granted, then the Logs & Statistics parameter (on page 39) called
Use dedicated pool is not synced.
Additional write/modify permissions management (Windows hosting)
Allows the subscriber to toggle the hosting parameter Additional write/modify permissions.
These permissions are required if a subscriber's web applications use a file-based database
(like Jet) located in the root of httpdocs folder. Please note that selecting this option might
seriously compromise the websites' security.
Note: If this permission is granted, then the hosting parameter Additional write/modify
permissions is not synced.
Shared SSL management (Windows hosting)
Provides the shared SSL service, and allows the subscriber to set up shared SSL links for
their websites within the subscription.
Hard disk quota assignment
Allows the subscriber to set up the hosting parameter Hard disk quota.
Note: If this permission is granted, then the mentioned hosting parameter is not synced.
Database server selection
Allows subscribers to select a database server for their databases, as opposed to using the
default database server. For details about default database servers, see the section Hosting
Parameters (on page 28).
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Access to advanced operations: Website Copying and Website Maintenance Mode
Specifies whether the website copying and maintenance mode are available to the
subscriber in the Control Panel > Websites & Domains > Show Advanced Operations. If denied, the
Website Copying and Website Maintenance Mode links are not available to the subscriber.
Password-protected directories management
Specifies whether the protected directories feature is available to the subscriber in the Control
Panel > Websites & Domains > Show Advanced Operations. If denied, the Password-protected
directories link is not available to the subscriber.
Ability to manage auxiliary user accounts
Specifies whether the subscriber can manage auxiliary user accounts on the Control Panel >
Users tab. If denied, the Users tab is not available to the subscriber.
Allow activating APS apps using license keys from the Panel license pool
If granted, users will be able to install certain APS apps without the need to purchase app
licenses from vendors. In this case, app license keys will be taken from the Panel license
pool. Note that you cannot limit the number of app installations a user is allowed to perform.
This permission is relevant only if your Panel license comes in a bundle with APS app
licenses. Learn more about license bundles.

Hosting Parameters
These parameters define the hosting service provided with the plan or subscription. The
parameters can be found in:


Service Plans > select a plan > Hosting Parameters tab



Subscriptions > select a subscription > Customize > Hosting Parameters tab

Note: Unless specifically noted, the parameters are not synced if the Hosting management
permission is granted to a subscription.
Enable hosting
Defines whether the hosting service is actually provided with the plan.
Turn off this option to make up a service plan that provides only mail service. Subscribers of
such a plan will be able to have 'domains without hosting' which will serve mailboxes.
Status of websites in suspended subscriptions
Defines whether sites in suspended subscriptions should be available over the Internet and
which hosting services should be available for these sites.
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In Panel, a website can receive a new status in two ways:


When the site owner or hosting provider changes the status individually for the site (in
Websites & Domains > Edit > Change status). As long as the subscription stays active,
services like mail are available for sites with any status, and these services can be
managed by means of Panel. Learn more in Website Status (on page 130).



After the subscription has been suspended. It can be suspended automatically (when its
expiration date passes) or manually by the hosting provider (using the Suspend button in
the subscription's settings). The DNS and mail services are available for sites in
suspended subscriptions, but cannot be managed by means of Panel.
The setting Status of websites in suspended subscriptions enables you to specify the status
that websites will receive when their subscription becomes suspended.

Websites in suspended subscriptions can have the following statuses:


Disabled. Disabled websites have all associated hosting services disabled. Visitors see
the web server's default page defined by the hosting provider.
Disabled websites are no longer hosted on the server: They are excluded from the web
server configuration. However, the physical directories and files of disabled websites can
be accessed using FTP clients and File Manager.
Important: In Panel versions earlier than 11.5 this status was called Suspended. After
upgrading from earlier Panel versions to 11.5, all websites that had the Suspended status
will receive the status Disabled in order to keep their correct behavior.



Suspended. Suspended websites do not open in browsers. Visitors are redirected with the
search engine friendly 503 HTTP code to the custom maintenance page.
Note: You can customize the maintenance page by using the Edit maintenance error page
link in Control Panel > Websites & Domains > domain name. This link is displayed only if you
select the Custom error documents checkbox in the site settings in Websites & Domains >
domain name > Edit. Site owners can edit the maintenance page too.
Suspended websites remain hosted on the server, which means that the services such as
mail are running and web server configuration for these websites is kept on the server.



Active. The website works as usual.

Hard disk quota
Hard quota imposed on disk space in addition to the soft quota (set with the option Notify upon
reaching (on page 20)). Hard disk quota will not allow writing more files to the web space
when the limit is reached: users will get an "Out of disk space" error at an attempt to write
files.
Note: (Linux hosting) Confirm that your operating system supports hard disk quota before
you set any value other than Unlimited. In case you define a hard quota when it is not
supported, you will get a synchronization conflict on all the plan's subscriptions.
SSL support
Allows setting up SSL encryption on websites hosted within the subscription.
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Web statistics
Selects a statistics engine that will create reports on how the subscription's websites are
visited: how many people visited a site, and which web pages they viewed.
The accessible via password protected directory /plesk-stat/webstat option allows a subscriber view
website statistics at URLs like https://example.com/plesk-stat/webstat using their system
user account login and password.
Note: This parameter is not synced if the Web statistics management permission is selected.
Custom error documents
Allows subscribers to design and use their own error pages that the web server returns with
HTTP error codes.
SSH access to server shell under the subscription's system user (Linux/Unix hosting)
Allows subscribers to upload securely web content to the server through SSH.
Note: This parameter is not synced if the Management of access to server over SSH permission is
selected.
Scripting
Support for programming and scripting languages that should be interpreted, executed or
otherwise processed by a web server: Microsoft ASP.NET framework, PHP hypertext
preprocessor (PHP), Common Gateway Interface (CGI), Perl, Python, Fast Common
Gateway Interface (FastCGI), Microsoft or Apache Active Server Pages (ASP), Server Side
Includes (SSI), ColdFusion, and Miva scripting required for running Miva e-commerce
solutions.
To learn more about adjustable PHP settings, see the section PHP Settings.
Additional write/modify permissions (Windows hosting)
This option is required if subscriber's web applications use a file-based database (like Jet)
located in the root of httpdocs folder. Please note that selecting this option might seriously
compromise the Web site security.
Allow web users to use scripts
Allows scripting at web pages available at URLs like
http://example.com/~<username>/<webpage>, where <username> refers to a web user.
Web users are individuals who do not need their own domain names. This service is popular
with educational institutions that host non-commercial personal pages of their students and
staff.
FrontPage support (Windows hosting).
The options in the FrontPage support group allow subscribers to connect to the server and
create websites with Microsoft Frontpage.
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Default Database Server
Specifies default database servers of each supported type to be used within a plan.
Customers will be able to create databases only on the default database servers. Note that if
you disable a database server for an existing plan or subscription (the None option), the
databases already used by customers will still be accessible.

Next in this section:
PHP Settings ..................................................................................................... 32
Customizing PHP Configuration ........................................................................ 34
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PHP Settings
Choose one of the following PHP handlers at Hosting Parameters > PHP handler type taking into
consideration resources consumption and security aspects of each option:
Performance
High.
Apache
module (Linux Runs as a part of
the Apache web
only)

Memory
Usage

Security

Low

This handler (also known as mod_php) is the least secure
option as all PHP scripts are executed on behalf of the
apache user. This means that all files created by PHP
scripts of any plan subscriber have the same owner
(apache) and the same permission set. Thus, there is a
theoretical possibility that some users will try to affect files of
another users or some important system files.

server.

Note: You can evade some security issues by turning
the PHP safe_mode option on. It disables a number of
PHP functions that bring potential security risk. Note
that this may lead to inoperability of some web apps.
The safe_mode option is considered to be obsolete
and is deprecated in PHP 5.3.
ISAPI
extension
(Windows
only, not
supported
since PHP
5.3)

High.

Low

Runs as a part of
the IIS web server.

The ISAPI extension can provide site isolation in case a
dedicated IIS application pool is switched on for
subscriptions. Site isolation means that sites of different
customers run their scripts independently. Thus, an error in
one PHP script does not affect the work of other scripts. In
addition, PHP scripts run on behalf of a system user
associated with a hosting account.

Note: The ISAPI extension handler is not supported
since PHP 5.3.
CGI
application

FastCGI
application

Low.
Low
Creates a new
process for each
request and closes it
once the request is
processed.

The CGI handler provides PHP script execution on behalf of
a system user associated with a hosting account. On Linux,
this behavior is possible only when the suEXEC module of
the Apache web server is on (default option). In other case,
all PHP scripts are executed on behalf of the apache user.

High (close to
Apache module and
ISAPI extension).

The FastCGI handler runs PHP scripts on behalf of a
system user associated with a hosting account.

Keeps the
processes running
to handle further
incoming requests.

High

We recommend that you use the CGI application handler only
as a fall-back.
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The PHP-FPM is an advanced version of FastCGI which
offers significant benefits for highly loaded web applications.
The PHP-FPM handler is available only if it was installed by
hosting provider and if the option Process PHP by nginx in the
website’s settings is turned on (Websites & Domains > select a
domain > Web Server tab).

Note: Switching PHP from Apache module to FastCGI application may break functionality of
existing PHP scripts. Switching to PHP-FPM by selecting Process PHP by nginx in the website’s
web server settings may do the same.

PHP Version
Panel supports different versions of PHP. For each handler, one or more PHP versions can
be available. The list of available versions is defined by your hosting provider and available
to you in the same location where you select the PHP handler: Websites & Domains tab >
<domain_name> > Edit.
Note: Always use PHP 5.x except the cases when you need PHP 4.x to host some old PHP
apps.
Since Panel 10.4, you have the ability to adjust PHP configuration individually for each
hosting plan or subscription. For this purpose, Panel exposes a number of PHP configuration
settings on the PHP Settings tab. To learn more about custom per-subscription PHP
configuration, refer to the section Customize PHP Configuration.
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Customizing PHP Configuration
PHP is one of the most popular scripting languages for creating dynamic web pages. The
majority of today's websites and web applications are based on PHP scripts. Thus, site
administrators should understand how they can control the execution of PHP scripts.
Typically, PHP behavior is defined by a number of configuration settings. These settings
specify various script execution aspects, like performance (for example, the amount of
memory a script can use), security (for example, access to file system and services), and so
on. Administrators might want to adjust these settings for a number of reasons:


Preventing a memory leak or server hang-up by poorly written scripts.



Protecting data from malicious scripts.



Meeting the requirements of a certain web app.



Testing own scripts and other.

Custom PHP Settings in Panel
Generally, PHP settings are defined by the server-wide configuration file. For Linux it is,
typically, /etc/php.ini and for Windows - %WIN%\php.ini. This file is managed by your
hosting provider and defines PHP configuration for all websites hosted on the server. Since
Panel 10.4, PHP settings are adjustable through the Control Panel and you can adjust them
individually for each hosting plan or subscription. Moreover, your customers (if allowed) can
adjust your PHP settings preset individually for each of their websites and subdomains. See
the PHP settings hierarchy on the diagram below.
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You can set the custom PHP configuration in the properties of a certain service plan, add-on
plan, or subscription (on the PHP Settings tab). PHP settings from a higher level act as a
preset for a lower level, thus each lower level overrides them. For example, you can
consciously apply some PHP limitations to a service plan and then offer your customers the
add-on plan that removes the limitations. PHP settings of the add-on plan will override the
settings defined in the main service plan.
If customers have the corresponding permissions, they can specify the PHP configuration
that is unique for each website (or subdomain) in their subscription.

Groups of PHP Settings
For convenience, all PHP settings in Panel are divided into two groups:


Performance settings.
These settings define how scripts work with system resources. For example: Use the
memory_limit parameter to limit the amount of memory for a script and, as a
consequence, to prevent memory leaks; or prevent scripts from tying up the server by
limiting the maximum time scripts are allowed to run in max_execution_time.



Common settings.
This group contains other commonly used PHP settings. Generally, these are: Security
settings (say, the PHP safe mode toggle or the permission to register global variables),
error reporting settings (say, the directive to log errors), and others.

Important: If you use Panel for Windows or for Linux, where PHP runs not as an Apache
module, your customers are able to override some PHP settings regardless of any
permissions. They can use the ini_set() function in their scripts to change values of the
following parameters: memory_limit, max_execution_time, and those of your
additional directives that PHP allows to set anywhere (PHP_INI_ALL directives; learn more
at http://php.net/manual/en/ini.list.php).
If you cannot find particular parameters among performance or common settings, contact
your hosting provider.

The Default Values of PHP Parameters
You can set the value of each parameter in PHP Settings either by selecting a value from a
preset, typing a custom value, or leaving the Default value. In the latter case, Panel takes the
parameter value from the server-wide PHP configuration. The only exceptions are add-on
plans: the value set to Default on the add-on's PHP Settings tab will keep the parameter's value
from the main service plan.
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Allowing Customers to Change PHP Settings
You can allow your customers to override subscription's PHP settings with their own perwebsite and per-subdomain PHP configuration. For this purpose, you should use the
following permissions on the Permissions tab of a certain service plan or subscription:


Hosting performance settings management.
Along with management of some other settings, this permission grants customers access
to PHP settings from the performance settings group.



Common PHP settings management.
If granted, allows customers to adjust PHP settings from the common settings group.

Note that you can toggle these permissions for a plan (subscription) only if it has the granted
Hosting settings management permission.
Even if your customers do not have permissions to adjust PHP settings, you (as the
administrator) can always perform such per-website (subdomain) PHP configuration. To do
this, open a certain hosting account from the Server Administration Panel and apply changes
to the settings of a particular website (subdomain) on the PHP Settings tab.

Mail
These parameters (located at Service Plans > select a plan > Mail tab) define the mail service
provided with the plan.
Webmail
Provides the webmail service, which allows users of mailboxes within the subscription to
work with their mail using a web-based mail application.
Enable mailing lists
Turns on the mailing lists service provided by the GNU Mailman software on the
subscription's websites.
Note: This parameter is not synced if the permission Mailing lists management is selected.
Policy on mail for non-existent users
Defines how mail server should treat e-mail messages sent to e-mail addresses that are
supposed to be registered under the subscription's domains but actually do not exist. The
following options are available:


Bounce with message returns the mail back to sender with a notice.



Forward to address forwards the mail to another e-mail address.



Reject silently rejects the mail without accepting it. This setting can decrease mail server
load caused by a large amount of spam, which is often directed at randomly generated
user names. However, this might be useful to spammers because scanning your mail
server for valid e-mail addresses will speed up in such a case.



Redirect to external mail server with IP address (on Windows hosting), forwards the mail to the
specified mail server.
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DNS
These parameters (located at Service Plans > select a plan > DNS tab) define how the DNS
service running on the Panel-managed server will serve DNS zones for websites hosted on
the plan.
Master
A master or primary name server stores locally the zone file it serves, while a secondary
server only retrieves a copy of this file from the primary.
Slave
A slave or secondary server retrieves a copy of the zone file from the primary name server.

Performance
These system parameters (located at Service Plans > select a plan > Performance tab) define
performance of all services provided with the plan.
Use dedicated IIS application pool (Windows hosting)
Enables the use of dedicated IIS application pool for web applications within the subscription.
Using dedicated IIS application pool dramatically improves the stability of web applications
due to worker process isolation mode. This mode gives each site hosted on the server a
possibility to allocate a separate process pool for execution of its web applications. This way,
malfunction in one application will not cause stopping of all the others. This is especially
useful when you are using shared hosting package. The Maximum CPU use (%) option limits the
amount of the server CPU that the pool can use.
Maximum bandwidth usage
Defines the maximum speed (measured in KB per second) that a domain can share between
all its connections.
Connections limited to
Defines the maximum number of simultaneous connections to web server for all websites
within the subscription. This setting is intended for preventing the websites from Denial of
Service (DOS) attacks and excessive usage of bandwidth.
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Logs & Statistics
These parameters (located at Service Plans > select a plan > Logs & Statistics tab) define how
statistics and logs of a subscription should be stored.
Note: These settings in subscriptions are not synchronized with service plans.
Retain web and traffic statistics
Sets a period (in months) for which reports on the subscription's web statistics (generated by
the selected web statistics component) and traffic statistics (generated by Panel) should be
available.
Note: The setting Retain web and traffic statistics is not changed in subscriptions when you
update it for a service plan. The only way to update this setting for each domain is changing
it in the Panel database. See http://kb.parallels.com/en/6246 for details.
Log rotation
Enables automatic cleanup and recycling of web server log files. You can also switch on
compression of processed log files and sending them to a specific e-mail address.

Applications
Depending on the service plan, a number of prepackaged applications can be available to
Panel users. You can install the apps on your own sites as well as provision them to your
customers.
When setting up a hosting plan, you can select which of the apps should be provisioned to
customers:


To provide all available applications, on the Permissions tab, select the option Access to
Application Catalog.



To provide only selected applications, on the Permissions tab, select the option Access to
Application Catalog, and then go to the Applications tab and select the option Provide only
applications that I select. Use the button >> to add the selected applications to the plan.

Additional Services
If your provider configured Panel to provide custom additional services, then the Additional
Services tab is shown in hosting plan properties. On this tab, you can select the services that
you want to provide to subscribers.
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Syncing Subscriptions and Plans
Subscriptions associated with a particular plan are synchronized, or synced, with it: any
changes made to the plan are automatically applied to all its subscriptions. This is true for
both service and add-on plans.
In case a plan offers a privilege which makes it possible for a subscriber to change a
particular resource or service, this resource/service allocation is not synced. For example, if
a subscription provides the privilege of DNS zone management, then the DNS zone settings
of the associated service plan are ignored during synchronization.

States of Subscription
Subscriptions associated with a particular plan are synchronized, or synced, with it: any
changes made to the plan are automatically applied to all its subscriptions. This is true for all
kinds of plans: service plans, their add-ons, and reseller plans.
The Panel allows the following deviations from the default subscription state (active and
synced with the service plans):


Locked state, which means locked for syncing, indicates that a subscription is excluded
from syncing with the associated plans.
A subscription gets locked if you change the parameters of the subscription, without
changing the associated service plan. Such locking secures your customizations so that
they are not overwritten the next time you change the plan and all its subscriptions are
synced.



Unsynced state indicates that some services or resources offered with the associated
plans cannot actually be provided with the subscription.



Suspended state. This state is not related to the synchronization of a subscription with the
service plan, but it affects the behavior of websites. Panel suspends subscriptions
automatically if their expiration date passes. In addition, you can suspend a subscription
manually.

Note: If a plan offers a privilege that makes it possible for a subscriber to change a particular
resource or service, this resource/service allocation is ignored during a sync. For example, if
the plan provides the privilege of PHP settings management and a customer changes some
PHP setting, its subscription remains synced with the plan (even if a value of the PHP setting
in the subscription differs from the corresponding one in the plan).

Understanding Service Plans and Subscriptions

41

Unsynced Subscriptions
Panel does not check whether a service or a resource that a service plan should provide is
actually available in the system. For example, when creating a plan, you can select to
provide ColdFusion when ColdFusion is not installed on the server, and Panel will let you do
it and will show no error or warning messages.
A subscription is automatically marked as Unsynced if Panel cannot provision the resources
and/or services defined by the plan. This may happen in the following cases:


When the subscription is created.




When the properties of the associated plan are changed.
When an add-on plan is added to or removed from the subscription.

 To know which of the subscription's resources or services are not synced with
the plan:
1. Go to Subscriptions, and click the unsynced subscription name.
2. Click Sync.
The Panel will retry syncing the subscription with associated plans, and will display the
conflicting properties if syncing fails.
Be sure to take note of the conflict report: which properties are affected, and what the
Plan value and the Available value are.
Clicking OK at this page will initiate setting the subscription values according to the
available values, Cancel will leave everything unchanged.
Once you have identified the problem, you can resolve it. There are two possible ways:
1. Fine-tune the plan to conform to the system's capabilities.
2. Fine-tune the system to provide resources and services offered with the plan.

 To change the plan properties to conform to the system:
1. Go to Service plans > <plan name>.
2. Adjust the required settings so that they correspond to the Available values
(see above).
3. Click Update & Sync.
The subscriptions will be synced automatically.

 To adjust the system:
Contact your service provider.

CHAPTER 3

Starting Your Business in Panel
Organizing your offerings into service plans is only one of the many steps required to
get your business ready to run. Before you can start serving customers, you should
also think about how potential customers will find your offerings, how you will subscribe
new customers and take payments, and other aspects of your business. To start your
business more easily, you can use automation solutions that carry out different routines
for you, for example, issue invoices and take payments from customers.
The automation tools included in your reseller package by your hosting provider define
whether you will be able to automate certain business routines. If your hosting provider
offers you a business automation solution, learn how to automate certain routines in
the appropriate documentation. Otherwise, you should take care of various aspects of
your business on your own before you start serving customers. However, in this case,
you can automate some aspects, for example, financial ones, by means of the
appropriate software as well.
To start your hosting business in Panel, do the following:


Rebrand Panel and prepare hosting plans.



Set up a website for your own company.

After you complete these operations, you can start subscribing customers to your
services.

Rebranding Panel and Preparing Hosting Plans
Before you can start serving your customers, you should do the following:

1. Adjust Panel branding and appearance as described in the section
Changing Branding and Interface Settings (on page 44).
2. On the Service Plans page, add service plans and add-ons that you will
offer to your customers.

Setting Up Your Company's Presence on the Web
To let your prospective customers become acquainted with your offerings and contact
you, set up a website and e-mail addresses for your company on the Panel-managed
server.
To set up your website, create your own hosting subscription by clicking Subscriptions >
Create New Subscription. This will enable you to log in to the Control Panel and manage
your web hosting just as your customers do: you can create web pages and mailboxes,
install web applications, secure access to websites with SSL certificates, and so on.
For detailed information about using your hosting resources for your own needs, see
the chapter Website Management (on page 55).
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Subscribing Customers to Your Services
After you set up hosting plans in Panel, you can start subscribing customers to your
services. When a new customer subscribes to your services, create an account and a
subscription for this customer in Customers > Add New Customer. You will be prompted to
enter the following information:


The customer's contact information.



A username and a password that the customer will use to log in to the Control
Panel.
Subscription details:





A domain name that the customer owns and will use for their website hosted in
Panel.



An IP address used by the customer's website.



The customer's username and password that they will use to access their
folders, for example, using FTP.



The service plan to which the customer subscribes.

 (Optional) Add-ons that the customer wants to add to the subscription.
If the plan selected by the customer does not completely meet their needs and you
do not offer add-ons that could help, adjust the subscription settings by selecting
the checkbox Proceed to customizing the subscription parameters after the customer
account is created.
Once you create the account and the subscription, pass on the Panel access
credentials to the customer and they will be able to log in to Panel and create their
website.
Periodically, you will need to manually perform various operations on user accounts
and subscriptions. For example, renew (prolong) subscriptions at the end of
subscription periods, or suspend the accounts of customers who do not pay on time.
To learn how to manage existing customer accounts and subscriptions in Panel, refer
to the sections Managing Customer Accounts (on page 47) and Managing Subscriptions (on
page 48).

CHAPTER 4

Changing Branding and Interface
Settings
This chapter describes how to select Panel's interface language, rebrand Panel, and
add links to external sites or web applications.

Change Interface Language
In addition to English, Panel can be viewed in the following languages:



Chinese (traditional and simplified)
Dutch



French



German




Italian
Japanese



Polish



Portuguese




Russian
Spanish

If you want to switch Panel to any of these languages, go to My Profile > Interface
Preferences.
When you switch to a language different from English, some button captions may
become too long and corrupt the Panel layout. To prevent this, you can specify a limit
on button caption length. In this case, the system will automatically shorten button
captions longer than this limit and end them with an ellipsis (...).To define the caption
length limit, enter its value in the Button label length field in My Profile > Interface
Preferences. To disable automatic shortening, clear this field.

Add Branded Content
To disguise the fact that you are reselling another company's hosting resources, you
can add your own branded content to Panel. Specifically, this content may be the
following:


The logo in the top left corner. Upload your own logo and your customers will see this
instead of the original Panel logo in the Control Panel. Use a GIF, JPEG, or PNG
file for your logo, preferably not larger than 100 kilobytes to minimize the download
time. To ensure that your logo will fit into the top area, we recommend that you use
an image 50 pixels in height.
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The URL to which the logo points. Make your logo a clickable link that points to your
company's website to let your customers easily open the website any time they are
in the Control Panel.



The pages title. Let your customers see your company name or other relevant text in
their browsers' title bars when they work in the Control Panel.

To change any of these settings, go to Tools & Utilities > Panel Branding.

Add Links to Websites and Applications
If you want to have quick access from Panel to certain websites and applications, or
wish to provide your customers with such access, create custom buttons. The buttons
may lead to web resources, such as your corporate site, or to a web application that
can process online requests and accept additional information about the users clicking
the buttons. You can place these buttons on your Home page for yourself or in the
Control Panel for your customers.
You can place the buttons in the following locations of the Server Administration Panel
and the Control Panel, and decide who should be able to see them:


On the Home page in the Server Administration Panel, visible only to you. This is
achieved by selecting the Reseller's Home page option in the button properties.



On the Home tab in the Control Panel, visible to the hosting service customers and
their users who are allowed to log in to the Control Panel. This is achieved by
selecting the Customer's Home page option in the button properties.



On the Websites & Domains tab in the Control Panel, visible to the hosting service
customers and their users who are allowed to log in to the Control Panel. This is
achieved by selecting the Websites & Domains page of Subscription option in the button
properties.



On the Home page in the Server Administration Panel and Control Panel, visible to
you and your customers. This is achieved by selecting the Common access option in
the button properties.

You can specify what information about users should be passed:


Subscription ID.



Primary domain name associated with a subscription.



FTP account username and password.



Customer's account ID, name, e-mail, and company name.

 To add a custom hyperlink button to the Server Administration Panel or
the Control Panel:
1. Go to Tools & Utilities > Custom Buttons (in the Panel Management group), and
click Create Custom Button.
2. Specify the following properties of the button:


Type the text that will show on your button in the Button label box.



Choose the location for your button.
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Specify the priority of the button. Your custom buttons will be arranged in the
Panel in accordance with the priority you define: the lower the number, the
higher the priority. Buttons are placed in the left-to-right order.



To use an image for a button background, click Browse to browse for the desired
file. It is recommended that you use a 16x16 pixel GIF or JPEG image for a
button to be placed in the navigation pane, and a 32x32 pixels GIF or JPEG
image for a button placed in the main frame.



Type the hyperlink to be attached to the button into the URL box.



Using the checkboxes, specify whether you want the customer information and
other data to be transferred within the URL. These data can be used for
processing by external web applications.



In the Tooltip text input field, type in the help tip that will be displayed when users
place the mouse pointer over the button.



Select the Open URL in Parallels Panel checkbox if you want the destination URL to
be opened in the main frame of the Panel; otherwise, leave this checkbox
cleared to open the URL in a separate browser window or tab.



If you want to make this button visible only to you, select the Show to me only
checkbox.

3. Click Finish to complete creation.
To remove a custom button from the Panel, go to Tools & Utilities > Custom Buttons (in
the Panel Management group), select the corresponding checkbox and click Remove.

CHAPTER 5

Managing Customer Accounts
If you use Panel without software that automates creating and managing customer
accounts, manage these accounts in Panel manually.
To view the details of a customer account, click the customer's name on the Customers
page. To change these details, use the buttons on the page:


Edit Contact Info lets you update the customer's contact information: name, e-mail,
address, phone, and so on.



Edit Login Info lets you change the customer's username and password.

If you want to stop serving a customer, for example, if they do not pay for your
services, you may suspend the customer's accounts - block access to the Control
Panel for this customer and users that they created. To suspend an account, click
Suspend on the customer details page. In addition to suspending the account, this will
suspend all its subscriptions making the customer's websites, FTP and mail services
unavailable to the Internet users.
Later you will be able to cancel the suspension by clicking Activate on the customer
details page.
You can also suspend multiple accounts at once or activate multiple suspended
accounts. To do this, select the accounts that you want to suspend or activate at the
Customers page and choose the appropriate action from the More Actions menu.
To remove customer accounts and all subscriptions belonging to them, select these
accounts at the Customers page and click Remove.

CHAPTER 6

Managing Subscriptions
In Panel, you can do the following with existing subscriptions belonging to your
customers and yourself:


Change hosting settings of a subscription.
That is, the IP address on which the subscription's websites are hosted, and
credentials of system user account linked with the subscription (used to manage
files and folders of websites within the subscription, and to access the server via
SSH or Remote Desktop). To change a subscription's hosting settings, go to
Subscriptions > subscription's name, and click Change Hosting Settings.



Transfer one or several subscriptions to another user.
This means that you change owner of subscriptions, or, in other words, reassign
subscriptions to another user: another customer or yourself. In this case, the
subscriptions are automatically unbound from their plans and become custom. To
transfer one or several subscriptions to another user, go to Subscriptions, select the
corresponding checkboxes and click Change Subscriber.



Suspend subscriptions.
Websites, FTP and mail services of suspended subscriptions are no longer
accessible to the Internet users. Suspending a subscription manually may be useful
in cases when a website hosted within the subscription gets attacked or the
subscriber does not pay for the services.
To suspend one or several subscriptions, go to Subscriptions, select the
corresponding checkboxes and click Suspend.



Activate suspended subscriptions.
Once a subscription is activated, all the services provided with it resume operation.
Activation is only useful for subscriptions that were suspended manually: if you
activate a subscription that was expired, Panel will automatically suspend it again
on the next day. To make an expired subscription active, renew it as described
below.
To activate one or several subscriptions, go to Subscriptions, select the
corresponding checkboxes and click Activate.



Renew an expired subscription.
When a subscription's expiration date comes, Panel suspends it. In such cases,
you should renew subscriptions manually.
To renew a subscription, go to Subscriptions > subscription's name, click Activate,
and then set a new expiration date (it may be unlimited). Then apply the new
settings by clicking Update & Lock.
Note: After this step, the system will not apply further changes of the plan settings
to this subscription. If you try to sync this subscription with the plan, the subscription
will expire again unless you set the Unlimited validity period for this plan.
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Remove subscriptions.
To remove subscriptions, go to Subscriptions, select the corresponding checkboxes
and click Remove.

CHAPTER 7

Backing Up and Restoring Data
With the data backup and restore functions provided by your Parallels Plesk Panel, you
can perform the following operations:


Back up your account with all domains. The backup archive will include all settings and
data related to your account and your domains (websites).



Back up individual domains (websites). The backup archive will include all data related
to a website and mail services, including the contents of mailboxes, address book
contact lists, antispam and antivirus settings. The instruction for backing up a
certain website is provided in the section Backing Up and Recovering Websites (on
page 277).



Schedule backups. Scheduling backup can be done both for your account and your
domains.
Restore your data from backup archives.



Your customers granted with the permission to use the backup and restore functions
can back up and restore their own account settings and websites through the Panel.

In this chapter:
Configuring the Control Panel for Using FTP Repository ................................... 51
Backing Up Your Account with Your Sites ......................................................... 51
Scheduling Backups .......................................................................................... 52
Restoring Data From Backup Archives .............................................................. 53
Downloading Backup Files from Server ............................................................. 54
Uploading Backup Files to Server ..................................................................... 54
Removing Backup Files from Server ................................................................. 54
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Configuring the Control Panel for Using
FTP Repository
 If you are going to use an FTP server for storing backup files, you should
set up the Control Panel appropriately:
1. Go to Tools & Utilities > Backup Manager > Personal FTP Repository Settings.
2. Specify the following settings:


FTP server's IP address or host name.



Directory on the server, where you want to store backup files.



User name and password for access to the FTP account.

3. Click OK.

Backing Up Your Account with Your Sites
 To back up your account with domains:
1. Go to Tools & Utilities > Backup Manager, and click Back Up.
2. Specify the following:


Backup file name prefix and description. You cannot specify an arbitrary file
name, however, you can set the control panel to add a prefix to backup file
names. Note that the control panel automatically adds the date and time of
backup file creation (in Universal Time) to backup file names.



Splitting of the backup file. To create a multivolume backup, select the
respective check box and specify volume size in megabytes.



Location where to store the backup file. Select the repository where you would
like to store the backup file.



What data to back up. You can back up only the settings related to the user
accounts and Web sites, or the settings with all user data.



E-mail notification on backup completion. If you want to be notified of the
backup completion, type your e-mail address.

3. Click Back Up. The backup process will start and the progress will be
shown under the Current Back Up Tasks tab. You can use the Refresh button
to update the information on the screen. When backing up is finished,
the backup file will be saved to the repository you selected.
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Scheduling Backups
 To schedule backing up of data:
1. Go to Tools & Utilities > Backup Manager.
2. Click Scheduled Backup Settings.
3. Select the Activate this backup task checkbox and specify the following:


When and how often to run the backup.



Backup file name.



Splitting of the backup file. To create a multivolume backup, select the
respective check box and specify volume size in megabytes. Note that volume
size cannot exceed 4095 megabytes.



Location where to store the backup file. Select the repository where you would
like to store the backup file.



Maximum number of backup files stored in the repository. Type a number if you
want to recycle backup files: When this limit is reached, the oldest backup files
are removed.



E-mail notification on backing up errors. If you want to send an e-mail notice
when something goes wrong during backing up, type the e-mail address you
need.



What data to back up. You can back up only settings, or settings and user data.

4. Click OK.
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Restoring Data From Backup Archives
You can restore data from backup files kept in Panel's repository on the server, a
custom FTP repository (on page 51), and you can upload a backup file (on page 54) in
a ZIP archive (on Windows systems) or tar archive (on Linux systems), and then
restore data from it.

 To restore data from a backup file:
1. Go to Tools & Utilities > Backup Manager.
2. Click the backup file name.
3. Specify the following settings:


Types of data to be restored.



Suspend domain (Web site) until restoration task is completed. Select this if you want
to avoid possible conflicts that may occur when users modify site content or
settings while they are being restored.



Send an e-mail notice when restoration task is completed. Type your e-mail address if
you want the Control Panel to notify you when restoring is completed.



Conflicts resolution policy. Specify what to do if any conflicts occur during
restoration.

4. Click Restore.
In case if any errors or conflicts occur during restoration of data, the wizard will
prompt you to select an appropriate resolution. Follow the instructions provided on
the screen to complete the wizard.
Note: The Overwrite data restoring mode means that all objects will be restored
from the backup files regardless of their current presence in the system. The
Overwrite mode works as follows:


If an object or settings from the backup file are not present in Parallels Plesk
Panel, then they are created or set in Parallels Plesk Panel.



If an object or settings from the backup file are present in Parallels Plesk Panel,
then the object or settings from the backup file replace the corresponding object
or settings that are present in Parallels Plesk Panel.



If an object or settings are present in Parallels Plesk Panel, but are missing from
the backup file, then the object or settings currently present in Parallels Plesk
Panel are not changed.
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Downloading Backup Files from Server
 To download a backup file from a backup repository within the Panel:
1. Go to Tools & Utilities > Backup Manager.
2. Click the icon

corresponding to the backup file you want to download.

3. Select the location where you want to save the backup file and click
Save.
The backup file will be downloaded from the backup repository.

Uploading Backup Files to Server
 To upload a backup file to a backup repository within the Panel:
1. Go to Tools & Utilities > Backup Manager.
2. Click Upload Files to Server Repository.
3. Click Browse and select the required backup file.
Note: Make sure you select the appropriate backup file format, which depends on
the operating system on which Parallels Plesk Panel is installed. On Linux/Unix
systems, you should upload tar or zipped tar archives, and on Windows, ZIP
archives.

4. Click OK.
The backup file will be uploaded to the backup repository.

Removing Backup Files from Server
 To remove a backup file from the backup repository in the Panel:
1. Go to Tools & Utilities > Backup Manager.
2. Select a checkbox corresponding to the backup file you want to remove.
3. Click Remove.
4. Confirm removal and click OK.

CHAPTER 8

Website Management
The Panel's main function is simplified administration of hosted websites, mailboxes,
and other network resources. As a reseller, you can use leased hosting resources for
your own needs as well as for selling these resources to customers. For example, you
can set up your corporate website or mailbox on the Panel server. To set up your own
hosting account, create a subscription in Panel by clicking Subscriptions > Add New
Subscription. Then provide a domain name for this subscription, specify access
credentials, and choose a service plan and add-ons if you need them. The subscription
will appear in the list on the Subscription page together with your customers'
subscriptions. To start creating your website or to edit the subscription settings, click
the Open in Control Panel link next to the subscription's name. A list of operations
available to you in the Control Panel is provided in the table below.

Helping Customers Manage Their Subscriptions
Your customers will have different levels of technical expertise and, therefore, may
have problems with managing certain settings of their subscriptions. To assist your
customers, you can log in to the Control Panel under a customer's account and edit
their websites and subscription properties as if they were your own. To start managing
a customer's subscription in the Control Panel, find the subscription in the list on the
Subscriptions page and click Open in Control Panel.

Operating in Control Panel
Operations related to managing hosting accounts, such as managing website content,
adding and removing mailboxes, changing hosting settings, and so on, are available to
you in a separate interface called the Control Panel.
The sections of this chapter explain how to perform hosting operations in the Control
Panel. The instructions are applicable to your own subscriptions and subscriptions of
your customers. This means that when we say your website, your subscription, and so
on, we imply both your own and your customers' websites or subscriptions. The table
below lists the sections of this chapter and briefly describes what you can learn from
them.
Section

Description

Quick Start with Parallels Panel

Explains the workflow of setting up a website
and a mail account in the Control Panel.

Customer Account Administration

Explains how to view and manage account
settings, subscriptions, invoices, and
resources in the Control Panel.
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Websites and Domains

Explains how to create websites, fill them
with content, add applications, and configure
subscription properties related to websites
and domain names.

Building Websites with Presence Builder

Provides instructions on creating websites
using Presence Builder - a visual website
editor coming in a bundle with Panel.

FTP Access to Your Websites

Explains how to set up access to websites
using FTP for subscribers and auxiliary
users.

Mail

Describes how to set up mail accounts and
configure mail settings under subscriptions.

Scheduling Tasks

Provides instructions on configuring Panel to
automatically run scripts at specific times.

Using Databases

Explains how to use databases under
subscriptions: create new databases, import
existing ones, or access external databases.

Backing Up and Recovering Websites

Provides instructions on backing up and
restoring the data of certain hosting
subscriptions on behalf of subscribers.

In this chapter:
Quick Start with Parallels Panel......................................................................... 57
Customer Account Administration ..................................................................... 81
Websites and Domains ..................................................................................... 108
Creating Sites with Presence Builder ................................................................ 199
FTP Access to Your Websites ........................................................................... 252
Mail Accounts .................................................................................................... 256
Scheduling Tasks .............................................................................................. 267
Website Databases ........................................................................................... 272
Backing Up and Recovering Websites............................................................... 277
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Quick Start with Parallels Panel
According to the latest studies, the Internet has become the most popular source of
information in the world, leaving far behind all traditional media such as TV or
newspapers. Nowadays, the first thing people do when trying to find services is to
searching for them on the web. Thus, a proper web presence is vital for every
business. There are a number of ways you can present your company on the Web. A
web presence may be as simple as a contacts page, or as complex as a large
company website with access to an ERP system. In both cases, you should perform
the same steps to get your business online.
Before proceeding any further, you will need to take the following two essential steps:


Purchase a customer account from a hosting provider.
Your customer account provides access to the services that are vital for a web
presence - Internet connectivity, disk space to store your website content, and so
on. For more information about customer accounts in Panel, refer to the chapter
Customer Account Administration.



Register a domain name.
This is the name people will use to access your site from their browsers. For
example, www.example.com.

These two elements - an account for web hosting management and a domain name
make up your website.
In this chapter, we will explain how to create your first website, fill it with content, create
mailboxes for users of the site, and, finally, view the site visits statistics.

Advanced Hosting Features
Once you are comfortable with basic Panel capabilities, try out some advanced hosting
features: Expand website functionality by installing web applications (on page 151),
secure your sites with SSL certificates (on page 161), employ databases, and much
more.
Note: Hosting providers can turn off some of the advanced features to make your
Control Panel look simple and user friendly. We have used the (Advanced) prefix to
designate the sections about features that may be turned off. If you require one of the
advanced options, contact your hosting provider.

Next in this section:
Set Up Your First Website ................................................................................. 58
Set Up Mail Accounts ........................................................................................ 62
View Site Visit Statistics .................................................................................... 81
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Set Up Your First Website
Now that you have a customer account and a domain name, the first thing you will want to do
is create a website. The information about the possible ways to do it is provided in the
section 1. Create Your Site (on page 58)
When your site is ready, you may want to take a look at the result in your browser. Learn
how to do it in the section 2. Preview your Site (on page 61).

Next in this section:
1. Create Your Site ............................................................................................ 58
2. Preview Your Site .......................................................................................... 61

1. Create Your Site
There are three general ways to create a website:


Employ a web design studio to create a site for you, and then you will just maintain its
content.



Create a site by yourself using Presence Builder - the powerful tool that allows you to
create professional-looking websites in a few mouse clicks. Learn more in the section
Presence Builder (on page 59).



Create your website in a third-party Content Management System - an editor that allows
you to easily create and edit website content such as pages, scripts, applications, and so
on. To learn more about creating sites in third-party content management systems, see
the section Content Management Systems (on page 59).

If you have purchased a ready-made site or created it by yourself, you should upload the site
content to your account to make the site visible on the web. There are two ways to upload
content:


Using FTP. Learn more in the section Uploading Content Using FTP (on page 61).



Using an integrated File Manager. Learn more in the section Uploading Content with File
Manager (on page 61).

Next in this section:
Presence Builder............................................................................................... 59
Content Management Systems ......................................................................... 59
Uploading Content ............................................................................................ 60
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Presence Builder
Presence Builder is a tool that enables users with no knowledge of HTML markup or graphic
design skills to create professional-looking sites. This tool provides a simple visual editor and
a huge set of templates for different websites. The editor allows you to create web pages,
add content of different types (text, images, video, scripts), and edit website settings such as
website name, keywords, icons, and so on.
To create websites in Presence Builder, ensure that your hosting subscription includes this
option. If it does not, choose another way or upgrade your subscription.

 To create a website with Presence Builder:
1. Go to the Websites & Domains tab and click your domain name.
2. Click the link Launch Presence Builder.
3. Select a topic that best suits your website.
4. Edit the website:
a. Structure: add more pages, remove the predefined pages that you do
not need.
b. Content: change the predefined content to your own, add text,
images, videos, scripts, and other required elements.
c. Design: change the layout and color scheme.
5. Publish the website.
Find more information about creating websites with Presence Builder in the section Building
Websites with Presence Builder (on page 199).

Content Management Systems
Content Management Systems (or CMS) are applications that provide a graphical user
interface for adding and editing website content: pages, scripts, files, multimedia content, and
so on.
Before you can create a website in a third-party CMS, you should install the CMS on your
hosting account. Note that you can install the CMS only if your hosting subscription allows it.

 To create a website using a CMS:
1. Go to the Applications tab.
2. Find the CMS you need in the list of available applications, and install it as
described in the section Using Website Applications (on page 151).
3. Create your website in the CMS. For information about creating websites
with your CMS, refer to the relevant documentation.
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Uploading Content
If you already have a website created by yourself or a web design studio, just upload the
website files and folders to your provider's server. You can do this in one of the following
ways:


Using FTP. This way is better when several people manage a website's content because
it does not require access to your customer account. You can just create FTP users for
them. Learn more about this method in the section Uploading Content Using FTP (on page
61).



Using Control Panel File Manager. This way is more convenient since it uses the Control
Panel GUI and provides a set of useful features, for example, a visual HTML editor and a
file permissions manager. Find more information on the features of File Manager in the
section Uploading Content with File Manager (on page 61).

Next in this section:
Uploading Content Using FTP........................................................................... 61
Uploading Content with File Manager ............................................................... 61
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Uploading Content Using FTP
 To publish a website using FTP:
1. Connect to your webspace on the server with an FTP client program, using
your FTP account username and password.
You can change your username and password in the Panel at the Websites & Domains tab
> Web Hosting Access.
The FTP address should be ftp://your-domain-name.com, where your-domain-name.com
is your site's Internet address.
Enable the passive mode if you are behind a firewall.

2. Upload the files and directories of your site to the httpdocs directory. If you
use CGI scripts, place them in the cgi-bin directory.
3. Close your FTP session.
You can also set up additional FTP accounts if you need to collaborate on website content
with other users. For more information, see the section Adding FTP Accounts (on page 253).

Uploading Content with File Manager
To upload a website from your computer to Panel server with File Manager, open the Files
tab of Control Panel and drag the website folder to the central area of this tab. You can also
upload your website as a compressed ZIP file and then extract the contents using the
archiver integrated in File Manager.
With File Manager, you can also do the following:


Edit HTML files in the visual editor.



Preview website pages.



Edit files in the text editor.



Manage the files' access permissions.

Learn more about uploading and editing website files and folders with File Manager in the
section Managing Website Content (on page 143).
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2. Preview Your Site
After you uploaded website files to the webspace, you can check how your site will look in a
web browser, even before the information about the new site has spread in the Domain
Name System.

 To preview a site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscription menu at the top of the screen.
2. Go the Websites & Domains tab.
3. Click Preview below the domain name of the website that you want to preview.
You site will open in a new browser window.
Note: The contents of password-protected directories might be inaccessible in the Preview
mode.
Sometimes, you may need to show your site to someone when your domain name is not
registered yet. There are several ways to do it without giving a person access to your
customer account. Learn more in the section Previewing Websites (on page 150).

Set Up Mail Accounts
Once your website is ready, you can start creating mail accounts. You can choose, for
example, to create mail accounts for all users within your organization. Note that the number
and size of mailboxes is limited by your hosting plan.

Next in this section:
1. Create Mail Account ...................................................................................... 63
2. Access Your Mailbox ..................................................................................... 64
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1. Create Mail Account
 To create an e-mail address:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Mail tab.
3. Click Create E-mail Address.
4. Type the left part of the e-mail address before the @ sign, and, if you have
several domain names on your account, select the domain name under
which the e-mail address will be created.
5. Leave the Mailbox checkbox selected.
Clearing this checkbox makes sense only if you want to use this address as a mail
forwarder, which will forward all incoming mail to another address.

6. Specify the mailbox size or use the default size defined by the provider's
policy or your service plan.
7. Specify a password consisting of five or more Latin characters.
8. Click OK.
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2. Access Your Mailbox
There are two ways to access a mailbox for sending and receiving e-mail messages:


Set up and use an e-mail client program on your computer. Typically, in such programs
you should specify the following settings:


Username. In this field, specify your full e-mail address. For example,
johndoe@example.com.



Password. Most likely, the password to your e-mail account.



Mail server protocol. This property defines whether you want to keep copies of
messages on the server or not. To keep the copies on the server, select the IMAP
option. If you do not want to keep them on the server, select POP3. Selecting IMAP will
also allow you to train the SpamAssassin spam filter on e-mail messages you receive,
if SpamAssassin is enabled on the server.



Incoming mail server (POP3/IMAP). Type your domain name. For example,
example.com. The POP3 port is 110. The IMAP port is 143.

Outgoing mail server (SMTP). Type your domain name. For example, example.com.
The SMTP port is 25. This server requires authentication.
To get detailed instructions on configuring popular e-mail clients to work with your
mailbox, see subsections of this section.





Use a web browser to connect to the webmail interface.

Note: If you cannot access your mailbox following the instructions in this section, this might
be caused by mail server settings. Contact your hosting provider to resolve the issue.

Next in this section:
Access from Webmail ........................................................................................ 65
Access from Microsoft Office Outlook ................................................................ 65
Access from Microsoft Outlook Express ............................................................ 69
Access from Mozilla Thunderbird ...................................................................... 73
Access from Apple Mail ..................................................................................... 76
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Access from Webmail
 To access your mailbox through webmail, do any of the following:


In a Web browser, visit the URL webmail.example.com, where example.com is the
Internet address of your website. When prompted, specify your full e-mail address as the
username (for example, mail@example.com), and specify the password that you use
for logging in to the Panel.



When logged in to the Panel, click the Mail tab, and in the list of e-mail addresses, click
an icon
corresponding to the e-mail address you need.

Access from Microsoft Office Outlook
 To set up Microsoft Office Outlook 2010:
1. Open Microsoft Office Outlook.
2. Go to File > Info > Add Account.
3. Select the checkbox Manually configure server settings or additional server types.
Click Next.
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4. Select the Internet E-mail option and click Next.
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5. Specify the following:


Your name.



Your e-mail address.



Account type. If you want to keep copies of messages on the server, select the IMAP
option. If you do not want to keep any messages on the server, select the POP3
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on email messages you receive, if SpamAssassin is enabled on the server.



Incoming mail server. Type your domain name. For example, example.com.



Outgoing mail server (SMTP). Type your domain name. For example, example.com.



User Name. Specify your full e-mail address. Example: johndoe@example.com.



Password. Most likely, this password coincides with the password you use for logging
in to Panel.



Require logon using Secure Password Authentication (SPA). Leave this option cleared.
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6. Click More Settings, open the Outgoing Server tab and check My outgoing server
(SMTP) requires authentication.

7. Click Next.
8. Click Finish.
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Access from Microsoft Outlook Express
The instructions provided in this section were verified against Microsoft Outlook Express 6.
They might not work with earlier or later versions of Microsoft Outlook Express.

 To set up Microsoft Outlook Express:
1. Open Microsoft Outlook Express.
2. Go to Tools > Accounts.
3. Click the Add button and select the Mail item.
4. Enter your name as you want it to appear in any messages you send, and
click Next.
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5. Type your e-mail address, and click Next.
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6. Specify the following settings:


Protocol of your incoming mail server.
If you want to keep copies of messages on the server, select the IMAP option. If you
do not want to keep any messages on the server, select the POP3 option. Selecting
IMAP will also allow you to train the SpamAssassin spam filter on e-mail messages
you receive, if SpamAssassin is enabled on the server.



Incoming mail server. Specify your website's Internet address.



Outgoing mail server. Specify your website's Internet address.
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7. Click Next.
8. Specify the following:


Your account name. Type your e-mail address in the Account name box.



Your password. Most likely, this password coincides with the password you use for
logging in to the Panel.



Remember password checkbox. Leave it selected if you do not want to be prompted to
enter password each time your e-mail program connects to the mail server to check
for new mail, and click Next.

9. To complete setting up your e-mail program, click Finish.
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Access from Mozilla Thunderbird
The instructions provided in this section were verified against Mozilla Thunderbird 12. They
might not work with earlier or later versions of Mozilla Thunderbird.

 To set up Mozilla Thunderbird:
1. Open Mozilla Thunderbird.
2. Go to Tools > Account Settings > Account Actions > Add Mail Account.
3. Specify the following:


Your name, as you want it to appear in any messages you send.



Your e-mail address and password.

73

74

Website Management

4. Click Continue.
5. If Thunderbird fails to find the settings automatically, specify the following:


Account type. If you want to keep copies of messages on the server, select the IMAP
option. If you do not want to keep any messages on the server, select the POP3
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on email messages you receive, if SpamAssassin is enabled on the server.
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6. Click Create Account.

If you set up a mail account manually, please use the following typical combinations of
connection security and authentication method settings. If the settings do not work for you,
ask your hosting provider about the correct combination.
On Linux:


Connection security: STARTTLS



Authentication method: Encrypted password
On Windows, IMAP:



Connection security: None



Authentication method: Encrypted password
On Windows, POP3:



Connection security: None

Authentication method: Password, transmitted insecurely Other parameters that you may need
when configuring your account manually:


POP3 port: 110




IMAP port: 143
SMTP port: 25



Username. Your full e-mail address. For example: johndoe@example.com.



Incoming server address (POP3/IMAP). Specify your website's Internet address. Example:
example.com



Outgoing server address. Specify your website's Internet address. Example: example.com
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Access from Apple Mail
The instructions provided in this section were verified against Apple Mail 3.6 (Leopard). They
might not work with earlier or later versions of Apple Mail.

 To set up Apple Mail:
1. Run Apple Mail.
If you run it for the first time and do not have any mail accounts configured in it, skip the
next step: Apple Mail will take you directly to creating one.

2. Open the Adding Mail Account wizard:
a. Click Mail > Preferences....
b. Select the Accounts tab.
c. Click the + button at the bottom left corner.
3. Enter the account information:


Your full name



Your full e-mail address



The password you use to log in to the Panel.
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4. Click Continue.
5. Fill in the following incoming mail server information:


Account Type: select whether you want to use IMAP or POP protocol.
We recommend selecting IMAP if you use SpamAssassin as a spam filtering solution:
IMAP account is a requirement for SpamAssassin learning which messages are spam
and which are not.



Incoming Mail Server: type in the name of domain which serves your mail (which follows
the @ sign in your e-mail address).



User Name: enter your full e-mail address.



Password: leave it auto-completed (Apple Mail takes it from the previous step).
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6. Click Continue.
7. (Optional) Specify the incoming mail security options:
a. Select the Use Secure Sockets Layer (SSL) checkbox.
b. Select the authentication method.
Keep the default method if you are not sure which to select.
Apple Mail displays this setup screen only if a mail server bundled with Panel supports
SSL for the selected account type (POP or IMAP).
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8. Click Continue.
9. Fill in the following outgoing mail server information:


Outgoing Mail Server: type in the name of domain which serves your mail (which follows
the @ sign in your e-mail address).



Use only this server: selected.



Use Authentication: selected.



User Name: enter your full e-mail address.



Password: leave it auto-completed (Apple Mail takes it from the previous step).
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10. Click Continue.
Apple Mail displays overall description of the mail account that is going to be created.

11. Select the Take account online checkbox and click Create.
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View Site Visit Statistics
Finally, when your site works fine and search engines return it in search results, it is the best
time to evaluate site efficiency by viewing the visits statistics.

 To find out how many people visited a site, from what countries, and what
pages of the site they viewed:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the domain name for which you
want to view the statictics
3. Click Web Statistics.
The site visitor statistics will show in a new browser window.

4. To view statistics for web pages viewed from the SSL-secured area of your
site, select SSL Web Statistics in the menu.
5. To view statistics for files downloaded over the file transfer protocol (FTP),
select FTP Statistics in the menu.
Alternately, you can view the visits statistics for a site by visiting the following URL:
https://your-domain.com/plesk-stat/webstat. When prompted for username and password,
specify your FTP account username and password.
You have successfully completed the quick start part of the guide. Feel free to read about
other features that are available to you in the Control Panel.

Customer Account Administration
As described in the section Quick Start with Parallels Panel, the first step in establishing your
company's web presence is signing up to the services provided by a hosting company
(hosting provider). After you subscribe to a hosting plan, a customer account in Panel is
created to enable you to log in to Panel and use the hosting services and resources like
mailboxes, disk space, and bandwidth.
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Customer Account and Multiple Subscriptions
Panel allows you to subscribe to as many hosting plans as you need. For example, if you do
not want your main site to share hosting resources with a company's branch site you can
subscribe to another hosting plan under the same customer account. In other words, a
customer account is a personalized access to all your subscriptions (see the picture below).
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Another reason for using multiple subscriptions is that subscription is limited to only one IPv4
and one IPv6 address. Thus, all domains within a subscription share the same IP address
(v4 or v6). If you need to host sites on different IP addresses, you should additionally order
the same plan for as many IP addresses as you need. This can be useful, for example, if you
want to secure connections to each of your sites with a separate SSL certificate. For
information on how to purchase an additional subscription, refer to the section Ordering More
Resources (on page 97).
If you have multiple subscriptions under a single customer account, you can easily switch
among them from the Account tab. To be more specific, the Account tab provides access to
operations that apply to all your subscriptions. All other tabs (like Mail, Users, or Domains &
Websites) are, on the contrary, subscription-wide. This means that to change mail settings on
a particular subscription, you should first switch to it before clicking Mail.

System Users
For each hosting subscription, Panel creates a system user - a user account in the Panel
server operating system. Customers obtain their system users' access credentials from their
service providers and use these credentials for connecting to the server through FTP, SSH,
and so on. In addition, all operations with files and directories in Panel are performed on
behalf of system users. For example, when a customer adds a new file in File Manager, the
subscription's system user becomes the owner of the file.

Adding Resources to a Subscription
Purchasing a new subscription for extending hosting resources is not always necessary. You
can always improve just one of your subscriptions. For example, add extra disk space or SSL
support. This can be done by switching to another hosting plan or by purchasing hosting plan
add-ons. Learn more in the section Ordering More Resources (on page 97).

Managing Customer Account
In Panel, you can perform a number of administrative operations on your customer account:


Change an account password and personal information. Learn more in the section
Changing Your Password and Contact Information (on page 85).



View the list of services and resources provided by subscription on the Account tab. For
detailed information about all subscription features, refer to the section Viewing
Subscription Summary (on page 86).



Make payments to renew your subscription. Learn more in the section Managing Account
Balance and Invoices (on page 93).



View statistics on your account: For example, disk space or traffic usage. Learn more in
the section Viewing Statistics (on page 99).
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Allowing Other Users to Access Your Account
If the number of hosting maintenance operations is too large to be handled by one person,
you can delegate some of them to other people. For this purpose, you can create auxiliary
user accounts grouped by means of user roles. For example, you can create a group that is
allowed to only upload content to websites. Users in this group will not be able to perform
any operations except for managing website content. For more information about auxiliary
users, refer to the section (Advanced) Managing Auxiliary User Accounts (on page 101).

Next in this section:
Changing Your Password and Contact Information ........................................... 85
Viewing Subscription Summary ......................................................................... 86
Managing Account Balance and Invoices .......................................................... 93
Ordering More Resources ................................................................................. 97
Viewing Statistics .............................................................................................. 99
(Advanced) Managing Auxiliary User Accounts ................................................. 101
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Changing Your Password and Contact Information
 To change your password for access to the Control Panel:
1. Click a link with your name at the top of the screen.
2. Type a new password, and click OK.

 To change a username or password that you use for connecting to your
subscription over FTP or SSH:
1. Click the Websites & Domains tab.
2. Click Web Hosting Access.
3. Type the new username or password, and click OK.

 To change your contact information:
1. Click a link with your name at the top of the screen.
2. Click the Contact Details tab.
3. Update your contact information and click OK.
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Viewing Subscription Summary
When you subscribe to hosting services, a user account is created in the Panel to allow you
to manage your websites and mailboxes on your own.
You can view the following information about your account:


Current subscriptions to service plans.
You can be subscribed to a number of service plans at once, and, therefore, can have
several subscriptions associated with your account. If a billing system is connected to the
Panel, then you can also purchase additional subscriptions, upgrade or downgrade them,
and pay your invoices.



Allocated and consumed resources.



Hosting features available for your websites.



Operations you can perform in your Panel.



Account balance, unpaid invoices, and monthly fee for your hosting package.

 To view the information about your account and your current subscriptions:
1. Click the Account tab.
A list of your current subscriptions is shown.

2. If the billing system is integrated with the Panel, then the following
information is shown:


Account credit balance. This is how much money is available in your billing account.



Due invoices balance. This is how much money you owe to your provider. Here, you can
pay all invoices at once by clicking Pay All Outstanding Invoices, or pay one of invoices
by clicking a Pay Now link in the list titled Latest Outstanding Invoices. You can also view
all invoices by clicking the link Show all invoices, or print an invoice by clicking an
invoice number and then clicking Print.



Latest to-do items. This shows reminders from the system about the actions you need to
take.



List of all your subscriptions. You can use links in the list to perform the following
operations:


View subscription properties by clicking a link with subscription name.



Select a subscription that you want to manage through the Control Panel by
clicking the corresponding link Switch to Subscription.



Order an SSL certificate for a site by clicking Request SSL Certificate. This operation
is described in the section Ordering SSL Certificates.



View properties of already ordered SSL certificates by clicking Show Certificate Info.



View or change domain information, contact information, and DNS settings
specified at a registrar's site, by clicking Show Domain Info. These operations are
described in the section Registrar's DNS Settings in Panel (on page 122).

3. To view detailed information about resource allotments, available hosting
options, and permissions for operations, click a subscription's name.
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4. Do any of the following:


To view a list of allocated and consumed resources, click the Resources tab.



To view a list of hosting features available for your account, click the Hosting Options
tab.



To view a list of operations that you can perform in your Hosting Panel, click the
Permissions tab.

Next in this section:
Allocated and Consumed Resources................................................................. 88
Hosting Features Available for Your Websites ................................................... 90
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Allocated and Consumed Resources
If you are subscribed to a number of service plans at once, then you have several
subscriptions. For each subscription, the following types of allocated resources are listed in
the Panel at the Account tab > subscription name > Resources tab:


Disk space. This is the total amount of disk space allocated to your account with
subscription. This amount includes all data related to your websites, e-mail accounts,
applications, backups, and log files.



Traffic. This is the total amount of data in megabytes that can be transferred monthly from
all your websites.



Domains. This is the number of websites that can have separate second-level domain
names, such as, for example, example.com.
For information about setting up websites, refer to the sections Set Up Your First Website
(on page 58) and Adding Domains (on page 110).



Subdomains. This is the number of additional websites that can have third-level domain
names, such as, for example, news.example.com.
For information about setting up subdomains, refer to the section Adding Subdomains (on
page 112).



Domain aliases. This is the number of additional domain names that can be set up to point
to one of your sites. For example, example.fr and example.de can both point to
example.com.
For information about setting up domain aliases, refer to the section Adding Domain Aliases
(on page 114).



Mailboxes. This is the number of mailboxes that can be created under all your websites.
For information about creating mailboxes, refer to the chapter Mail.



Mailbox size. This is the amount of disk space that can be occupied by a mailbox.



Total mailboxes quota. This is the total amount of disk space that can be used by all
mailboxes under all your domains. This option is available only on Windows-based
customer accounts.



Mailing lists. This is the total number of mailing lists that can be set up under all your
websites. Note that there are mailing lists and mail groups, which serve the same
purpose, but are slightly different in functionality. Mailing lists support archiving and premoderation of messages, while mail groups can only be used for sending one message to
a number of recipients at once.
For information about setting up and using mailing lists, refer to the section Using Mailing
Lists (on page 266).



Additional FTP accounts. This is the number of FTP accounts that can be set up for
accessing the webspace, in addition to the main FTP account that was created when your
subscription was activated.
For information about setting up FTP accounts, refer to the sections Changing FTP Access
Credentials (on page 252) and Adding FTP Accounts (on page 253).



Databases (Linux). This is the number of databases that can be hosted for all your
websites. Databases are a standard means of organizing data storage that allows
dynamic websites, web applications, and their users to store, search, and retrieve
information.
For information about working with databases, refer to the chapter (Advanced) Using
Databases.
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MySQL databases and Microsoft SQL Server databases (Windows). This is the maximum
number of MySQL and Microsoft SQL Server databases respectively that can be created
on the Panel database servers and used by the subscription's websites.



MySQL databases quota and Microsoft SQL databases quota (Windows). This is the maximum
amount of disk space (in megabytes) that the subscription's MySQL and Microsoft SQL
Server databases respectively can occupy.



Java applications. This is the number of Java applications packaged in WAR format that
you can install on your sites.



Sites published with Presence Builder. This is the number of sites that you can create and
publish using Presence Builder, if Presence Builder option is included in your hosting
package.



Mobile sites.This is the total number of websites that you can host with the UNITY Mobile
online service, which optimizes sites for viewing on mobile devices.



Web users. This is the number of user accounts that you can create for hosting web pages
for other users under your domains.



FrontPage accounts. This is the number of Microsoft FrontPage user accounts that you can
create for collaboration on site content using FrontPage. This option is available only for
Windows-based customer accounts.



Shared SSL links. This is the number of websites that you can secure with an SSL
certificate shared by your provider. This option is available only for Windows-based
customer accounts.



ODBC DSN connections. This is the number of connections to external databases that you
can create for web applications running on your customer account. This option is
available only for Windows-based customer accounts.



ColdFusion DSN connections. This is the number of connections to external databases that
you can create for web applications written in Adobe ColdFusion, which are running on
your customer account. This option is available only for Windows-based customer
accounts.
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Hosting Features Available for Your Websites
Depending on your service plan, the following hosting features may be available for your
websites (listed at the Account tab > subscription name > Hosting Options tab):


SSL support. This allows you to secure connections to websites with SSL encryption.
For information about securing sites with SSL, refer to the section Securing Connections
with SSL Certificates (on page 161).



Web statistics. This allows you to view website visits statistics presented in diagrams and
charts.
For information about viewing website visits statistics, refer to the section Viewing Statistics
(on page 99).



Custom error documents. This allows you to create custom HTML pages and configure web
server to show them instead of typical error messages, such as 404 Not Found.
For information about setting up custom error documents, refer to the section Setting Up
Custom Error Pages (on page 170).



Support for programming and scripting languages, such as PHP, CGI, Perl, Python, Microsoft
ASP, ASP.NET, Adobe ColdFusion, SSI.



Microsoft FrontPage support and Microsoft FrontPage over SSL support. These allow you to use
Microsoft FrontPage to create and edit website content. These options are available only
for Windows-based customer accounts.



Remote Microsoft FrontPage authoring (Windows). This allows you to use Microsoft
FrontPage to create and edit website content directly on the server. This option is
available only for Windows-based customer accounts.



Dedicated IIS application pool (Windows). This provides isolation and improved stability for
web applications working on sites.



Additional write/modify permissions (Windows). This option allows the web applications to
use a file-based database (like Jet) located in the root of httpdocs folder.



Allow web users to use scripts. This allows scripting at web pages available at URLs like
http://example.com/~<username>/<webpage>, where <username> refers to a web user.
Web users are individuals who do not need their own domain names. This service is
popular with educational institutions that host non-commercial personal pages of their
students and staff.

The following is a list of permissions for operations that you can perform in your Panel
(shown at the Account tab > subscription name > Permissions tab):


DNS zone management. Manage resource records in the DNS zones of websites. DNS
stands for Domain Name System. It is a service that enables web browsers to locate
websites by domain names.
For information about configuring DNS settings for your websites, refer to the section
(Advanced) Configuring DNS for a Domain (on page 116).



Hosting settings management. Manage web hosting settings, such as custom web server
settings or support for scripting languages.
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PHP safe mode management. This option is available only for Linux-based customer
accounts. It allows you to switch PHP safe mode on or off for websites. Safe mode is a
security restriction that does not allow scripts written in PHP to perform potentially
dangerous operations on the server. You might need to switch off the safe mode for PHP
if you use some web applications written in PHP and if they do not function properly.



Management of access to the server over SSH and Management of access to the server over Remote
Desktop. Securely upload web content to the server through Secure Shell (Linux) or a
Remote Desktop connection (Windows).



Anonymous FTP management. Set up a folder on the server which should be accessible to
the Internet users over FTP protocol. This folder can have an address like, for example,
ftp://downloads.example.com. This feature is called anonymous FTP because the users
will not need to specify a username and password to browse, download, or upload files.
For information about setting up FTP folder with unrestricted access, refer to the section
Setting Up Anonymous FTP Access (on page 255).



Scheduler management. Schedule execution of programs or scripts in the server's operating
system.
For information about scheduling tasks, refer to the chapter Scheduling Tasks.



Spam filter management. Set custom settings for protection from unsolicited commercial email, also known as spam.
For information about setting up spam filtering, refer to the section Protecting Mailboxes
from Spam.



Antivirus management. Set custom settings for protection from viruses and other malicious
software that spreads itself through e-mail.
For information about setting up virus protection, refer to the section Protecting Mailboxes
from Viruses.



Data backup and restoration using the server repository. Use the backup and restore functions
of the Panel to back up and restore websites, mail accounts, settings, and keep your
backup files on the server.
For information about backing up and restoring data, refer to the chapter (Advanced) Back
Up and Restore Data.



Data backup and restoration using a personal FTP repository. Use the backup and restore
functions of the Panel to back up and restore websites, mail accounts, settings, and save
your backup files to an FTP folder on another server.
For information about backing up and restoring data, refer to the chapter (Advanced) Back
Up and Restore Data.



Web statistics management. Set custom preferences for visitor statistics reports.
For information about configuring and viewing website visitor statistics, refer to the
section Viewing Statistics (on page 99).



Log rotation management. Set custom preferences for recycling (rotation) of web server
logs. Web server records information about connections to your sites and errors occurred
on attempts to retrieve missing files. You can use these log files for website debugging
purposes.
For information about working with web server access logs, refer to the section Log Files
(on page 100).



Access to Application Catalog. View and install applications on websites. For information
about applications, refer to the section Employing Website Applications (on page 151).



Setup of potentially insecure web scripting options that override provider's policy. This allows you
to override the hosting security policy, if it is applied by the provider.
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Domain creation. Set up and manage new websites.
For information about setting up websites, refer to the sections Set Up Your First Website
(on page 58) and Adding Domains (on page 110).



Subdomains management. Set up and manage new websites with addresses like
forum.example.com.
For information about setting up subdomains, refer to the section Adding Subdomains (on
page 112).



Domain aliases management. Set up and manage additional domain names for a site.
For information about setting up domain aliases, refer to the chapter Adding Domain Aliases
(on page 114).



Additional FTP accounts management. Set up and manage additional FTP accounts. To
enable collaboration on website content, you can set up FTP accounts for other users
and specify which directories of the site should be accessible to them.
For information about setting up FTP accounts, refer to the section Adding FTP Accounts
(on page 253).



Java applications management. Install and manage Java applications distributed in WAR
archives and obtained separately from third-party vendors or application developers.
For information about installing Java applications, refer to the section Installing Java
Applications.



Mailing lists management. Set up and manage mailing lists.
For information about setting up and using mailing lists, refer to the section Using Mailing
Lists (on page 266).



Hosting performance settings management. Limit the bandwidth and number of connections to
websites.
For information about restricting bandwidth usage for sites, refer to the section Limiting
Bandwidth and Number of Connections to Websites (on page 177).



IIS application pool management. Set custom preferences for IIS application pool (available
only on Windows-based customer accounts).
For information about setting up IIS application pool, refer to the section Setting Up IIS
Application Pool (Windows) (on page 196).



Additional write/modify permissions management. Set additional write/modify permissions for
websites that use file-based databases (available only on Windows-based customer
accounts).



Shared SSL management. Secure connections to your sites with SSL protection by using an
SSL certificate shared by your provider.
For more information, refer to the section Using Shared SSL Certificates (Windows) (on page
165).



Hard disk quota assignment. Adjust hard quotas on disk space if that is supported by your
customer account.



Database server selection. Select a database server for creating databases, if multiple
database servers are available.

Website Management

93

Managing Account Balance and Invoices
The operations described below are available if your Control Panel is integrated with
Parallels Parallels Customer and Business Manager.

 To view your account balance and pay for hosting services:
1. Click the Account tab.
2. The following information is shown:


Account credit balance. This is how much money is available in your account.



(Optional) Usage charge. If your subscription allows consuming hosting resources
over the plan limit, this number shows how much money you should pay for these
resources in addition to your subscription price. To view the detailed information about
how much resources you used over limits, click the link See details below the charge
amount. To learn how the system calculates usage charges, see the section
Calculating Usage Charges (on page 95).



Due invoices balance. This is how much money you owe to your provider. Here, you
can pay all invoices at once by clicking Pay All Outstanding Invoices, or pay one of
invoices by clicking a Pay Now link in the list titled Latest Outstanding Invoices.



Latest to-do items. This shows reminders from the system about actions you need to
take.



(Optional) Affiliate programs. Your provider may let you earn money for promoting
their plans. To start earning, you should join their affiliate programs. Here you can find
the link to join affiliate programs or the info about your money you earn if you already
joined the programs. To learn how to get profit from affiliate programs, see the section
Earning Money by Promoting a Provider's Plans (on page 95).



List of all your subscriptions. You can use links in the list to perform the following
operations:


To view subscription properties, click a link with subscription name.



To select a subscription that you want to manage through the Control Panel, click
the corresponding link Switch to Subscription.



To order an SSL certificate for a site, click Order a Certificate. For more information
about this operation, see the section Ordering SSL Certificates.



To view properties of already ordered SSL certificates, click Show Certificate Info.



To view or change domain information, contact information, and DNS settings
specified at a registrar's site, click Show Domain Info. For more information about
these operations, see the section Registrar's DNS Settings in Panel (on page 122).
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 To choose a payment method that you would like to use for paying for
services:
1. Go to the Account tab > Billing Accounts.
A record about the payment method that you used for purchasing the services for the first
time is shown.

2. Do any of the following:


To view or change settings for a billing account, click the corresponding link in the
Billing account name column, specify the information about your bank card or account,
and select the subscriptions that should be paid by it. Click OK.



To add a new billing account, click Add New Billing Account, select the payment method,
and click Next. Then choose the account owner (you or an auxiliary user that will be
able to use this account), specify the required information about your bank card or
account, and select the subscriptions for which you will pay with it. Click OK.



To remove a billing account, click the corresponding Remove link.

Next in this section:
Calculating Usage Charges ............................................................................... 95
Earning Money by Promoting a Provider's Plans ............................................... 95
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Calculating Usage Charges
If the pay-as-you-go web hosting is allowed for a plan, Business Manager calculates usage
charges - total costs of hosting resources overage - for the plan's subscribers basing on
resource usage statistics that Business Manager collects from the connected Panels on a
daily basis. No matter what billing mode and billing cycles you use, this happen on the first
day of each month: The system finds the average daily overage of each resource except
traffic and multiplies it by the month length and the monthly usage price of this resource.

Traffic
The traffic usage charge is calculated in the following way: Business Manager counts the
total traffic overage for a month and multiplies it by the monthly traffic usage price. For
example, if subscribers download 10 GB of files during a month while the plan limit is 5 GB,
then the traffic overage is 5 GB. Assuming that the traffic usage price is $1 for a 1 GB, such
subscribers will pay (10 GB - 5 GB) * $1 = $5 traffic usage fee.

Other Resources
For calculation usage charges for other resources, Business Manager uses the average daily
usage values. For example, if a customer uses 500 MB of disk space over the subscription
quota for 15 days and then uses extra 700 MB for other 15 days, the average overage will be
(500 * 15 + 700 * 15)/30 = 600 MB. If the disk space usage price is $1 for 1 GB, then the
customer will pay $0.6 for disk space overage this month.

Calculating Usage with Add-ons
If a customer purchases additional resources in the middle of a month, then the system
subtracts the resource amount provided by the add-on from the daily resource usage of each
day starting from the add-on purchasing day.
For example, if a customer uses 500 MB of disk space over the plan limit for a whole month
and purchases the add-on that provides an additional 1 GB of disk space on the 7th day of
the month, then the usage charge will include the payment for only 7 days of 500 MB of disk
space overage.

Earning Money by Promoting a Provider's Plans
Panel lets you earn money for promoting your provider's service plans. Particularly, you can
get a certain commission for each subscription ordered in the provider's online stores by
people who signed up using your referral link.
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Participants of affiliate programs (affiliates) distribute links to their provider's online stores.
Each link is unique, so the system defines who brought a new customer and adds the
commission to the link owner's affiliate balance. This commission is defined by the terms of
the affiliate program and may vary depending on an online store. The commission consists of
two different elements:


Initial rate - a percentage that the affiliate earns from the price of each order placed using
the affiliate's link.



Recurrent rate - a percentage that the affiliate earns from each invoice issued for
subscriptions that were ordered using the affiliate's link.

Affiliates can use money they earn only after the provider pays out the money to them.
Depending on the affiliate program conditions, the provider can pay out the commission
either to the affiliate's account credit balance or transfer the money outside the system, for
example, by check or cash. Normally, the provider pays out affiliates' commissions when
they exceed the affiliate program's payment threshold. When the threshold is exceeded,
affiliates can request the provider to pay out the commission by using the button in the
Control Panel. Alternatively, affiliates can delay payments in order to earn a larger amount.

Becoming an Affiliate
To start earning money, click the link Become an Affiliate on the Account tab. Once became an
affiliate, you will get the access to the list of the provider's affiliate programs and your affiliate
links. To see the programs list and your links, click the Affiliate Programs list on the Account
tab.

Tracking Your Earnings
To see your current affiliate balance, go to the Account tab and find the balance in the Affiliate
Programs group. If you want to see detailed information about your earnings, click the link
Revenue from Referrals.
To request a payout after exceeding a payment threshold, go to the Affiliate Programs page,
select the programs and click Request Payout.
Note: If none of your affiliate balances exceed the corresponding thresholds, you will not see
the Request Payout button.

Example
For example, your provider offers you an affiliate program with 10% commission rate and
$20 payment threshold. You share your affiliate link with your friends, and three of them
subscribe to a web hosting plan which costs $50. The total commission that you get to your
affiliate balance is $50 * 3 * 10% = $15. This amount is less than the program's payment
threshold, so to receive credits, you should bring more customers to the online store with
your link. When you do this and your balance exceeds the payment threshold which is $20,
the provider will add this balance to your credits. When you receive them, you can use them
to pay for your subscriptions or subscribe to new services in the provider's online stores.
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Participating in Multiple Programs
Your hosting provider may have multiple online stores with different currencies. If the
provider offers affiliate programs for stores with different currencies, you will receive separate
commissions in the corresponding currencies. For example, if you distribute links to stores
with USD and EUR currencies, your affiliate balance contains two separate affiliate balances,
one for each currency. Your provider pays out the commissions separately as well. For
example, your affiliate balance is USD 50 and EUR 40 and the payment thresholds of the
corresponding programs are USD 40 and EUR 45, your provider will pay out USD 50 to your
credits and your affiliate balances will be USD 0 and EUR 40.

Ordering More Resources
The operations described below are available if your Control Panel is integrated with a billing
system.

 To add more resources to your subscription or upgrade to another service
plan:
1. Click the Account tab.
2. In the list of subscriptions, locate the subscription that you want to upgrade
to another service plan, and click a link with the currently used plan's name.
3. Click Upgrade.
If there is no Upgrade link, then it means that you cannot upgrade to another hosting plan
from your Control Panel, and you need to contact your provider.

4. Do any of the following:


To add resources to your subscription without upgrading to another plan, select the
options you would like to add and click Adjust Add-ons.



To upgrade to another service plan, click Order Upgrade.

 To reduce the amounts of resources or downgrade to another service plan:
1. Click the Account tab.
2. In the list of subscriptions, locate the subscription that you want to
downgrade to another service plan, and click a link with the currently used
plan's name.
3. Click Downgrade.
If there is no Downgrade link, then it means that you cannot downgrade to another hosting
plan from your Control Panel, and you need to contact your provider.

4. Do any of the following:


To reduce the amounts of allocated resources without downgrading to another plan,
select the options you would like to reduce and click Adjust Add-ons.



To downgrade to another service plan, click Order Downgrade.
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 To subscribe to a hosting plan in addition to your main plan:
1. Go to the Account tab and click the Add Subscription link.
2. Select the hosting plan to which you want to subscribe, and click Buy Now.
Follow the instructions on the screen to complete the order.
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Viewing Statistics
 To view the reports on disk space and traffic usage by your account:
1. If you have several subscriptions associated with your account, in the
Subscription menu at the top of the screen, select the required subscription.
2. Click the Statistics tab.
The following information is presented in charts:




Disk space used by the following files and directories in the subscription:


Websites



Mail accounts



Databases



Logs



Backups



Chroot directories



Configuration files



Anonymous FTP directory

Traffic used by FTP, web, and mail services during the current month.
FTP field shows the information about the total size of files transferred to and from the
webspace over the file transfer protocol.
HTTP field shows the information about the total amount of data transferred from all of
your websites over HTTP protocol, that is, retrieved by web browsers.
POP3/IMAP field shows the total amount of data received by all mail accounts under
your domains.
SMTP field shows the total amount of data sent by all mail accounts under your
domains.

3. Do any of the following:


To view a report on the amount of data transferred to and from your sites over FTP,
click FTP Statistics.



To view a report on the amount of data transferred to and from your FTP directory,
which is accessed without authorization, click Anonymous FTP statistics.



To view a report on the amount of traffic used by services during a certain month, click
Data Transfer Statistics, and select the required month from the menu.

Next in this section:
Log Files ........................................................................................................... 100
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Log Files
All connections to the web server and requests for files that were not found on the server are
registered in log files. These log files are analyzed by the statistics programs running on the
server, which then present graphical reports on demand. You may want to download these
log files to your computer for processing by third-party statistics programs, or view their
contents for web server debugging purposes.

 To prevent these log files from growing too large, you should enable automatic
cleanup and recycling of log files:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Logs > Log Rotation.
3. Click Switch On. If you see only the Switch Off button there, this means that log
recycling is already switched on.
4. Specify when to recycle log files and how many copies of each log file to
store on the server. Also specify whether they should be compressed and
sent to an e-mail address after processing.
5. Click OK.

 To view the contents of a log file or download it to your computer:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Logs. A list of log files opens.
3. Do any of the following:


To view all entries in a log file, click the log file name. If you want to view only a few
last lines from the log file, type the number of lines into the input box under the Settings
group, and then click the log file name.



To download a file to your computer, click the corresponding icon



To remove a processed log file from the server, select the corresponding checkbox
and click Remove. Confirm removal and click OK.

.

 To download log files to your computer via FTP:
1. Connect to the Panel server via FTP.
2. Go to the /var/www/vhosts/<domain_name>/logs directory and copy
the log files to you computer.
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(Advanced) Managing Auxiliary User Accounts
If you want to allow other users to access the Panel for managing websites and installed
applications, or to use e-mail services under your domains, then you need to create user
accounts for them.

Auxiliary Users and User Roles
Auxiliary user accounts are created based on user roles. The roles include privileges to
access certain areas of the Panel and perform operations in the Panel. There are several
predefined user roles, namely: Accountant, Application User, Owner, and Webmaster. You
can review and modify the Accountant, Application User, and Webmaster roles to suit your
needs, or you can create your own custom roles. For more information on user roles and
user account creation, refer to the sections User Roles (on page 102) and Auxiliary User
Accounts (on page 104) correspondingly.
After auxiliary user accounts are created, the users will be able to log in to their accounts in
Panel and use shortcuts in their Panels to access their mailboxes and work with applications.
In addition, you can extend the list of links available to your auxiliary users with your custom
links. These can be links to corporate resources, sites on the web, and so on. Learn more in
Custom Links (on page 106).

Auxiliary Users and Multiple Subscriptions
Since Panel 10.4, if your customer account includes more than one subscription, you can
allow auxiliary users to access only a specified subscription. If the Access to subscriptions
property of a user account is set to a certain subscription, the user will always log in to this
subscription and will not be able to switch to other subscriptions.

Next in this section:
User Roles ........................................................................................................ 102
Auxiliary User Accounts..................................................................................... 104
Custom Links .................................................................................................... 106
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User Roles
 To create a user role:
1. Go to the Users tab > User Roles tab > Create User Role.
2. Specify the following:


User role name.



Access to Panel services. Grant the required permissions for operations to the user:





Manage users and roles. Add, modify, and remove user accounts and roles. Note that
even if this permission is not granted to a user, the user will be able to browse
contact information of other users after logging in to the Panel.



Create and manage sites. Set up, modify, remove domain names and subdomains,
host websites and change web hosting settings.



Configure log rotation. Manage settings for recycling of web server access and error
log files. View, download, and remove log files.



Configure anonymous FTP service. Set up a directory accessible to all Internet users
over FTP without authorization.



Create and manage scheduled tasks. Schedule execution of scripts or programs on
your customer account.



Configure spam filter. Set up spam protection for mailboxes.



Configure antivirus. Set up virus protection for mailboxes.



Create and manage databases. Add, modify, and remove databases stored on your
customer account.



Configure and perform data backup and restoration. Back up and restore data related to
your customer account, websites, and mailboxes under your domains.



View statistics. View reports on disk space and traffic usage by your websites, and
website visits.



Install and manage applications. Install applications on websites and manage them.



Design sites in Presence Builder. Create websites using Presence Builder.



Upload and manage files. Manage files and directories located in the webspace by
using the Panel's file manager.



Create and manage additional FTP accounts. Set up additional FTP accounts for other
users.



Manage DNS settings. Manage DNS settings for domains.



Install and manage Java applications. Install on websites third-party Java applications.



Create and manage mail accounts. Create, modify, and remove e-mail accounts.



Create and manage mailing lists. Create, modify, and remove mailing lists.

Access to apps. Select the applications that the user should be able to access and use.
All web applications installed on the server are listed in this area.
For more information about installing applications and providing access to users, refer
to the section Granting Auxiliary Users Access to Apps (on page 154).
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Access to the billing operations. Grant these permissions if you want users of this role to
view and pay invoices for your subscriptions.

3. Click OK.

 To modify user role properties:
1. Go to the Users tab > User Roles tab.
2. Click a link with the role name that you want to change.
3. Change the role properties as required and click OK.

 To remove a user role:
1. Go to the Users tab > User Roles tab.
2. Select a checkbox corresponding to the role you want to remove and click
Remove. Note that it is impossible to remove the Owner role and other roles
that are assigned to one or more users.
3. Click Yes to confirm the removal.
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Auxiliary User Accounts
 To create a user account:
1. Go to the Users tab > Create User Account.
2. Specify the following:


Contact name.



E-mail address. The e-mail address will be used as a user name for logging in to Panel,
unless you specify another name in the Username box.


To create a new e-mail address for the user, select the option Create an e-mail
address under your account,
type the desired left part of the address which goes before the @ sign, and, if you
have a number of domains on your account, select the domain name under which
the e-mail address should be created.



To associate with this user account an external e-mail address, select the option
Use an external e-mail address, and specify an existing external e-mail address.



User role. Select the required user role from the menu.



Access to subscriptions. Allow a user to access only a specified subscription. The All
value grants them access to all subscriptions within your customer account.



Username. The user name for access to Panel.



Password. The password for access to Panel.

3. Leave the User is active checkbox selected. Otherwise, the user will not be
able to access the Panel and use applications on your customer account.
4. Click OK.
5. Now, if you want to add contact information for the user, click a link with the
user's name, and then click the Contact Details tab, and specify the user's
contact information.
6. Click OK.
Now you can notify the user about creation of his or her account and ability to access Panel.
Provide the user with the address to open in his or her browser, the username (which is the
user's e-mail address), and the password that you specified in the account settings.

 To change user account properties:
1. Click the Users tab.
2. Click a link with the user's name.
3. Make the required changes and click OK.
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 To suspend or activate a user account:
1. Click the Users tab.
2. Click a link with the user's name.
3. Do any of the following:


To suspend a user account, clear the User is active checkbox. The user will no longer
be able to log in to the Panel and access applications.



To activate a user account, select the User is active checkbox.

4. Click OK.

 To remove a user account:
1. Click the Users tab.
2. Select a checkbox corresponding to the user account you want to remove,
and click Remove. Note that you cannot remove your own account.
3. Click Yes to confirm the removal.
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Custom Links
You can add custom hyperlinks to the Panel and make them visible for your users. The links
may lead to web resources, such as your corporate site, or to a web application that can
process online requests and accept additional information about the users who click these
links.
You can specify what information about users should be passed:


Subscription ID.




Primary domain name associated with a subscription.
FTP account username and password.



Customer's account ID, name, e-mail, and company name.

You can place the links in the following locations of the Control Panel, and decide who
should be able to see them:


On the Websites & Domains page in the Control Panel, visible only to you. This is achieved
by selecting the Customer's Home page option in the link properties.



On the Websites & Domains page in the Control Panel, visible to you and your users who
are allowed to log in to the Control Panel. This is achieved by selecting the Common
access option in the link properties.



On the Websites & Domains tab in the Control Panel, visible to you and your users who are
allowed to log in to the Control Panel. This is achieved by selecting the Websites & Domains
page of Subscription option in the link properties.

 To add a custom hyperlink to the Control Panel:
1. Go to the Account tab > Additional Services, and click Add Link to Service.
2. Specify the following settings:


Type the text that will show on your button in the Button label box.



Choose the location for your button.



Specify the priority of the button. Your custom buttons will be arranged in the Panel in
accordance with the priority you define: the lower the number, the higher the priority.
Buttons are placed in the left-to-right order.



To use an image for a button background, type the path to its location or click Browse
to browse for the desired file. It is recommended that you use a 16x16 pixels GIF or
JPEG image for a button to be placed in the navigation pane, and 32x32 pixels GIF or
JPEG image for buttons placed in the main frame or desktop.



Type the hyperlink of your choice to be attached to the button into the URL box.



Using the checkboxes, specify whether you want the customer information and other
data to be transferred within the URL. These data can be used for processing by
external web applications.



In the Tooltip text input field, type in the help tip that will be displayed when the users
place the mouse pointer over the button.
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Select the Open URL in Parallels Panel checkbox if you want the destination URL to be
opened in the main frame of the Panel, otherwise, leave this checkbox cleared to
open the URL in a separate browser window or tab.



If you want to make this button visible only to you, select the Show to me only checkbox.

3. Click Finish to complete creation.

 To remove a hyperlink button from the Panel:
1. Go to the Account tab > Additional Services.
2. Select a checkbox corresponding to the link that you want to remove an d
click Remove.
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Websites and Domains
As described in the chapter Quick Start with Parallels Panel, creating your web presence always
starts with purchasing a domain name. The domain name (or simply, domain) is the name
people use to access your site from their browsers, for example, www.example.com. The
domain registration is carried out by authorized companies - domain name registrars.
Hosting providers often carry out this function. For detailed information about how to manage
domains in Panel, refer to the section Domains and DNS (on page 109).
However, a domain is not a website. To make it accessible from the web and fill it with
content, you should subscribe to hosting services (obtain a customer account). That is to
supplement your domain with Internet connectivity, some disk space to store your content,
mail services, and so on. Thus, a website is a domain with provided hosting services.
Panel provides a full range of operations in regard to domains and websites:


Adding and removing domains, subdomains, and aliases.



Managing the content of your websites.




Installing various web apps.
Securing connections to your websites and much more.

This chapter provides detailed information on all the possible operations on websites and
domains in Panel. Note that some of these operations may be unavailable according to your
hosting plan.

Next in this section:
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Hosting Settings ................................................................................................ 125
Website Content ................................................................................................ 143
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Previewing Websites ......................................................................................... 150
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(Advanced) Extended Website Management..................................................... 166
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Domains and DNS
As described above, a domain name is the name that people type in their browsers to access
your website.
A domain name is hierarchical and can consist of a number of parts called labels:


The label furthest to the right is called the top-level domain. For example, com is the toplevel domain of www.example.com. The number of top-level domains is limited and all of
them are managed by separate international authorities.



The second-level domain is the label that we mainly use to imply the purpose of our
website. In www.example.com it is the example part. The combination of the secondlevel and top-level domain names specifies the exact location of your website.



Each label to the left is a subdomain of the domain to the right. For example, www is the
subdomain of example.com. Subdomains can be convenient when you want to isolate
some content from the main site, e.g. you can organize your personal blog on
myblog.example.com. For information on how to add subdomains in Panel, refer to the
section Adding Subdomains (on page 112).

If you want to host more than one website under your subscription, you can register more
domains and add them to your subscription. Registering new domains may be available to
you in the Control Panel if your hosting provider allows this. For information on how to
purchase and add domains in Panel, refer to the section Adding Domains (on page 110).
In fact, domain names exist only for convenience; the real communication between browser
and web servers uses IP addresses - the numerical host identifiers. For example, the real
address of www.example.com may be 192.0.2.12 (IPv4). To resolve domain names into IP
addresses, web hosts use DNS technology. For more details about how DNS is implemented
in Panel, refer to the section (Advanced) Configuring DNS for a Domain (on page 116).
DNS allows several domains to be resolved into one IP address. Such additional names are
called domain aliases. This is convenient when you have purchased several domains that
you want to point to the same website. For information on how to add aliases to existing
domains, refer to the section Adding Domain Aliases (on page 114).

Next in this section:
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Adding Domains
If your hosting package includes more than one domain name (website), then you can easily
add new domains to the server. Before you start adding a new domain that will use a
second-level domain name, like example.com, be sure to register this domain name. If your
hosting provider provides the domain name registration service, you can do this from the
Control Panel as described below. Otherwise, you should register your domain name with
another domain name registration authority.
You can set up the following types of site configurations through Panel:




Website addressed by a second-level domain name. The following services are available for
websites:


A unique Internet address (domain name), like example.com.



Additional domain names (domain aliases).



Subdomains - divisions of a site accessible by easy-to-remember addresses that are
added to the main site, like mail.example.com.



Separate FTP accounts for collaboration on the site content. For every FTP account,
you can specify which directories can be accessed.



Creating content using Presence Builder.



Simplified deployment of applications, such as content management systems, photo
galleries, shopping carts, blogging platforms, and many more.



Secure data exchange implemented by SSL protocol. This requires that a site be
hosted on a dedicated IP address, which is not shared among other users and sites.



Mailboxes and mailing lists.



Viewing statistics on site visits.

Website or a division of a website addressed by a third-level domain name (subdomain). This is
usually a division of an existing site. It has an Internet address comprising of three parts
separated by dots. The following services are available for subdomains:


Separate document root from the main site. Document root is a directory on the server
where web pages of a site are stored.



Access over FTP for content management.



Creating content using Presence Builder.



Simplified deployment of applications.



Secure data exchange implemented by SSL protocol.



Viewing statistics on site visits.
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Adding More Domains
 To host a new website with a second-level domain name:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscription menu at the top of the screen.
2. Click the Websites & Domains tab, click Add New Domain and follow on-screen
instructions.
Note: If you select the recommended option, you should connect the DNS settings
related and your domain name with the domain name at the registrar's side. To achieve
this, enter the Panel name server IP address into the respective NS record of the
registrar. The instruction on how to obtain the IP is as follows: go to Websites & Domains >
<domain name> > DNS Settings, find the NS record, and then find the A record
corresponding to the NS record value.
For example, if your NS record is
example.com.
NS
ns.example.com,
find the A record with ns.example.com, for example,
ns.example.com. A
192.0.2.12
The resulting value, 192.0.2.12, is the Panel name server IP you need.

3. Click OK.
The new domain name is now shown in the list at the bottom of the screen.

4. If the operation of changing hosting settings is available for your accoun t,
then you can click the domain name of the new website to view or change
the hosting settings, as described in the section Changing Hosting Settings (on
page 125).
You can now start creating your website with Presence Builder or upload your web content to
the webspace of the new website, as described in the section Managing Website Content (on
page 143).

Registering Domains
If your service provider offers the domain name registration service as well as web hosting,
you can initiate a domain registration directly from Panel. To register a domain name, add it
as described above and then click the link register it now beside the new domain name on the
Websites & Domains tab. This will redirect you to the provider's online store where you can
complete the registration.
After you register a domain name, it appears in the Registered domain names list on the
Websites & Domains tab. To get information about a domain name registration, for example,
the registration price and next renewal date, click the domain name in this list.
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Removing Domains
When you delete a domain from Panel, all data related to the corresponding site are deleted
from the server. The first domain name (default domain) that was created for your account
cannot be deleted; however, it can be renamed.

 To remove a domain:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscription menu at the top of the screen.
2. Go to the Websites & Domains tab and click the name of the domain or
subdomain you want to remove.
3. Click Remove Website or Remove Subdomain.
4. Confirm removal and click OK.
Note: Removing domain names from the Control Panel does not cancel the registration of
these names. If you registered these domains name, you still can use them for your
websites.

Adding Subdomains
If your hosting package includes subdomains, which are additional third-level domain names,
then you can use them to:


Organize logically the structure of your site.



Host additional websites or parts of a website on the same server without the need to pay
for registration of additional domain names.

An example of using subdomains:
You have a website your-product.com dedicated to promoting and selling your product. For
publishing information related to customer service and online order tracking, you can
organize the subdomain "orders" so that your users will be able to access this information
directly by visiting the Internet address "orders.your-product.com".
As subdomains have the same status with the additional domains, you can use the same set
of tools and services for working with subdomains. For example, SSL protection, Presence
Builder, web statistics, and so on.

 To set up a subdomain for a site division or a separate site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscription menu at the top of the screen.
2. Click the Websites & Domains tab.
3. Click Add New Subdomain.
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4. Specify the following:
a. In the Subdomain name box, type the portion of address that will be
added to the domain name of your main site.
b. In the Document root box, type the desired location of the directory
where all files and subdirectories of this site will be kept. You can
use the default directory of the main site, called httpdocs, or specify
another directory.
5. Click OK.
The new subdomain name is now shown in the list at the bottom of the screen.
You can now upload your web content to the subdomains webspace (directory on the
server), as described in the section Uploading Content over FTP.

Wildcard Subdomains
If you enter the asterisk (*) symbol as a subdomain name, Panel will create a so-called
wildcard subdomain.When site visitors enter any subdomain name that is not registered in
Panel, they will be redirected to this wildcard subdomain. You can create wildcard
subdomains on any domain name level. For example, you can create the
*.mystore.example.com subdomain. Learn more about wildcard subdomains in the section
Adding Wildcard Subdomains (Linux) (on page 115).
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Adding Domain Aliases
Domain aliases allow you to point several domain names to the same website. This can be
useful, for example, for branding purposes.

 To set up a domain alias in Panel:
1. Run the Add New Domain Alias wizard in the Websites & Domains tab.
2. Specify the domain for which you are creating an alias (the primary domain)
and the alias’s domain name, for example alias.tld, and set up the
following:


Synchronization of DNS zone with the primary domain
If this option is enabled, the DNS zone of the domain alias will be in sync with the zone of
the primary domain. Any changes made in the DNS zone of the primary domain will be
automatically applied to the DNS zone of the alias. For example, if you create the
CNAME record like blog.primary_domain.tld, the corresponding
blog.alias.tld record will be added to the zone of the alias.
Note: If a domain alias’s DNS zone is synced with the primary domain, you cannot modify
resource records in the alias's DNS zone.



Mail service
Panel does not allow creating mailboxes under domain aliases. Instead, the mailboxes of
the primary domain are used. If you select the Mail service option, the mailboxes created
under the primary domain will also be available under the alias. To enable users to read
mail sent to mailboxes under the alias, Panel redirects it to the corresponding mailboxes
under the primary domain.
For example:
You have an email address mail@domain.tld. Then you set up an alias for
domain.tld, for example, alias.tld. If you select the Mail service option, all mail sent
to mail@alias.tld will be available at mail@domain.tld. Otherwise, the mailbox
mail@domain.tld will not receive mail sent to mail@alias.tld.



Web service
If this option is turned on, the website will open in the browser at the alias’s URL. If you
clear the Web service check box, the alias will be used for mail only provided that Mail
service is selected.



Redirect with the HTTP 301 code
By default, Panel uses web server internal redirection for aliases. In this case, the alias
appears to be a separate website for visitors and for web search engines. This causes
the problem because search engines index the content of the alias separately, so your
primary domain loses search engine rankings.
To avoid this, you can use redirection with the HTTP 301 code (Moved permanently) by
selecting Redirect with the HTTP 301 code. In this case, only the primary domain will rank in
search engines. Learn more at
http://support.google.com/webmasters/bin/answer.py?hl=en&answer=93633
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Java web applications
If you use hosting services based on a Linux platform, and you have Java applications
installed on your site that you want to make accessible through the domain alias, select
the Java web applications option.

Adding Wildcard Subdomains (Linux)
Use wildcard subdomains to redirect visitors from non-existent subdomains to one of your
websites, commonly, to your main website. The typical use cases of this feature are:


Improve website organization and run marketing campaigns.
For example, you do not have the vps-limited-offer subdomain but wish to forward users
from limited-vps-offer.example.com to example.com.



Help users reach your website even if they mistyped a subdomain name.
It is a widespread mistake to mistype a website name if it has the leading www prefix (for
example, typing ww.example.com).



Finally, some website applications (WordPress) use wildcard subdomains to create
dynamic subdomains for convenience and better user experience.

Note: Traffic to existent subdomains will not be affected in any way if you add a wildcard
subdomain.

How to Add Wildcard Subdomains
You can add one wildcard subdomain per each of domain names under a subscription. For
this, go to the Websites & Domains tab and add a new subdomain which name is "*" to one of
your domain names. Example: *.example.com. If you wish this subdomain to have a custom
set of scripts or website content, specify a custom document root for this subdomain.

Limitations of Wildcard Subdomains
Wildcard subdomains act like typical subdomains with the following exceptions:



Linux-only feature. Currently, wildcard subdomains are supported only on Panel for
Linux.
Renaming is not available. It is not possible to rename such subdomains.



No DNS zone. This type of subdomains does not have own zone record in the Panel's
DNS server. Instead, they have the A record that points to the IP address associated with
a corresponding domain name.



Installation of APS apps is not allowed. Panel users are unable to install APS apps to
wildcard subdomains.



No Presence Builder sites. Panel users are unable to edit and publish sites to these
subdomains.
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(Advanced) Configuring DNS for a Domain
The Domain Name System (DNS) is a hierarchical naming system that translates
understandable domain names into the numerical identifiers (IP addresses) associated with
web hosts. Such translation is called resolving. When you add a domain name (using
Websites & Domains > Add New Domain), you should choose the role of Panel in resolving your
resources: It can directly process all translation requests, be a backup server, or pass the
translation requests to a remote server. This role can be changed for existing domain names
(Websites & Domains > domain name > DNS Settings). We discuss details about each of the
roles and provide instructions how to assign them next in this section.
Note: If your Panel does not use its own DNS service and does not allow configuring DNS
settings on a remote DNS server, you can only view the information about your registered
domain name. The link DNS Settings in Websites & Domains will be replaced with Whois
Information.

DNS Name Resolving
DNS is based on a hierarchical tree structure called the domain namespace. This global
namespace contains all possible domain names and is divided into logical parts - domain
zones (see the picture below). A domain zone is a part of the namespace that contains the
addresses of particular domains. Addresses are stored in a file on a separate name server
with authority for that zone. For example, when a browser tries to access
www.example.com, it gets the site's IP address from a server with authority for the
example.com zone. For more information about how DNS works, refer to the respective
documentation. You can find it in numerous sources on the Internet, for example, Microsoft
TechNet.
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When you purchase a domain, a registrar gives you access to the settings for the DNS zone
responsible for your domain and its subdomains. You can either allow the registrar to
manage the zone, or delegate the zone to Panel. The latter option gives you the ability to
manage a zone directly from your customer account. For information about how to delegate
your zone to the Panel, refer to the section Panel as a Master DNS Server (on page 118).
If you are an advanced user and already have a DNS server that you want to give authority
for your zone, you can set up Panel to be a slave (also called secondary) DNS server. In this
case, Panel just stores a copy of your zone and you do not have the option to manage it from
the Control Panel. The Panel DNS server will be used only if your primary name server
becomes inaccessible or inoperable. For information about how to make Panel act as a
secondary DNS server, refer to the section Panel as a Slave DNS Server (on page 122).
If you decide not to use Panel as a DNS server, all zone management should be performed
on a domain registrar's site. Some registrars provide support for remote DNS zone
management. If your hosting provider uses this feature, you will still be able to modify the
DNS zone from the Control Panel regardless of where your authoritative name server is
located. For information about how to switch off the Panel's DNS server and manage your
zone remotely, refer to the section Registrar's DNS Settings in Panel (on page 122).

Next in this section:
Panel as a Master DNS Server.......................................................................... 118
Panel as a Slave DNS Server............................................................................ 122
Registrar's DNS Settings in Panel ..................................................................... 122
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Panel as a Master DNS Server
For each new domain name, the Panel automatically creates a DNS zone in accordance with
the settings configured by your service provider. The domain names should work fine with
the automatic configuration, however, if you need to perform custom modifications in the
domain name zone, you can do that through your Panel.

 To view the resource records in a DNS zone of a domain:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to view.
2. Click DNS Settings.

 To add a new resource record to the zone:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage..
2. Click DNS Settings.
3. Click Add Record.
4. Select a resource record type, and specify the appropriate data:


For an NS record, which specifies the domain name of a name server that is
responsible for a DNS zone of a domain, you need to specify the domain name (or a
subdomain), and then the corresponding name server's domain name. If you are
defining an NS record for your main domain, then you should leave the domain name
field empty. If you are defining a name server for a subdomain, then type the
subdomain into the domain name field. After that, type the appropriate name server's
domain name into the name server field. For example: ns1.mynameserver.com.



For A and AAAA records, which associate IP addresses with domain names, you
need to specify the domain name and IP address. If you are simply defining a record
for your main domain, then you should leave the domain name field empty. If you are
defining a record for a name server, then type ns1 or ns2 into the domain name field.
Then specify the appropriate IP address with which to associate the domain name.



For a CNAME record, which specifies which subdomains (or domain aliases that look
like subdomains, for example, www) should be associated in the Domain Name
System with the main domain address, you need to type the subdomain name or www
alias, and then, the main domain name.



For an MX record, which specifies the host name of the preferred mail server for the
given domain, you need to specify the mail domain (or subdomain), the domain name
of the mail exchange server responsible for receiving e-mail, and the server's priority.
For the main domain, you would simply leave the available field blank. Then type the
domain name of your mail server. If you are running a remote mail server named
'mail.myhostname.com', then simply type 'mail.myhostname.com' into the Mail
exchange server field. After that, specify its priority: 0 is the highest and 50 is the lowest.



For a PTR record, which is required for reverse DNS lookup (an IP address is
translated to domain name), you need to enter the IP address/mask, and then type
the appropriate domain name for this IP address to be translated to.
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For a TXT record, which is used for specifying arbitrary human-readable text, you can
type an arbitrary text string, or an SPF record.



For an SRV record, which is used for specifying location of services other than mail,
you will need to enter the service name, protocol name, port number, and target host.
You can also specify the priority of the target host, and relative weight (for records
with the same priority) in the appropriate fields.

4. Click OK, and then click Update.

 To modify the properties of a resource record:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click the hyperlink in the Host column corresponding to the resource record
you want to modify.
4. Modify the record as required, click OK, and then click Update.
In addition to the resource records described above, there is also a Start of Authority record.
This record indicates that this DNS name server is responsible for the domain's DNS zone. It
also contains settings that affect propagation of information about the DNS zone in the
Domain Name System.

 To modify the entries in the Start of Authority (SOA) record for a domain:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click SOA Record.
4. Specify the required values:


Refresh interval. This is how often the secondary name servers check with the master
name server to see if any changes have been made to the domain's zone file. The
Panel sets the default value of three hours.



Retry interval. This is the time a secondary server waits before retrying a failed zone
transfer. This time is typically less than the refresh interval. The Panel sets the default
value of one hour.



Expire interval. This is the time before a secondary server stops responding to queries,
after a lapsed refresh interval where the zone was not refreshed or updated. The
Panel sets the default value of one week.



Minimum TTL. This is the time a secondary server should cache a negative response.
The Panel sets the default value of three hours.



Default TTL. This is the amount of time that other DNS servers should store the record
in a cache. The Panel sets the default value of one day.

5. Click OK, and then click Update.
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Usage of serial number format recommended by IETF and RIPE is mandatory for many
domains registered in some high-level DNS zones, mostly European ones. If your domain is
registered in one of these zones and your registrar refuses your SOA serial number, using
serial number format recommended by IETF and RIPE should resolve this issue.
The Panel-managed servers use UNIX timestamp syntax for configuring DNS zones. UNIX
timestamp is the number of seconds since January 1, 1970 (Unix Epoch). The 32-bit
timestamp will overflow by July 8, 2038.
RIPE recommends using YYYYMMDDNN format, where YYYY is year (four digits), MM is
month (two digits), DD is day of month (two digits) and NN is version per day (two digits).
The YYYYMMDDNN format will not overflow until the year 4294.

 To change the Start of Authority (SOA) serial number format to YYYYMMDDNN
for a domain:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click SOA Record.
4. Select the Use serial number format recommended by IETF and RIPE checkbox.
Note: See the sample of SOA serial number generated with the selected format. If the
resulting number is less than the current zone number, the modification may cause
temporary malfunction of DNS for this domain. Zone updates may be invisible to the
Internet users for some time.

5. Click OK, and then click Update.

 To remove a resource record from the zone:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Select a checkbox corresponding to the record you want to remove.
4. Click Remove.
5. Confirm removal, click OK, and then click Update.

 To restore the original zone configuration in accordance with the default DNS
template settings used on the server:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click Restore Defaults.
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4. In the IP address menu, select the IP address to be used for restoring the
zone.
5. Specify whether a www alias is required for the domain.
6. Select the Confirm the restoration of the DNS zone checkbox, and click OK.

 To restore the default Start of Authority (SOA) serial number format (UNIX
timestamp) for a domain:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click SOA Record.
4. Clear the Use serial number format recommended by IETF and RIPE
checkbox.
Note: See the sample of SOA serial number generated with the selected format. If the
resulting number is less than the current zone number, the modification may cause
temporary malfunction of DNS for this domain. Zone updates may be invisible to the
Internet users for some time.

5. Click OK, and then click Update.
By default, transfer of DNS zones is allowed only for the name servers designated by NS
records contained within each zone. If you are using a Windows-based account, then you
can change zone transfer settings.

 If your domain name registrar requires that you allow transfer for all zones you
serve:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click Zone Transfers. A screen will show all hosts to which DNS zone transfers
for all zones are allowed.
4. Specify the registrar's IP or network address and click Add Network.
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Panel as a Slave DNS Server
If you host websites on your account and have a standalone DNS server acting as a primary
(master) name server for your sites, you may want to set up the Panel's DNS server to
function as a secondary (slave) name server.

 To make the Panel's DNS server act as a secondary name server:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click Switch DNS Service Mode.
4. Click Add Record.
5. Specify the IP address of the primary (master) DNS server.
6. Click OK, and then click Update.
7. Repeat steps from 2 to 6 for each website that needs to have a secondary
name server on your server.

 To make the Panel's DNS server act as a primary back:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click Switch DNS Service Mode.
The original resource records for the zone will be restored.

Registrar's DNS Settings in Panel
If you have external primary and secondary name servers that are authoritative for some of
your websites, switch off the Panel's DNS service for each of these sites.

 To switch off the Panel's DNS service for a site served by external name
servers:
1. Go to the Websites & Domains tab and click the domain name whose DNS
settings you want to manage.
2. Click DNS Settings.
3. Click Switch Off the DNS Service.
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Turning the DNS service off for the zone will refresh the screen, so that only a list of
name servers remains. Note that the listed name server records have no effect on the
system. They are only presented on the screen as clickable links to give you a chance to
validate the configuration of the zone maintained on the external authoritative name
servers.

4. If you want to validate the configuration of a zone maintained on
authoritative name servers, do the following:
a. Add to the list the entries pointing to the appropriate name servers
that are authoritative for the zone: Click Add Record, specify a name
server, click OK, and then click Update.
b. Repeat the step a for each name server you would like to test. The
records will appear in the list.
c. Click the records that you have just created.
The Panel will retrieve the zone file from remote name servers and will check the resource
records to make sure that domain's resources are properly resolved. The results will be
interpreted and displayed on the screen.
If your Control Panel is integrated with a billing system, then the following operations on
domains might be available from the Panel:


Setting a password for access to domain management panel at a registrar's site.



Locking and unlocking domain name for transferring to another provider.



Changing domain registrant and other contact information.



Changing DNS settings for domain zones served by a domain registrar.



Configure automatic renewal of the domain account at the domain name registration
company.

 To set a new password for access to your domain management control panel at
a registrar's site:
1. Go to the Account tab.
2. Locate the domain name for which you want to change settings, and click the
link Show Domain Info next to it.
3. Click Change Domain Password.
4. Type a new password and click OK.

 To lock or unlock domain name for transferring to another provider:
1. Go to the Account tab.
2. Locate the domain name for which you want to change settings, and click the
link Show Domain Info next to it.
3. Click Change Registrar Lock Setting.
4. To allow domain name transfer, clear the Lock checkbox and click OK.
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 To change domain owner's contact, technical, administrative, or billing
information:
1. Go to the Account tab.
2. Locate the domain name for which you want to change settings, and click the
link Show Domain Info next to it.
3. Click Edit Contact Info.
4. Make the necessary changes and click OK.

 To change DNS settings for a domain:
1. Go to the Account tab.
2. Locate the domain name for which you want to change settings, and click the
link Show Domain Info next to it.
3. Click Edit DNS Settings.
4. Specify the domain name servers that serve the DNS zone for your website
and IP address of the server where the website is hosted.
5. If the DNS zone of your website is served by your domain name registrar,
then you can also specify other resource records that affect how your
website's services are accessible over the Internet.
6. To save your changes, click OK.

 To configure automatic renewal of the domain name:
1. Go to the Account tab.
2. Locate the domain name for which you want to change settings, and click the
link Show Domain Info next to it.
3. Click Automatic Domain Renewal.
4. To allow auto renewal of the domain registration, select the Turn on auto
renewal checkbox and click OK.
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Hosting Settings
The website’s hosting settings are available on the Websites & Domains tab of the Control
Panel. All per-website hosting settings form the following groups:


General.
Hosting type, security, scripting and statistics settings. See General Settings (on page 126).



PHP.
PHP scripting language settings. See PHP Settings (on page 132).



Web Server.
Web server settings (Apache (with nginx) or IIS). Web server type depends on Panel
version: Apache with nginx is used on Panel for Linux, and IIS on Panel for Windows.
See Apache Web Server Settings (on page 138) and IIS Web Server Settings (on page 140)
correspondingly.
Note that in the IIS web server settings you can configure basic website security settings,
such as anonymous access, ssl usage, and directory browsing.

On Windows, you can also set up custom ASP.NET settings in Websites & Domains > select a
domain > ASP.NET Settings. For details, see ASP.NET Settings (Windows) (on page 136).

Next in this section:
General Settings................................................................................................ 126
Web Scripting Settings ...................................................................................... 131
Web Server Settings ......................................................................................... 138
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General Settings
To view a website's general hosting settings, click Hosting Settings beside its name on the
Websites & Domains tab. The general website hosting settings are divided into groups:

Basic Settings


Domain name. The domain name that you register with a domain registrar and will use for
this website.



Hosting type. The hosting type (Website hosting, Forwarding, and No hosting) defines the
website behavior. By default, all webistes belong to the Website hosting type as they are
physically hosted on the server.
To change the hosting type, use the Change link. To learn more about hosting types, see
Hosting Types (on page 127).
To suspend the website with all mailboxes and mailing lists hosted under the website's
domain name use the Suspend option.
Note: Other basic settings depend on the selected hosting type. See Hosting Types (on
page 127).



Website status. The website status defines the site's accessibility in browsers and available
hosting services. Apart from working as usual, the site can be suspended so it will not
open in browsers, and even more, the hosting features of the site (such as the mail
service and DNS service) can be disabled. You should change the status if you want the
site to be temporarily unavailable, for example, for maintenance purposes. See Website
Status (on page 130).



Document root. Displayed for domains with the Website hosting type. See Website Hosting
(on page 128).



Preferred domain. Displayed for domains with the Website hosting type. See Website Hosting
(on page 128).

Security Settings


Enable SSL support. Secure Sockets Layer encryption is generally used for protecting
transfer of sensitive data during online transactions on e-commerce websites that run
on dedicated IP addresses. SSL certificates that participate in the encryption process
are usually applied to a single domain name on a single IP address, therefore, each
site that needs SSL protection must be hosted on a dedicated IP address. An
exception to this is subdomains, which you can protect with a wildcard certificate.
Installing an SSL certificate on a web server that hosts several websites with different
domain names on a single IP address is technically possible, however, it is not
recommended: the encryption will be provided, but users will get warning messages
on attempt to connect to the secure site. To allow SSL encryption for the website,
select the Enable SSL support checkbox.
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Web Scripting and Statistics


Scripting languages. Specify programming and scripting languages you want the
website to support. For PHP, you can also select the custom PHP version and handler
type. More PHP settings are available on the PHP tab. To learn more about PHP
handlers and PHP configuration, see PHP Settings (on page 132).



Microsoft FrontPage settings. Microsoft FrontPage is a popular website authoring tool. To
enable content creation and publishing through Microsoft FrontPage, select the
options Microsoft FrontPage support, Microsoft FrontPage over SSL support, and Remote
FrontPage authoring allowed.



Web statistics. Select the web statistics software that you want to use for viewing
graphical reports and charts on website visitors. Also, select the corresponding
checkbox if you want to be able to access the statistical reports by visiting the
password-protected directory http://your-website/plesk-stat/webstat.



Custom error documents. When visitors coming to a site request pages that the web
server cannot find, the web server generates and displays a standard HTML page
with an error message. If you want to create your own error pages and use them on
the web server, select the Custom error documents checkbox.



Additional write and modify permissions (available only for Windows hosting). This option
is required if web applications on the site will be using a file-based database (like Jet)
located in the root of the httpdocs directory. Note that selecting this option will
seriously compromise the website security.

Next in this section:
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Hosting Types
The hosting type defines the website's behavior. Panel supports three types of hosting:
Website hosting, Forwarding, and No hosting.

Next in this section:
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Website Hosting
The Website hosting means that a website is physically located on the server.
For the website hosting type you can specify:


Document root. The location of the directory where all files and subdirectories of the site
will be kept. You can use the default directory httpdocs or specify another directory.



Preferred domain. Typically, any website is available on two URLs: with the www prefix (like
in www.example.com) and without it (like in example.com). We recommend that you
always redirect visitors to one of these URLs (typically to the non-www version). For
example, after you set the Preferred domain to the non-www version (example.com),
site visitors will be redirected to this URL even if they specify www.example.com in their
browsers.
Panel uses the search engine friendly HTTP 301 code for such a redirection. This allows
preserving search engine rankings of your site (preferred domain). If you turn off the
redirection by choosing None, search engines will treat both URL versions (www and nonwww) as URLs of different sites. As a result, rankings will be split between these URLs.
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Forwarding
You can make one or more registered domain names to point to the same physical website,
by using the domain name forwarding. This allows automatic redirection of visitors from the
URL they specify in a browser to a site with a different URL. For example, visitors of the site
www.example.com can be redirected to www.somedomain.tld. There are two types of
forwarding in Panel: the standard and frame forwarding.

Standard Forwarding
With the Standard forwarding, users who have been redirected to another URL can see the
destination URL in the browser address bar.
Depending on how long you intend to use the redirection, you can select the type of
redirection – Moved permanently (code 301) or Moved temporarily (code 302). These are
HTTP response codes which Panel sends to browsers to perform the redirection. From
visitors’ point of view, the response code does not matter: in both cases they will be simply
redirected to the destination URL. For search engines, the code defines how they should
treat the redirected site and affects search engine rankings.


Moved permanently (code 301).
Use this redirection type if you want to keep search engine rankings of your site after
moving it permanently to another address.
For example, if example1.com has been moved permanently to the domain
example2.com, the rankings will not be split between example1.com and
example2.com – search engine crawlers will treat them as a single website.



Moved temporarily (code 302).
Use this redirection type when the destination domain is used temporarily, for example,
when you are testing a new version of your site with real visitors while keeping the old
version intact. If you set this redirection for a newly created destination domain, this
domain will not be indexed by search engines.

Frame Forwarding
With the Frame forwarding, when visitors are redirected to another site, the address bar of their
browsers continues to show the source URL. Thus, visitors remain unaware of the
redirection. This is called frame forwarding as the index page of the source site contains a
frame with the destination site.

Domains Without Web Hosting
You can switch off web service and use only email services under that domain (Websites &
Domains tab > domain name > the Change link > the No web hosting option).
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Website Status
The website status defines whether a website is available over the Internet and what hosting
services are provided for it. The hosting provider may need to change the status of a site if
the client does not pay for the services. Site owners can change the status of their sites if
they want the sites to be temporarily unavailable.
Panel supports three website statuses: Suspended, Disabled, and Active.

Suspended Sites
If you want to shut down a site for maintenance and let your visitors know that it is
temporarily unavailable, you can suspend the website so that it will not open in browsers
(Websites & Domains > domain name > the Suspend link). Visitors will be redirected with the
search engine friendly 503 HTTP code (Service Unavailable) to the "503 Service
Unavailable" error page. The site's search engine rankings will not be affected, and the
hosting services such as mail will still be available and manageable by means of Panel.
You can customize the error page using the link Edit maintenance error page in Control Panel >
Websites & Domains > domain name.
Note: The link Edit maintenance error page is displayed only if your hosting plan provides the
option to customize web server error documents (the Custom error documents is On in the
domain settings in Websites & Domains > domain name > Edit).

Disabled Sites
If you stop supporting a website, you can disable it using Websites & Domains > domain name
> the Disable link. Visitors will see the web server's default page set by the hosting provider,
and the site's search engine rankings will drop.
Disabled websites stop being hosted on the server: They are excluded from the web server
configuration. However, the physical directories and files of disabled sites can be accessed
by FTP clients and File Manager. The hosting services such as mail will be unavailable.
Note: In Panel versions earlier than 11.5 this status was called Suspended.

Active sites
To bring the website back online, use Websites & Domains > domain name > the Activate link.
The website will start working as usual.
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Web Scripting Settings
For each website in your subscription you can specify which of the following programming
and scripting languages should be supported by the web server: Active Server Pages (ASP),
Microsoft ASP.NET, Server Side Includes (SSI), PHP hypertext preprocessor (PHP),
Common Gateway Interface (CGI), Fast Common Gateway Interface (FastCGI), Perl and
Python. Since Panel 10.4, you are able to configure PHP settings individually for each
website (or subdomain) in your subscription. This is possible only if your subscription has the
corresponding permissions. To get the details about custom PHP configuration, refer to the
section PHP Settings.

Next in this section:
PHP Settings ..................................................................................................... 132
ASP.NET Settings (Windows) ........................................................................... 136
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PHP Settings
PHP is one of the most popular scripting languages for creating dynamic web pages. The
majority of today's websites and web applications are based on PHP scripts. This is why site
administrators should clearly understand how they can control the execution of PHP scripts.
How PHP scripts are executed for a certain website is fully defined by two aspects: PHP
handler and PHP settings for the site. You can set up these parameters for a certain website
in the Control Panel as described below.

PHP Handler
When a visitor accesses a site based on PHP scripts, a web server interprets site scripts to
generate a page that will be shown to the visitor. PHP handler calls PHP libraries needed for
this interpretation. You can choose from a number of PHP handlers: ISAPI (Windows),
Apache module (Linux), FastCGI, CGI, or PHP-FPM (Linux). The decision on what PHP
handler to choose should depend on a number of factors like security considerations, script
execution speed, and memory consumption.

 To choose a PHP handler for your website:
1. Go to Websites & Domains.
2. Click Hosting Settings near the domain name of a website for which you want
to choose the PHP handler.
3. Choose one of the following PHP handlers as the value of the Run PHP as
parameter (beside the PHP support option):

Run PHP as

Performance

Memory
Usage

Security

Website Management
High.
Apache
module (Linux Runs as a part of
the Apache web
only)

Low

server.

This handler (also known as mod_php)
is the least secure option as all PHP
scripts are executed on behalf of the
apache user. This means that all files
created by PHP scripts of any plan
subscriber have the same owner
(apache) and the same permission
set. Thus, a user has a theoretical
possibility to affect files of another user
or some important system files.

Note: You can evade some
security issues by turning the PHP
safe_mode option on. It disables a
number of PHP functions that bring
potential security risk. Note that this
may lead to inoperability of some
web apps. The safe_mode option is
considered to be obsolete and is
deprecated in PHP 5.3.
ISAPI
extension
(Windows
only, not
supported
since PHP
5.3)

High.

Low

Runs as a part of
the IIS web server.

The ISAPI extension can provide site
isolation in case a dedicated IIS
application pool is switched on for
subscriptions. Site isolation means that
sites of different customers run their
scripts independently. Thus, an error in
one PHP script does not affect the
work of other scripts. In addition, PHP
scripts run on behalf of a system user
associated with a hosting account.

Note: The ISAPI extension handler
is not supported since PHP 5.3.
CGI
application

Low.
Low
Creates a new
process for each
request and closes it
once the request is
processed.

The CGI handler provides PHP script
execution on behalf of a system user
associated with a hosting account. On
Linux, this behavior is possible only
when the suEXEC module of the
Apache web server is on (default
option). Otherwise, all PHP scripts are
executed on behalf of the apache
user.
We recommend that you use the CGI
handler only as a fall-back.

FastCGI
application

High (close to
Apache module and
ISAPI extension).
Keeps the
processes running
to handle further
incoming requests.

High

The FastCGI handler runs PHP scripts
on behalf of a system user associated
with a hosting account.
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PHP-FPM
application
(Linux only)

High

Low

The PHP-FPM is an advanced version
of FastCGI which offers significant
benefits for highly loaded web
applications.
The PHP-FPM handler is available
only if it was installed by hosting
provider and if the option Process PHP
by nginx in the website’s settings is
turned on (Websites & Domains > select
a domain > Web Server tab).

Note: Switching PHP from Apache module to FastCGI application may break functionality of
existing PHP scripts. Switching to PHP-FPM by selecting Process PHP by nginx in the website’s
web server settings may do the same.

PHP Version
Panel supports different versions of PHP. For each handler, one or more PHP versions can
be available. The list of available versions is defined by your hosting provider and available
to you in the same location where you select the PHP handler: Websites & Domains tab >
<domain_name> > Edit.
Note: Always use PHP 5.x except the cases when you need PHP 4.x to host some old PHP
apps.

PHP Settings
PHP behavior is defined by a number of configuration settings. These settings specify
various script execution aspects, like performance (for example, the amount of memory a
script can use), security (for example, access to file system and services), and so on. You
may adjust these settings for a number of reasons:


Preventing a memory leak or server hang-up by poorly written scripts.



Protecting data from malicious scripts.



Meeting the requirements of a certain web app.



Testing own scripts and other.

PHP settings are located in the Control Panel, Websites & Domains > select a website > PHP
Settings. For convenience, all PHP settings are divided into two groups:


Performance settings.
These settings define how scripts work with system resources. For example: Use the
memory_limit parameter to limit the amount of memory for a script to prevent a
memory leak. In addition, you can prevent scripts from tying up the server by limiting the
maximum time scripts are allowed to run using max_execution_time.



Common settings.
This group contains other commonly used PHP settings. Generally, these are: Security
settings (for example, the PHP safe mode toggle or the permission to register global
variables), error reporting settings (for example, the directive to log errors), and others.

Website Management

135

You can set the value of each parameter in PHP Settings either by selecting a value from a
preset, typing a custom value, or leaving the Default value. In the latter case, Panel uses the
values defined by the server-wide php.ini file. For information about certain PHP settings,
refer to the respective documentation. For example, http://php.net/manual/en/ini.list.php.
It is possible to use three placeholders in parameter values:


{DOCROOT} for the document root directory of a domain that gets custom PHP
configuration.



{WEBSPACEROOT} for the root directory of a subscription (webspace).



{TMP} for the directory which stores temporary files.

Note: Default values of PHP settings in Panel differ from the ones suggested by the official
PHP documentation at http://php.net/manual/en/ini.list.php.
Note: Custom PHP configuration of a website acts as a preset for all subdomains of this site.
You can perform further per-subdomain PHP configuration in the same way as for the
websites.
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ASP.NET Settings (Windows)
 To configure ASP.NET Settings for a site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click your website's domain name.
3. Click ASP.NET Settings.
4. Set up the strings that determine database connection data for ASP.NET
applications that use databases. This option is available only for ASP.NET
2.0.x.
When you open the ASP.NET configuration screen for the first time, sample
connection parameters with common constructions are displayed. You can delete
them and specify your own strings.


To add a string, enter the required data into the Name and Connection Parameters input
fields and click
next to them.



To remove a string, click

next to it.

5. Set up custom error messages that will be returned by ASP.NET applications
in the Custom Error Settings field:




To set the custom error messages mode, select an appropriate option from the Custom
error mode menu:


On - custom error messages are enabled.



Off - custom error messages are disabled and detailed errors are to be shown.



RemoteOnly - custom error messages are displayed only to remote clients, and
ASP.NET errors are shown to the local host users.

To add a new custom error message (which will be applied unless the Off mode was
selected), enter the values in the Status Code and Redirect URL fields, and click .


Status Code defines the HTTP status code resulting in redirection to the error page.



Redirect URL defines the web address of the error page presenting information
about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an error
code that already exists, but you can redefine the URL for the existing code.


To remove a custom error message from the list, click

next to it.
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6. Configure compilation settings in the Compilation and Debugging field:


To determine the programming language to be used as default in dynamic compilation
files, choose an entry from Default web page language list.



To enable compiling retail binaries, leave the Switch on debugging checkbox empty.



To enable compiling debug binaries, select the Switch on debugging checkbox. In this
case, the source code fragments containing error will be shown in a diagnostic page
message.

Note. When running applications in debug mode, a memory and/or performance
overhead occurs. It is recommended to use debugging when testing an application and to
disable it before deploying the application into production scenario.

7. Configure encoding settings for ASP.NET applications in the Globalization
Settings section:


To set an adopted encoding of all incoming requests, enter an encoding value into the
Request encoding field (default is utf-8).



To set an adopted encoding of all responses, enter an encoding value into the
Response encoding field (default is utf-8).



To set an encoding which must be used by default for parsing of .aspx, .asmx, and
.asax files, enter an encoding value into the File encoding field (default is Windows1252).



To set a culture which must be used by default for processing incoming web requests,
select an appropriate item from the Culture list.



To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the UI Culture list.

8. Set a code access security trust level for ASP.NET applications in the Code
Access Security field.
CAS trust level is a security zone to which applications execution is assigned, defining
what server resources the applications will have access to.
Important: When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permissions levels see
http://msdn.microsoft.com/library/enus/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010.

9. Enable the usage of the auxiliary scripts in the Script Library Settings field.
Specifying the script library settings is necessary if the validation web
controls are used on your web site. This option is available only for ASP.NET
1.1.x.


If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To do so,
enter the path beginning with the domain root directory preceded by the forward slash
into the Path to Microsoft script library field, or click the folder icon next to the Path to
Microsoft script library field and browse for the required location.



To initiate the auto-installation of files containing the scripts to the specified location,
select the Install checkbox. If the files already exist there, they will be rewritten.
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10. Set client session parameters in the Session Settings field:


To set up the default authentication mode for applications, select an appropriate item
from the Authentication mode list. Windows authentication mode should be selected if
any form of IIS authentication is used.



To set up time that a session can remain idle, type the number of minutes into the
Session timeout box.

11. Click OK to apply all changes.

Web Server Settings
Web server type depends on Panel version: Apache (with nginx) is used on Panel for Linux,
and IIS on Panel for Windows. Depending on your Panel version, refer to Apache Web Server
Settings (on page 138) or IIS Web Server Settings (on page 140).

Next in this section:
Apache Web Server Settings............................................................................. 138
IIS Web Server Settings .................................................................................... 140

Apache Web Server Settings
Panel uses the Apache web server (http://en.wikipedia.org/wiki/Apache_HTTP_Server) to
deliver the pages of your website to clients (such as browsers through which visitors access
your website). By default, to achieve better performance, Apache is supplemented with
another web server - nginx. For details about how Apache is integrated with nginx in Panel,
see Apache with nginx in the Administrator’s Guide.
Default web server settings are specified by the server administrator (hosting provider). For
example, these settings can determine how web servers process different types of files, how
they use SSL, where they store log files, and so on.
However, you (as a website owner) can set up custom web server settings for your website.
For example, add a new type of the index file, restrict access to the site, and so on.
Note: You can adjust web server settings for your websites only if your hosting subscription
provides the corresponding permission.

Next in this section:
Adjusting Apache Web Server Settings ............................................................. 139
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Adjusting Apache Web Server Settings
All customizable web server settings are located on the Websites & Domains > <domain_name>
> Web Server Settings page. Custom settings work only for the selected website. The settings
are divided into two groups:


Common Apache settings.
These settings are typically changed by site owners, who may want to add a new type of
index files (Index files), or a MIME type for files with a certain extension (MIME types), to
restrict access to the site (Deny access to the site), or specify Apache handlers for a certain
file type (Handlers).



nginx settings.
These settings define how the processing of web requests is divided between the Apache
and nginx web servers to achieve better performance for a specific site.
Important: nginx settings are for advanced users only. To learn more about nginx
settings, see Adjusting nginx Settings for Virtual Hosts in the Administrator’s Guide.


Smart static files processing.
Caution: Turn off this option only to troubleshoot nginx related issues.
Turning this option off will limit the role of nginx: It will only pass requests and
responses without modification. Except for troubleshooting the nginx related issues,
we recommend that you leave this option turned on.



Serve static files directly by nginx.
For sites with a lot of static content (like image or video files) and high load, better
performance can be achieved by delegating serving static files to nginx. Apache will
not take any part in processing the requests for the files with the specified extensions.

For example, to exclude Apache from delivering jpg and gif files, you should turn on
the option Serve static files directly by nginx and specify file extensions like this
gif jpg
or
gif|jpg
Caution: Because requests for static files never reach Apache, they do not pass
through Apache handlers. This means, for example, that rewrite rules or .htaccess
directives will not be applied.


Process PHP by nginx.
When the Process PHP by nginx option is on, Apache does not take any part in
processing the requests for PHP files. All requests for PHP files are processed by
nginx using the PHP-FPM handler. The handlers used by Apache are not available on
nginx. The PHP-FPM is an advanced version of FastCGI which offers significant
benefits for highly loaded web applications. To learn more about PHP-FPM, see
http://php-fpm.org/about/.
Caution: Because requests for PHP files do not reach Apache they do not pass
through its handlers (CGI, FastCGI, or an Apache module), so some web apps
may not work as expected.
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Note that subdomains have their own web server settings, therefore, when you change web
server settings for a site that has subdomains, the subdomains will not receive these
changes.
If you do not find the necessary setting, contact your server administrator (hosting provider),
who can set up more custom settings for websites.

The Default Value of Server Settings
You can set the value of each parameter either by typing a custom value, or leaving the
Default value. In the latter case, Panel uses the values from the default web server
configuration defined by the server administrator (hosting provider).
Your values override the default ones. The only exception is the Deny access to the site
setting - IP addresses from the default configuration, as well as the IP addresses specified
by you, will all be applied to your website. In case of a conflict (for example, when you allow
the IP address that is denied in the default configuration), Apache uses your settings.

IIS Web Server Settings
Panel uses the IIS web server (http://en.wikipedia.org/wiki/Internet_Information_Services) to
deliver the pages of your website to clients (such as browsers through which visitors access
your website). The behavior of IIS is defined by variety of settings.
Default web server settings are specified by the server administrator (hosting provider). For
example, these settings can determine how IIS process different types of files, how it uses
SSL, and so on.
However, you (as a website owner) can set up custom web server settings for your website.
For example, add a new type of the index file, restrict access to the site, and so on.
Note: You can adjust web server settings for your websites only if your hosting subscription
provides the corresponding permission.

Next in this section:
Adjusting IIS Web Server Settings ..................................................................... 141
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Adjusting IIS Web Server Settings
All customizable web server settings are located in Websites & Domains > select a website >
Web Server Settings. Custom settings work only for the selected website. The settings are
divided into groups:

Common Settings
These settings are typically changed by site owners, who may want to:


Allow site visitors to view the listing of files and subdirectories of the site’s directory in
their browsers (Directory browsing). The directory listing will be displayed if there are no
matches for default index pages in the site’s root directory.



Add a new type of default index pages (Default documents).



Add a new MIME type for files with a certain extension (MIME types).

Directory Security Settings
These settings allow site owners to:


Restrict access to the site by username and password – only system users will be able to
access the site (Anonymous access). Denying anonymous access may be useful if your site
is not intended for any visitor, for example, it is a web application for internal use. Note
that FTP users and additional FTP users created in Panel will have access to such a site
if they were granted access to the site’s directory.



Force all clients (such as browsers or FTP clients) to use the secure HTTPS protocol to
access their site (Require SSL). You need this option, for example, if the site contains and
transmits personal information.

Access Restriction Settings
These settings allow site owners to restrict access to the site by IP address of the visitor
(Deny access to the site) by denting and allowing access from certain IP addresses.
Note: Subdomains have their own web server settings, therefore, when you change web
server settings for a site that has subdomains, the subdomains will not receive these
changes.
If you do not find the necessary setting, contact your server administrator (hosting provider),
who can set up more custom settings for websites.

The Default Value of Server Settings
You can set the value of each parameter either by typing a custom value, or leaving the
Default value. In the latter case, Panel uses the values from the default web server
configuration defined by the server administrator (hosting provider).
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Your values override the default ones. The only exception is the Deny access to the site setting
- IP addresses from the default configuration, as well as the IP addresses specified by you,
will all be applied to your website. In case of a conflict (for example, when you allow the IP
address that is denied in the default configuration), IIS uses your settings.
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Website Content
To create your website and fill it with the content you need (text, images, videos, and so on),
use one of the methods provided by the Panel:




Using website creation and management tools. If you do not have a website yet, consider
setting one up by yourself with a tool for creating, editing, and publishing websites. You
can do this even if you do not possess the necessary web programming and design skills.
The best tools of this sort are the following:


Presence Builder - a website editor integrated with the Control Panel.



Third-party Content Management Systems (CMS) - web applications for creating and
editing websites.

Uploading existing websites to your hosting account using one the following methods:


FTP client program. You can obtain a free FTP client from the Internet, or, if you are
using Windows, use Windows Explorer. This enables you to access your directory on
the hosting server and manage your files. If you collaborate with other people when
managing your website (such as programmers or designers), you can provide them
with access to your directory using FTP to let them edit the website by themselves.



File Manager. A tool for uploading and managing website files and directories through
the Panel web interface.

Note: if you have a website created in Microsoft FrontPage editor, refer to the section Working
with Microsoft Frontpage Websites (Windows) (on page 178) for details on managing this site in
Panel.
Below you will find detailed descriptions of the ways to manage your content.

Presence Builder
Presence Builder is a great tool that enables users with no knowledge of HTML markup or
graphic design skills to create professional-looking sites. Just pick a suitable page design
and content template, add your text to the pages, and publish the site.
You can create and publish websites using Presence Builder if your hosting subscription
provides this option. If it does not, or if you have already created and published the allowed
number of sites, you still can create a new website with Presence Builder and edit it.
However, to publish this website, you will need to upgrade your hosting plan.
To start creating a website using Presence Builder or edit an existing Presence Builder site,
go the Websites & Domains tab, click you domain name, and click Launch Presence Builder. Find
more information on creating and editing websites in Presence Builder in the chapter Building
Websites with Parallels Presence Builder (on page 199).
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Third-Party Content Management Systems
To create and maintain a website, you can use third-party Content Management Systems
(CMS) - web applications that let you easily edit a website's structure and content with a
graphical user interface. Examples of such systems are Drupal and Joomla.
CMS are usually server applications, so to start using one of them you should install it on
your hosting account. Hence, if you plan to use a CMS, ensure that your hosting subscription
allows such applications to be installed.

 To create a website using a CMS:
1. Go to the Applications tab.
2. Find the CMS you need in the list of available applications, and install it as
described in the section Employing Website Applications (on page 151).
3. Create and edit your website in the CMS. For information on how to create
websites with your CMS, refer to the relevant documentation.

Uploading Using FTP
If you already have all your website files and directories, consider uploading them to your
hosting account using FTP. This is the quickest way for simple uploading of files when you
do not need to edit or manage them on the server.

 To upload files using FTP:
1. Connect to your site's domain name with an FTP client program using your
FTP access credentials. Learn how to configure these credentials in the
section Adding FTP Accounts (on page 253).
2. Copy the website files and directories to your directory on the server.

File Manager
Another way to publish a website created outside the Panel is File Manager - a tool that
provides a set of file management functions through the web interface. File Manager is
located on the Files tab of the Control Panel.
To upload a website from your computer to Panel server with File Manager, open the Files
tab of the Control Panel and drag the website folder to the central area of this tab. If your
website is compressed to a ZIP file, you can upload this file to the server and then extract it
by clicking Extract Files in the More menu.
If you want to edit pages of your website, you can do it in File Manager. It provides an HTML
editor that allows visual editing of HTML pages (without needing to manually type HTML
tags). To edit a file in the HTML editor, place the mouse pointer over the file, click the link
to open the file's context menu, and select Edit in HTML Editor.
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You can also edit files in File Manager's text editor if you like. To open a file in the text editor,
open the file's context menu and select the Edit in Text Editor.
If you have files or web pages that you want to make inaccessible on the Internet, change
these files' access permissions in File Manager. To edit access permissions for a file or a
directory, click the corresponding link in the Permissions column. To learn how to review and
edit the permissions, refer to the sections Setting File and Directory Access Permissions (on page
146).

Next in this section:
Setting File and Directory Access Permissions .................................................. 146
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Setting File and Directory Access Permissions
 To review or change the permissions set for files and directories on Linux
systems:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, select the required
webspace in the Subscription menu at the top of the screen.
2. Go to the Files tab.
The permissions set for files and directories are shown in the Permissions column. They
are represented as three sets of symbols, for example, 'rwx rwx r--'. The first set tells
what the owner of the file or directory can do with it; the second tells what the user group,
the file or directory belongs to, can do with the file or directory; the third set indicates what
other users (the rest of the world, that is, Internet users visiting a site) can do with the file
or directory. R means the permission to read the file or directory, W means the
permission to write to the file or directory, and X means the permission to execute the file
or look inside the directory.

3. Locate the file or directory for which you want to modify permissions and
click a hyperlink in the Permissions column.
4. Modify the permissions as desired and click OK.

 To set access permissions for a file or directory on Windows systems:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Files tab.
3. Locate the file or directory for which you want to set access permissions, and
click the corresponding icon .
4. Do the following:


To make the file or folder inherit permissions from a parent folder (if it does not),
select the checkbox Allow inheritable permissions from the parent to propagate to this object
and all child objects. Include these with entries explicitly defined here.



To make the files and folders, which are contained in this folder, inherit the folder
permissions you define, select the checkbox Replace permission entries on all child objects
with entries shown here that apply to child objects.



To change or remove permissions from a group or a user, click the required name in
the Group or user names list. If the group or user is not listed in the Group or user names
list, select the required user or group name from the menu located above the list and
click : the user/group appears in the list. Select it.
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To allow or deny permissions to a selected group/user, select the Allow or Deny
checkboxes corresponding to permissions listed under Permissions for <user/group
name>. If the checkboxes in the Allow or Deny columns are shown in grey, it means that
the corresponding permissions are inherited from a parent folder.


To deny the permissions, which are inherited from a parent object as allowed, select
the required checkboxes under Deny. This will override inherited permissions for this
file/folder.



To allow the permissions, which are inherited from a parent object as denied, clear the
Allow inheritable permissions from the parent to propagate to this object and all child objects.
Include these with entries explicitly defined here checkbox: this removes the inherited
permissions. Then select the required checkboxes under Allow and Deny.



To remove access permissions from a group or user, select the required name in the
Group or user names list and click the icon
next to it.

5. If you need advanced fine-tuning of permissions, click the Advanced button,
and do the following:


To create a permission entry for a group or user, select the required name from the
Group or user names list and click .



To set or change file/folder permissions for a group or user, select the required name
from the Group or user names list, select the required Allow and Deny checkboxes
corresponding to permissions listed under Permissions for <user/group name>.



To remove a permission entry for a group or user, select the required name from the
Group or user names list and click .



To make child objects of a folder inherit its permissions defined under Permissions for
<user/group name>, select the Replace permission entries on all child objects with entries
shown here that apply to child objects checkbox, and select checkboxes in the Apply to list
which correspond to the objects that must inherit the permissions.

6. Click OK.
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(Advanced) Restricting Access to Content
If you have directories in a site that only authorized users should see, restrict access to these
directories with password protection.

 To protect a directory in your site with a password and to specify authorized
users:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Password-protected Directories.
4. Click Add Protected Directory.
5. In the Directory name box, specify the path to the directory that you want to
protect with a password.
This can be any directory existing in the site, for example: /private. If the directory that
you would like to protect has not yet been created, specify the path and the directory
name – the Panel will create it for you.

6. If you are using a Linux-based account, you can also protect your CGI
scripts stored in the cgi-bin directory. To do this, leave '/' in the Directory
name box and select the cgi-bin checkbox.
7. In the Title of the protected area box, type a resource description or a welcoming
message that your users will see when they visit the protected area.
8. Click OK. The directory you specified will be protected.
9. To add authorized users, click Add New User.
10. Specify the username and password that will be used for accessing the
protected area. The password should be from 5 to 14 symbols in length.
Click OK.

 To add an authorized user of a protected directory:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Password-protected Directories.
4. Click on the name of the directory you need.
5. Click the Add New User icon.
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6. Specify the username and password that will be used for accessing the
protected area. The password should be from 5 to 14 symbols in length.
7. Click OK.

 To change password for an authorized user of a protected directory:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Password-protected Directories.
4. Click on the name of the directory you need. A list of authorized users will
open.
5. Click on the user’s name.
6. Specify the new password and re-type it for confirmation.
7. Click OK.

 To revoke a permission to access the protected directory from a user:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Password-protected Directories.
4. Click on the name of the directory you need. A list of authorized users will
open.
5. Select a checkbox corresponding to the user’s name.
6. Click Remove. Confirm the operation and click OK.

 To remove password protection and make the resource available to the public:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Password-protected Directories.
4. Select a checkbox corresponding to the name of the directory, from which
you want to remove protection.
5. Click Remove Protection. The protection will be removed and the contents of
the directory will be accessible to the public without restrictions.
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Previewing Websites
After you purchase a domain, its registration can require some time. The reason for the delay
is that name servers update their zone information periodically. Thus, until all name servers
have received information about your zone, you will not be able to access your site by its
domain name. Nevertheless, you can always access your site during domain name
propagation using the Preview button on the Websites & Domains tab.
During domain name propagation other people can access your site too. For this purpose,
Panel registers your website as a subdomain of one of the provider's sites. For example, if
your website is my-domain.tld and a provider has configured the preview service on providerdomain.tld, you can access your site on my-domain.tld.192-0-2-12.provider-domain.tld. Here
192-0-2-12 is the site's IP address where dots are replaced with dashes.
Notes:
The contents of password-protected directories might be inaccessible in the Preview mode.
If you do not have the site preview button on the Websites & Domains page, contact your
hosting provider.
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Web Applications
You can significantly increase your website functionality by using different web apps. Apps
installed on a website can perform a number of tasks. If you are an individual, you can, for
example, present yourself with a blog or organize an online storage of your media files.
Companies can move their business online using the e-commerce or CRM web apps. All
these apps are available for installation from the Applications tab of the Control Panel.
The list of available apps is governed by your hosting plan. For example, it might include only
free apps or no apps at all. For more information on available apps, contact your hosting
provider.

App Types
There are two types of web apps:


Apps installed directly on your website (for example, the WordPress blogging platform or
the Joomla! content management system).



Apps installed on external servers and provided by third-parties.

Regardless of the installation type, apps can be either free or commercial. Commercial apps
require you to obtain a license key to start working with them. You can recognize commercial
apps in the catalog on the Application tab by the button Buy now (instead of Install for free
apps). If you decide to use commercial apps, read the Managing Commercial App Licenses (on
page 156) section to learn more about acquiring and managing app licenses.

App Installation and Maintenance
The process of installation is fully automated and does not require any specific skills. To
learn how to install web apps from the Control Panel, refer to the section Installing Apps (on
page 153).
Further app management is also facilitated as you can update or remove apps directly in
Panel. Moreover, you can access some functions that apps reveal to the Control Panel
(without the need to log in to an app). For example, you can add SugarCRM user account
right from your Control Panel. Such app functionality is a service provided by the app.
After you install an app, grant other auxiliary user accounts access to it if you want them to
be able to use the app. To get started with managing apps, see the section Managing Apps (on
page 154).
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App Databases
If an app requires a database, Panel creates it automatically during installation of the app. To
create a database, Panel uses app database settings, which you can change in the Main
configuration section (Show All Settings link) when installing an app:


A database name and a database server where the app will store the database.



Database user credentials, which Panel will use to access the app database. It may be
convenient to employ a single database user with access to all databases. In this case,
you can create a universal user account and specify it when installing apps. To learn
more, refer to the section Managing Database User Accounts (on page 275).

Note that if you exceed the maximum number of databases allowed for your subscription, a
new app does not create a new database. Instead, it adds tables to one of the existing
databases, and adds prefixes to table names. Prefixes make it easier to distinguish tables of
different apps from each other. For example, the Wordpress app will add the “wpress_” prefix
to the names of its tables.

Access to Apps
By default, after you install an app, it is available only for users with the Owner role. You can
make your apps available to certain auxiliary users by adjusting their permissions. For details
on setting up access to apps for auxiliary users, refer to the section Granting Auxiliary Users
Access to Apps (on page 154).

Apps and Auxiliary User Accounts
Some apps let you create and manage user accounts directly in Panel. For example, the
SugarCRM app allows you to add SugarCRM users without logging in to the app. All apps
with such "account services" can associate their accounts with users of a Panel subscription
(auxiliary users). To perform such an association, you should grant the auxiliary users
access to that account service (in the same way as you grant access to apps). For details on
account association, refer to the section Linking Apps and Auxiliary (on page 155)User Accounts.

Next in this section:
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Managing Apps ................................................................................................. 154
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Installing Apps
Depending on your needs and expertise level, you can choose one of the following ways to
install an app:


Quick. This is the easiest way to install an app. If you choose this way, Panel will perform
a typical installation of the latest app version of the selected app, Panel will use the
default values for the app settings. For example, your Panel access credentials will be
used as the app administrator's credentials.
Note: Some apps require you to fill in certain settings even if you select the quick
installation.



Custom. This way allows you to customize app installation settings such as administrator
credentials and location, installation path, and other. Particularly, you should use custom
installation if you want to switch off automatic upgrades of the app.

 To install an app:
1. Go to the Applications tab and find the app you need.
2. Click either the Install button for the quick installation or the Install (Custom) for
the custom installation.
3. (Optional) Turn off automatic upgrades of the app.
If you do not want the app to be updated automatically, deselect the option Automatically
update this app when updates are available on the installation settings page.

4. (Optional) Select the app version.
Sometimes, you may need to install a specific version of an app. For example, if you plan
to use app extensions that are incompatible with the latest app version. In this case, click
the app name > Select another version to select the version you need. Then install the app.
Note: For commercial apps, you should obtain a license key by clicking Buy now before
starting the installation. To learn more about using commercial apps refer to the section
Managing Commercial App Licenses (on page 156).
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Managing Apps
Generally, all apps allow the configuration of their main parameters directly in the Control
Panel. You can access app settings by selecting the app from the list in Applications > Manage
My Applications. After you select an app, you can configure the following:


General settings.
These are basic settings (for example, the app administrator password) that can be
changed with Change Settings.



Service settings.
If an app provides a part of its functionality to Panel by means of services, you have the
option to configure them. For example, the SugarCRM app allows the creation of user
accounts and provides this ability as a service in the Control Panel. After you select this
service in Provided services, you can view all app user accounts and create new ones.
For some apps, you can associate the app accounts with auxiliary user accounts. Learn
more about account association in the section Linking App and Auxiliary (on page 155)User
Accounts.

Granting Auxiliary Users Access to Apps
By default, after you install an app, only users with the Owner role can access it. To allow
other subscription users to access the app:



Grant permission to access the app to a certain user group in Users > User Roles.
Be sure to add users of your choice to the group.

Once you allow users to access the app, a link to the app appears on their Websites &
Domains page under the name of the corresponding website. Note that you can control app
access only for user groups, so you should either modify the permissions of an existing
group or create a new one, and then assign users to it.
By default, the app administrator is a subscription user with the Owner role. As well as
accessing the apps from the Websites & Domains page, this user can also install and manage
apps within a subscription. For these purposes, their interface has the additional Applications
tab. You can provide the same administrative privileges to other subscription users by
granting the Install and manage applications permission to their role in Users > User Roles. This
gives users full administrative access to all apps within a subscription. As well as the
administrator, the users with this permission can install, configure, update, and remove apps
through the Applications tab in their Control Panel.
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Linking Apps and Auxiliary User Accounts
Some apps let you create and manage user accounts without logging in to the app. If an app
provides such an account service, you can link users of a Panel subscription with accounts in
the app. To perform such an association:
1. Organize the users into a certain group (Users > User Roles).
2. Grant one of these group permissions:


Public access.
If granted, all users in the group will have access to the app through the link on the
Websites & Domains page.



Personal access.
If granted, the app will automatically create accounts for all users in the group. After
that, the users' Websites & Domains page will contain an additional link that allows
logging in to a personal account in the app. Note that if you deny the Personal access
permission, the app will automatically remove all accounts associated with this group.
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Updating Apps
Automatic Updates
By default, Panel installs the latest available app versions and updates apps immediately
once the newer versions are available. However, updating an app can significantly change its
functionality: For example, plug-ins or extensions developed for a particular app version may
be incompatible with newer versions. Therefore, you might want to turn off automatic updates
for a certain app.

 To turn automatic updates on or off:
1. Go to Applications > Manage My Applications and click the app's name.
2. Click Change Settings.
3. Select or deselect the option Automatically update this app when updates are
available.

Manual Updates
If you prohibit automatic updates for an app, Panel will inform you about the availability of
newer versions by adding the link Update available under the app name in Applications > Manage
My Applications. Click this link to review the changes available in the new version and decide
whether to update the app or continue with the current version.

Managing Commercial App Licenses
If you decide to buy an application license in the Control Panel and click the corresponding
button on the Applications tab, you will be forwarded to Storefront, the online store where you
complete your order. Actually it is not only a store, it also includes its own web interface to
help you perform various operations with the licenses you own. For example, from this web
interface you can renew a license, cancel it, change your payment methods and so on. This
section explains how to carry out these operations.

Storefront Basics
When you order a first license in Storefront, it creates an account for you. This account
contains your personal and financial information; if you log in to Storefront under this
account, you will be able to do various operations with your licenses.
Each time you successfully check out in Storefront, a purchase order is generated. It is a
document that lists the cart items you ordered. Storefront assigns different statuses to
orders. These statuses explain the current state of your purchase - whether it is unpaid,
canceled, or successfully delivered.
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Storefront and Panel share the service plans business model. In Storefront, each application
is presented by a separate service plan, and when you order an application license you
subscribe to one of the service plans. In other words, each license you purchase is shown as
a subscription in the web interface. For instance, if you would like to view a license price,
terms, or an expiration date, you should open the corresponding subscription.

How to Get a License File or Key
After you order a license and pay for it, Storefront sends you an e-mail with your license file
or key. We recommend that you keep the information in a safe place because there is no
way to request it again or view it from the web interface. If you did not receive the e-mail with
a license file or key, contact us at https://support.parallels.com/.

Available Operations
The operations you can carry out in Storefront fall into three groups:


Operations with your user account. These operations include viewing and modifying your
personal information and preferences and changing the password to your user account.



Operations with payments and payment methods. This group comprises operations with
your credit cards, payments, and orders.



Operations with subscriptions. Use them to acquire new licenses, obtain information
about your existing licenses, and check the subscription renewal method for a particular
subscription.

Learn more about these operations in the subsections of this section.

Next in this section:
User Account..................................................................................................... 158
Payments and Payment Methods ...................................................................... 159
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158

Website Management

User Account
You can do the following operations with your user account.

View and Change Your Account Information
The system uses your account information to add your personal and financial details into
invoices. If you see that you need to update your details, open the My Contact Info submenu
on the Navigation menu and select Account Info.

View and Change Your Personal Information
Your personal information mostly duplicates the account information. It does not appear in
financial documents, but some services use this information as technical contact details. For
example, it is possible to order a domain name through Storefront, and if you do so,
Storefront will send your personal information (as the technical contact) to a domain name
registrar.
To view user personal information, open the My Contact Info > Personal Info menu on the left
panel. Here you can also edit your personal information and change password to your
Storefront account.

Configure e-mail notifications
E-mail notifications are sent on different events to your account contact e-mail address. They
fall into a number of categories. For example, subscription renewal and expiration, your
credit card(s) expiration, etc. You can select messages format for every group of messages
and decide whether to send certain messages or not. To configure messages types to
receive, open My Contact Info > Notification Methods.
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Payments and Payment Methods
This section describes operations with payments and credit cards available to you in
Storefront.

Registering a Credit Card
Before a credit card becomes available for making online payments, it is necessary to
register it in Storefront. To register a credit card, open Billing Manager > My Financial Info >
Payment Methods and click the appropriate button.

Configuring Automatic Payments
You can assign one of the registered credit cards to be used for paying orders automatically.
In this case, you will not need to pay each order manually. If you assign a payment method
to be used for automatic payments, the previous default one is unselected automatically.
Thus, only one payment method can be used for automated payments.
To turn on automatic payments from a card, go to Billing Manager > My Financial Info > Payment
Methods, select the card by clicking on its ID or Type, and, finally, enable automatic payments
on the card properties screen.

Making a Payment
To add new payment, open the Billing Manager > New Payment link on the dashboard. The
adding new payment wizard starts. The list of pending documents appears on the screen. If
there are no pending documents, click Cancel to finish the wizard. Otherwise, walk through
the wizard by providing the payment settings.

Viewing Open Orders
Your open orders are available in the Billing Manager > My Financial Info > Open Orders
submenu.
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Subscriptions
Storefront offers you a powerful and comprehensive mechanism of subscriptions (licenses)
management, allowing you to perform the following operations.

Buying a Subscription
If you want to purchase one more app license or another service offered by Storefront, there
is no need for you to go to the Control Panel. The Storefront web interface provides all
facilities for making the purchase. To start the subscription ordering wizard, open Billing
Manager > Subscription Management and click Buy New Subscription.

Renewing a Subscription Manually
If you did not configure the auto renewal feature, your subscription will expire unless you do
not renew it manually. The auto renewal setup instructions are given later in this section. To
renew a subscription manually, open Billing Manager > Subscription Management > Renew
Subscription and follow the wizard steps.

Renewing Subscriptions Automatically
Configuring a subscription for auto renewal helps renewing your subscriptions in time. To
allow the auto renewal, open Billing Manager > Subscription Management > Renew Subscription,
click a subscription for which you want to turn the option on, and click Turn On AutoRenew
Option. Clear the option to cancel the auto renewal.

Canceling a Subscription
A subscription cancelation results in termination of the subscription services and money
refund. To cancel a subscription, open Billing Manager > Subscription Management > Renew
Subscription, click a subscription you want to cancel, and start the cancelation wizard by
clicking Cancel Subscription.

(Advanced) Website Security
Next in this section:
Securing Connections with SSL Certificates ...................................................... 161
Protecting Sites from Hotlinking (Windows) ....................................................... 166
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Securing Connections with SSL Certificates
If your website transfers private data, for example, visitors' credit card numbers, we
recommend that you use the SSL secure channel for this website. To set up such a channel,
you should purchase an SSL certificate for your website.
SSL certificates are used not only for establishing secure communication channels on the
Internet but also for verifying a website's identity as well. When users visit your secure online
store, they are notified that your website is really what it claims to be and that all sensitive
data, such as credit card numbers, will be transferred over a secure channel.
SSL certificates are issued by specific organizations - SSL certificate providers. However,
some hosting providers allow customers to purchase SSL certificates directly from Panel.

Purchasing SSL Certificates
Depending on your hosting provider, you can have the following ways of purchasing SSL
certificates:


Order an SSL certificate from Panel. This way is available to you if your provider
configures the corresponding Panel settings. The links for purchasing SSL certificates
from Panel may let your purchase certificates either from your provider in their online
store or from Parallels in the MyPlesk outlet. To learn how to order an SSL certificate
through Panel, see the section Purchasing SSL Certificates through Panel (on page 162).



Order an SSL certificate from the SSL certificate provider you like. In this case, you
should create a certificate signing request (CSR) for your website in Panel and submit it
to an SSL certificate provider. To learn how to create such request and purchase a
certificate with it, refer to the section Generating Certificate Signing Requests (on page 163).

Securing Websites
After you obtain a certificate for your website, you should secure the connection to the
website with the certificate. The section Securing Websites (on page 164) explains how to do
this.

Securing Websites with Shared SSL Certificates
On Windows systems, you may be able to secure your websites without purchasing your
own SSL certificates. This feature is available to you if your hosting provider offers shared
SSL certificates. The section Using Shared SSL Certificates (Windows) (on page 165) explains
how to secure a website with a shared SSL certificate.

Next in this section:
Purchasing SSL Certificates Through Panel ...................................................... 162
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Using Shared SSL Certificates (Windows)......................................................... 165
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Purchasing SSL Certificates Through Panel
The links for purchasing SSL certificates in Panel let you purchase either certificates from
your provider if they offer their own certificates, or certificates from Parallels in the MyPlesk
outlet. These links may also be unavailable to you if your provider decides so.

 To purchase an SSL certificate through Panel:
1. Open the corresponding subscription in the Control Panel
2. Go to the Websites & Domains and select the website you want to protect with
an SSL certificate.
3. Click Secure Your Sites.
4. Click Add SSL Certificate.
5. Specify the following certificate parameters:


Certificate name. This will help you identify this certificate in the repository.



Encryption level. Choose the encryption level of your SSL certificate. We recommend
that you choose a value more than 1024 bit.



Your location and organization name. The values you enter should not exceed the
length of 64 symbols.



The domain name for which you want to purchase an SSL certificate. This should be a
fully qualified domain name. Example: your-domain.com.



The website administrator's e-mail address.

6. Make sure that all the provided information is correct and accurate, as it will
be used to generate your private key.
7. Click Buy SSL Certificate.
8. Complete all steps of an SSL certificate purchase in the online store and you
will receive your SSL certificate by e-mail.
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Generating Certificate Signing Requests
If your hosting provider does not allow purchasing SSL certificates through Panel, you can
create a certificate signing request and submit it to an SSL certificate provider. The provider
will generate an SSL certificate for your website basing on this request.

 To generate a certificate signing request:
1. Open the corresponding subscription on the Control Panel
2. Go to the Websites & Domains and select the website you want to protect with
an SSL certificate.
3. Click Secure Your Sites.
4. Click Add SSL Certificate.
5. Specify the following certificate parameters:


Certificate name. This will help you identify this certificate in the repository.



Encryption level. Choose the encryption level of your SSL certificate. We recommend
that you choose a value more than 1024 bit.



Your location and organization name. The values you enter should not exceed the
length of 64 symbols.



The domain name for which you want to purchase an SSL certificate. This should be a
fully qualified domain name. Example: your-domain.com.



The website administrator's e-mail address.

6. Make sure that all the provided information is correct and accurate, as it will
be used to generate your private key.
7. Click Request. Panel will generate your private key and certificate signing
request and add them to your certificates repository (Websites & Domains >
Secure Your Sites).
8. In the list of certificates, click the name of the certificate you need.
9. Locate the CSR section on the page, and copy the text that starts with the line
-----BEGIN CERTIFICATE REQUEST----- and ends with the line -----END CERTIFICATE
REQUEST----- to the clipboard.
10. Visit the website of the certification authority from which you want to
purchase an SSL certificate, and follow the links on their site to start a
certificate ordering procedure. When you are prompted to specify CSR text,
paste the data from the clipboard into the online form and click Continue. The
certification authority will create an SSL certificate in accordance with the
information you supplied.
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Securing Websites
After you receive an SSL certificate for your website, secure the website with this certificate.

 To secure a website with an SSL certificate:
1. Log in to the Control Panel and select the subscription that contains the
website you want to secure in the Subscriptions menu at the top of the screen.
2. Go to the Websites & Domains and select the website you want to protect with
an SSL certificate.
3. Click Secure Your Sites.
Upload the SSL certificate: Click Browse in the middle of the screen and navigate to the
location of the saved certificate. Select it, and then click Send File.
This will upload and install the certificate against the corresponding private key.

1. To install the certificate on a site, return to the Websites & Domains tab, and
click the domain name of the website that you want to secure.
2. To switch on SSL protection, select the Enable SSL support checkbox.
3. From the SSL certificate menu, select your SSL certificate and click OK.

Website Management

165

Using Shared SSL Certificates (Windows)
If your hosting service provider offers shared SSL for securing access to sites, then you can
switch on SSL encryption without purchasing your own SSL certificate.

 To secure connections to a site by using an SSL certificate shared by your
provider:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains and select the website you want to protect with
an SSL certificate.
3. Click Shared SSL.
4. Select the domain name of the site that you want to secure.
5. Select the Switch on shared SSL checkbox.
6. Specify the virtual directory name in the corresponding input field. The virtual
directory with the supplied name will be created under the domain whose
SSL certificate is shared (called master SSL domain). This directory will be
used for accessing your site through SSL.
For example, let us suppose that you have a domain named mydomain.com, the master
SSL domain is defined as master_ssl_domain.com, and the virtual directory name you
supplied is my_virtual_dir. In this case, to access your site through SSL, you need to
use the following address: https://master_ssl_domain.com/my_virtual_dir.
Note: You cannot use your domain name (for example, mydomain.com) to access your
site via SSL if you are using shared SSL.

7. Select the directory where protected content is located under your website.
The documents within the specified directory will be accessible only through
SSL.
8. To make your domain accessible via SSL only, select the checkbox Make this
website accessible only through secure connections.
9. Click OK.
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Protecting Sites from Hotlinking (Windows)
Hotlinking (also called file leeching, remote linking, direct linking, bandwidth stealing or
bandwidth banditism) is a term used for describing a situation when a web page of one
domain owner is directly linking to images (or other multimedia files) on the web pages of
another domain owner, usually using an <IMG> tag. If your domains are hotlinked, you may
face the problem of excessive bandwidth usage.

 To protect a website from hotlinking:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Hotlink Protection.
4. Click Switch On to enable the protection from hotlinking.
5. Specify the extensions of files that you want to protect from hotlinking (for
example, jpg, bmp, and so on) in the Protected files extensions field. When
listing several file extensions, separate them with white spaces.
6. If you want to allow direct linking to your files from certain sites, type the
website addresses into the Addresses of friendly websites field, and click Add.
7. Click OK.

(Advanced) Extended Website Management
Panel provides a number of operations on websites and domains for advanced users:
Working with third-party applications and services, fine tuning of some system services, and
much more. This section contains the detailed instructions on all these operations.

Next in this section:
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Working with a Staging Site
If you have a production website and are planning major site changes, consider setting up a
staging site — a separate location on the server where you can conveniently update and test
a copy of the site before putting it into production.
We recommend that you work with a staging site in the following way:
1. Decide where you want to host the development copy and prepare the development
environment. You can choose to host it in the same webspace, in a separate webspace
on the same server, or upload it to an FTP account on another server.
If you choose the same webspace, then you first need to set up a new website by adding
a domain or a subdomain.
2. (Optional step.) If you set up your development environment under your account in the
Panel and your production site has APS applications installed via the Panel (at the
Applications tab), install the desired site applications in your development environment in
the same subdirectory as you have on your production site. This step is optional;
however, it will help you avoid changing manually database connection settings in the
application scripts.
3. Make a copy of the website and place it in the staging environment.
4. Make copies of the databases used by the site and deploy them in the staging
environment.
5. Change database connection settings in the scripts to point at the databases in the
staging environment.
6. (Optional step.) Complete APS applications setup. Go to the Applications tab for your
development site, locate the application in the list of installed applications, open its
Settings screen and re-save the parameters. With this operation, the APS scripts should
stop pointing at the production database and reconnect the application to the database
copy. This step is needed if your production site has APS apps installed via the Panel
and you performed Step 2 of the current instruction.
7. Make the required changes to the site copy in the staging environment, and test them to
make sure everything works as intended.
8. Publish the updated site. This is done by pointing the document root of the production
site to the staging site location.

 To set up a site for staging purposes:
1. Go to the Websites & Domains tab.
2. Click either Add New Domain or Add New Subdomain.
We recommend that you use a subdomain for staging purposes.

3. Proceed as described in Adding Domains (on page 110) or Adding Subdomains
(on page 112).
If you do not want your staging site to be accessible to the Internet users, do not register the
newly added domain or subdomain name with a domain name registrar, or use an
.htaccess file (on Linux hosting) to restrict access to it.
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 To make a copy of website files:
1. Go to the Websites & Domains tab and click the name of the website you want
to copy.
2. Click Website Copying.
3. To copy website files to the document root of an existing site:
a. Select the option Website in the Panel.
b. Select the destination site from the Site name menu.
c. Specify what to do with the files that might already be present in the
destination directory.
4. To copy website files to an FTP account on this or another server:
a. Select the option FTP storage.
b. Specify the server's host name and credentials for connecting to the
FTP account.
c. In the FTP connection method field, leave the Active mode option selected.
If the Panel fails to connect to the external FTP account, select the
Passive mode option here.
5. Click OK.
If the site uses scripts that work with a database, copy the database to the staging
environment:


If the database is hosted on the same server managed by Panel 10, use the procedure
below to copy it.



If the database is hosted on a server which is not managed by Panel 10, use the
mysqldump utility to export the database, move the resulting data dump file to the
staging environment and deploy it there. Modify the site's scripts in the staging
environment so that they connect to the copied database.

 To make a copy of a database from the Panel-managed server:
1. Go to the Websites & Domains tab > Databases.
2. Click Copy in the databases list for the database you want to copy.
3. Specify the following:


Destination database server. You can select the same Panel-managed database server,
or a database server located elsewhere. For an external database server, specify the
host name or IP address, and access credentials: the username and password of a
database management system user authorized to create new databases and
database tables.



Destination database. You can choose to create a new database or copy the data to an
existing database.



Create a full copy. Leave this option selected to copy the database structure and all
data.
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4. Click OK.
The copy of the database will be deployed on the destination server.

5. Modify the site's scripts in the staging environment so that they connect to
the copied database.
When the site copy in the staging environment is updated and ready to go live, publish it as
described in the following steps.

 To publish the updated site to the production environment:
1. Go to the Websites & Domains tab.
2. In the list of domain names, locate the address of your production site and
click it.
3. In the Document root box, specify the document root directory of the staging
site.
4. Click OK.
This will make the updated site copy in the staging site location accessible to visitors of your
production site address.

Setting Up Mobile Sites
Your service plan may include the option to create website copies optimized for viewing on
mobile devices. The copies are hosted with external UNITY Mobile online service.
Important: In Panel 10.4, if a customer ordered the Unity Express offering from the
Applications tab, the system could confuse the offering with Unity One. If you faced this
problem, we recommend that you remove the site created with Unity One and create the
new one in order to get Unity Express.

 To create a copy of your website optimized for viewing on mobile devices, or
set up a new mobile website:
1. Go to Websites & Domains tab and click the site's domain name.
2. Click Mobile Websites.
3. Click the corresponding Create Mobile Site link.
4. Specify an address for the mobile site.
If your site is accessible, for example, by domain name example.com, you can type a
prefix like mobile, and then the optimized copy of your website will be accessible by the
address mobile.example.com.

5. Click OK.
6. Click Edit Site Content. A UNITY Mobile site opens in a new browser window or
tab, and you are logged on under your account.
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7. In the Import from the web section showing your main website’s domain name,
click the button

.

8. Complete the website import wizard by following instructions presented on
the screen.
After the mobile site is created, you can add a link to it to your main site.
You can now perform the following operations on the mobile site using links in Control Panel:


Open site editor.



Remove mobile site.

Setting Up Custom Error Pages
When visitors coming to a site request pages that the web server cannot find, the web server
generates and displays a standard HTML page with an error message. You may want to
create your own error pages and use them for your sites or individual virtual directories. The
following error messages are the ones customized most often:


400 Bad File Request. Usually means the syntax used in the URL is incorrect (for
example, uppercase letter should be lowercase letter; wrong punctuation marks).



401 Unauthorized. Server is looking for some encryption key from the client and is not
getting it. Also, wrong password may have been entered.



403 Forbidden/Access denied. Similar to 401; a special permission is needed to access
the site – a password or username, if it is a registration issue.



404 Not Found. Server cannot find the requested file. File has either been moved or
deleted, or the wrong URL or document name was entered. This is the most common
error.



500 Internal Server Error. Could not retrieve the HTML document because of server
configuration problems.



503 Service Temporarily Unavailable. The site is temporarily unavailable due to
maintenance.

Next in this section:
Setting Up Custom Error Pages on Windows Servers ....................................... 171
Setting Up Custom Error Pages on Linux Servers ............................................. 172
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Setting Up Custom Error Pages on Windows Servers
 To configure the web server to show custom error pages for a site or a
directory within a site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Switch on support for custom error documents.
a. Go to the Websites & Domains tab and click the Hosting Settings button
beside domain name you need.
b. Select the Custom error documents checkbox.
c. Click OK.
3. Go to the Websites & Domains tab.
4. Click the domain name you need.
5. Click Virtual Directories to see the list of error documents for the root web
directory. Error documents located here are used for all web pages of the
selected site. If you want to customize error pages for a specific virtual
directory, navigate to that directory.
6. Click Error Documents tab and click the required error document in the list.


To use the default document provided by IIS for this error page, select Default in the
Type menu.



To use a custom HTML document already located in the error_docs directory in the
virtual host directory of the domain, select File in the Type menu and specify the file
name in the Location field.



To use a custom HTML document located in a directory other than error_docs on
a domain, select URL in the Type menu and enter the path to your document in the
Location field. The path should be relative to the virtual host root (that is,
<vhosts>\<domain>\httpdocs).
For example, you have created a file forbidden_403_1.html and saved it in the
my_errors directory located in the httpdocs. To use this file as an error document,
you need to type the following path into the Location field:
/my_errors/forbidden_403_1.html.

Note: You can use a connection over FTP or File Manager in the Panel to upload your
custom error document to the server. By default, all error documents are stored in the
/vhosts/your-domain.com/error_docs/ directory (located in C:\InetPub by
default).

7. Once the web server is restarted, it will start using your error documents.
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Setting Up Custom Error Pages on Linux Servers
 To configure the web server to show custom error pages for a site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Switch on support for custom error documents.
a. Go to the Websites & Domains tab and click the Hosting Settings button
beside domain name you need.
b. Select the Custom error documents checkbox.
c. Click OK.
3. Connect to your FTP account, and go to the error_docs directory.
4. Edit or replace the respective files. Be sure to preserve the correct file
names:


400 Bad File Request - bad_request.html



401 Unauthorized - unauthorized.html



403 Forbidden/Access denied - forbidden.html



404 Not Found - not_found.html



405 Method Not Allowed - method_not_allowed.html



406 Not Acceptable - not_acceptable.html



407 Proxy Authentication Required - proxy_authentication_required.html



412 Precondition Failed - precondition_failed.html



414 Request-URI Too Long - request-uri_too_long.html



415 Unsupported Media Type - unsupported_media_type.html



500 Internal Server Error - internal_server_error.html



501 Not Implemented - not_implemented.html



502 Bad Gateway - bad_gateway.html



503 Service Temporarily Unavailable - maintenance.html

The web server will start using your error documents in a few hours, after it is restarted.
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Using Google Services
Using links in the Panel, you can generate code for inserting a custom Google search engine
into your site, submit your website to Google through Webmaster Tools area, enroll in the
AdSense program, embed YouTube videos, Google Translate service, or other Google
products into your site.
Google Custom Search is a search engine provided by Google. It adds search functions to
your site and allows you to apply your website's look and feel to the search results page. It
can be used for free on websites of individuals and non-profit organizations. Websites related
to for-profit businesses can either use a Custom Search Engine that will show
advertisements from Google, or purchase a subscription to Google Site Search service,
which starts from $100 per year. To learn more about Google Site Search and current prices,
visit http://www.google.com/sitesearch.
Google Webmaster Tools allow webmasters to submit a website to Google and view search
statistics. To learn more about Webmaster Tools, visit
http://www.google.com/support/webmasters/?hl=en.
Google AdSense allows webmasters to earn money for displaying targeted Google ads on
their websites. To learn more about AdSense, visit
https://www.google.com/adsense/login/en/.
Google Web Elements allows webmasters to easily add their favorite Google products to
websites. Embed content, such as news, maps, YouTube videos, and social conversations
from Google Friend Connect to Web pages with simple cut-n-paste. To learn more about
Google Web Elements, visit http://www.google.com/webelements/.
Before you start using Google services, you need to confirm acceptance of Google Terms of
Services, and then confirm ownership for your sites.

 To confirm acceptance of Google terms of service and then confirm ownership
of your sites:
1. Go to the Websites & Domains tab, and click the Google Services for Websites link.
2. Click the appropriate links in the Panel to open and read the Terms of
Service documents.
3. To confirm that you accept the Terms of Service, select the checkbox and
click Confirm.
Now you can do the following:



Submit your site to Google and improve site visibility in search results by clicking Google
Webmaster Tools.
Add search functions to a site by clicking Add New Custom Search Engine.



Enroll in the AdSense program by clicking Google AdSense.



Embed Google products into your site by clicking Google Web Elements.
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 To submit a site to Google:
1. Go to the Websites & Domains tab and click the site's domain name.
2. Click the Google Services for Websites link.
3. Click Google Webmaster Tools.
The Google Webmaster Tools area opens in a new browser window or tab.

4. Create a Sitemap and submit it to Google by following instructions at
http://www.google.com/support/webmasters/bin/answer.py?hl=en&answer=1
56184.

 To add a custom search engine to a site:
1. Go to the Websites & Domains tab and click the site's domain name.
2. Click the Google Services for Websites link.
3. Click Custom Site Search.
4. Click Add New Custom Search Engine.
5. Type a search engine name and select the website you need.
6. Select the checkbox to confirm your acceptance of Terms of Service, and
click OK.
The record corresponding to the new search engine is added to the Panel.

7. Click the corresponding Get Code link, copy the generated code to the
clipboard and paste it into the source code of your website pages.
The other links in the list of Custom Search Engines will help you perform the following
operations:


Make Money. Connect your Custom Search Engine to a Google AdSense account. You
make money when users click on an ad they see in your search results. If you have more
than one Custom Search engine, all of your search engines will automatically be
associated with the same AdSense account.



Manage. Manage your Custom Search Engines.



Look and Feel. Adjust the appearance of search box and search results page.



Upgrade. Upgrade a Custom Search Engine to ads-free Google Site Search.



Statistics. Review site search reports.



Delete. Delete a Custom Search Engine.

 To participate in the Google AdSense program:
1. Go to the Websites & Domains tab and click the site's domain name.
2. Click the Google Services for Websites link.
3. Click Google AdSense.
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4. Click Google AdSense account.
5. Fill in all the required fields to create a new AdSense account, or select an
existing account, and click OK.
A confirmation e-mail with further instructions will be sent to your e-mail address.

Hosting Personal Web Pages Under Your Domains
You can host on your web server personal web pages for users who do not need their own
domain names. These pages usually have web addresses like http://yourdomain.com/~username.

 To accommodate a personal web page under your domain and set up an FTP
account for publishing:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the domain name under which you
want to create a personal web page.
3. Click Web Users.
4. Click Settings.
5. If you want to allow execution of scripts embedded in personal web pages,
select the Allow web users to use scripts checkbox.
6. Click OK.
The settings you have defined at the step 4 are common for all personal web pages you
might host on your account. Therefore, you will not need to perform the steps from 3 to 5
next time you set up a new web user account.

7. Click Add New Web User.
8. Specify a username and a password that will be used for accessing the
webspace through FTP and publishing the web pages.
You can use only lower-case alphanumeric, hyphen and underscore symbols in the
username. The username should begin with an alphabet character. It cannot contain
white spaces. The password cannot contain quotation marks, white space, username,
and should be between 5 and 14 characters in length.

9. If you want to limit the amount of disk space that can be occupied by the web
page content, type the desired value in megabytes into the Hard disk quota
box.
When the specified limit is exceeded, the web page owner will not be able to add files to
his or her webspace.

10. Specify the programming languages that should be supported for the web
page.
For example, if the web page is written in PHP, select the PHP support checkbox.
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11. If you use a Windows-based hosting account and this personal web page's
applications need to use a file-based database (like Jet) located in the root
of httpdocs directory, select the Additional write/modify permissions option. Note
that selecting this option might seriously compromise the website security.
12. Click OK.
Now you can tell your user the FTP account credentials, so that he or she can publish their
web page.

 To change FTP password for a web page owner:
1. Go to the Websites & Domains tab and click the name of the domain that
contains the personal page.
2. Click Web Users.
3. Click the user name you need.
4. Type the new password into the New password and Confirm password boxes.
5. Click OK.

 To allocate more disk space to the web page owner:
1. Go to the Websites & Domains tab and click the name of the domain that
contains the personal page.
2. Click Web Users.
3. Click the user name you need.
4. Type the amount of disk space in megabytes into the Hard disk quota box.
5. Click OK.

 To remove a web page owner’s account together with their web page:
1. Go to the Websites & Domains tab and click the name of the domain that
contains the personal page.
2. Click Web Users.
3. Select a checkbox corresponding to the user account you want to remove
and click Remove.
4. Confirm removal and click OK.
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Limiting Bandwidth and Number of Connections to Websites
To avoid excessive usage of bandwidth, and protect your site from Denial Of Service attacks,
you can limit bandwidth usage for a site and number of simultaneous connections.

 To limit bandwidth usage and number of connections to a site:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the site's domain name.
3. Click Bandwidth Limiting.
4. Select the Switch on bandwidth limiting checkbox.
5. In the Maximum bandwidth usage (KB/S) box, specify the maximum speed,
measured in kilobytes per second, that a website can share among all its
connections.
6. Select the Switch on connections limiting checkbox.
7. In the Connections limited to box, specify the maximum number of simultaneous
connections to the site.
8. Click OK.
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Working with Microsoft FrontPage Websites (Windows)
Microsoft FrontPage deals with two kinds of websites: disk-based and server-based. In short,
a disk-based site is a FrontPage website you create on your local hard disk and then later
publish to the server. A server-based site is one you create and work with directly on the
server, without the extra step of publishing. This section provides you with instructions on
publishing only disk-based websites.
You can publish disk-based websites either through FTP or HTTP. If your hosting server is
running FrontPage Server Extensions, you would publish your site over HTTP. For example:
http://your-domain.com/MyWebSite. If your hosting server supports FTP, you would publish
to an FTP location. For example: ftp://ftp.your-domain.com/myFolder.
After publishing, you can manage your site through FrontPage Server Extensions.

 To access FrontPage Server Extensions management interface:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab and click the name of the website you want to
manage in Frontpage.
3. Click FrontPage.
4. Do either of the following:


To manage a site over HTTP connection, click Frontpage Webadmin.



To manage a site over a secure SSL connection, if SSL support is enabled for the
site, click Frontpage SSL Webadmin.

5. Type your FrontPage administrator’s username and password, and click OK.
For instructions on using FrontPage server extensions, see online help (Frontpage Webadmin >
Help) or visit Microsoft website.
The following FrontPage settings are changeable through the Panel:


The use of Microsoft FrontPage IIS Index Server for building the full-text index of your
website.



SMTP mail server and sender's e-mail address. These options are applicable if you
use FrontPage forms that submit information from your site by e-mail. By default,
SMTP server specified in the domain's DNS zone is used for sending mail. If no
SMTP server is specified in the zone, then FrontPage uses the mail service running
on the server where the domain (site) is hosted.
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 To change any of these settings:
1. Click the Websites & Domains tab and click the name of the website you want to
manage in Frontpage.
2. Go to FrontPage > Settings.
3. Make the required changes and click OK.

Next in this section:
Publishing FrontPage Websites ......................................................................... 180
Adding FrontPage Accounts .............................................................................. 182
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Publishing FrontPage Websites
 To publish files through FTP:
1. Open your FrontPage program.
2. Open a FrontPage website: open File menu and select the Open Site item.
3. Go to Remote Web site view: click the Web Site tab, and then the Remote Web Site
button at the bottom of the window.
4. Set up your Remote Web Site Properties:


Click the Remote Web Site Properties button in the upper-right corner of the window.



Select FTP as the remote Web server.



In the Remote Web site location box, type your host name (for example, ftp://ftp.yourdomain.com)



In the FTP directory box, type your FTP directory if your hosting company provided one.
Leave it blank if they did not specify one.



Select the Use Passive FTP check box if your computer or network is protected by a
firewall.

5. Click OK to connect to the remote site.
The Remote Web site view will show files that you have in your local and remote sites.

6. Click the Publish Web site button in the lower-right corner of the window.

 To publish files through HTTP on a server that supports FrontPage Server
Extensions:
1. Open your FrontPage program.
2. Open a FrontPage website: open File menu and select the Open Site item.
3. Go to Remote Web site view: click the Web Site tab, and then the Remote Web Site
button at the bottom of the window.
4. Click the Remote Web Site Properties button in the upper-right corner of the
window.
5. On the Remote Web Site tab, under Remote Web server type, click FrontPage or
SharePoint Services.
6. In the Remote Web site location box, type the Internet address, including the
protocol, of the remote website that you want to publish folders and files to,
for example, http://www.your-domain.com, or click Browse to locate the site.
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7. Do any of the following:


To use Secure Sockets Layer (SSL) for establishing a secure communications
channel to prevent the interception of critical information, click Encryption connection
required (SSL). To use SSL connections on your web server, the server must be
configured with a security certificate from a recognized certificate authority. If the
server does not support SSL, clear this check box. Otherwise, you will not be able to
publish folders and files to the remote website.



To remove specific types of code from web pages as they are being published, on the
Optimize HTML tab, select the options you want.



To change the default options for publishing, on the Publishing tab, select the options
you want.

8. Click OK to connect to the remote site.
The Remote Web site view will show files that you have in your local and remote sites.

9. Click the Publish Web site button in the lower-right corner of the window.
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Adding FrontPage Accounts
If you are using Microsoft FrontPage for collaborating on website content with other users,
then you need to create additional Microsoft FrontPage accounts.

 To create an additional Microsoft FrontPage account:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the domain name of the website for
which you create the account.
3. Click FrontPage.
4. Click Add New FrontPage Account.
5. Specify the following:


Username and password for the account.



Limit on disk space. If you wish to limit the amount of disk space that can be used by
this account, clear the Unlimited check box and type the desired value in megabytes
into the Hard disk quota box.
When the specified limit is exceeded, the user will not be able to upload more files to
the webspace.

6. Click OK.

 To change settings for an additional Microsoft FrontPage account:
1. Go to the Websites & Domains tab and click the domain name of the website
that contains the account.
2. Click FrontPage.
3. Click the required account name in the list.
4. Adjust the settings as necessary and click OK to save changes.

 To remove an additional Microsoft FrontPage account:
1. Go to the Websites & Domains tab and click the domain name of the website
that contains the account.
2. Click FrontPage.
3. Select the checkbox corresponding to the account you want to remove.
4. Click Remove.
5. Confirm the removal and click OK.
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Using Virtual Directories (Windows)
A virtual directory is a link to an existing physical directory that is present on the server's hard
disk. Virtual directories can have a number of specific settings like custom ASP.NET
configuration, access permissions, and protection with a password.
Because any virtual directory can have its own settings, including customized ASP.NET
configuration, virtual directories are very useful in setting up your web applications, especially
those written in ASP.NET. For example, if you have three web applications that use
ASP.NET version 1.1, and you need to install one web application that uses ASP.NET
version 2.0, you can create a virtual directory for the ASP.NET 2.0 application, configure
ASP.NET settings for this directory so as to enable support for version 2.0, and then
successfully install the required application.
Virtual directories can also be used as aliases. For example, you have a web application
installed on your domain "example.com" in the physical directory
"/my_data/web_apps/forum". To access this web application, users need to type
"example.com/my_data/web_apps/forum", which is hard to remember and too long to
type. You can create virtual directory called forum in the root of your virtual host, and link
this virtual directory to "/my_data/web_apps/forum", so the users who want to access
the web application will need to type "example.com/forum", which is much shorter and
easier to remember.

Next in this section:
Creating Virtual Directories ................................................................................ 184
Configuring ASP.NET for Virtual Directories ...................................................... 186
Configuring PHP for Virtual Directories .............................................................. 188
Setting Up Access to Virtual Directories ............................................................ 189
Changing Virtual Directory Settings ................................................................... 192
Adding and Removing MIME Types .................................................................. 194
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Creating Virtual Directories
 To create a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories. You are in your web site root now.
4. Navigate to the directory in which you want to create a new virtual directory.
5. Click Create Virtual Directory.
Note: To create a physical directory instead of virtual directory, click Create Directory,
specify the name of the directory and click OK.

6. Specify the required parameters:


Name - specify the virtual directory name.



Path - specify the virtual directory path:


Select the Create physical directory with the same name as virtual directory checkbox to
automatically create a physical directory with the same name as the virtual
directory you are creating.



Clear the Create physical directory with the same name as virtual directory checkbox and
specify the path in the field to select a physical directory that already exists.



Script source access - select this checkbox to allow users to access source code if
either Read or Write permissions are set. Source code includes scripts in ASP
applications.



Read permission - select this checkbox to allow users to read files or directories and
their associated properties.



Write permission - select this checkbox to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-enabled
file. Write access is allowed only if browser supports the PUT feature of the HTTP 1.1
protocol.



Directory browsing - select this checkbox to allow users to see a hypertext listing of the
files and subdirectories in the virtual directory.



Log visits - select this checkbox if you want to store the information about visits of the
virtual directory.



Create application - select this checkbox to make the directory an IIS application. The
directory becomes logically independent from the rest of the website.
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Execute permissions - select the appropriate program execution level allowed for the
virtual directory.


None - allow access only to static files such as HTML or image files.



Scripts only - allow running scripts only, not executables.



Scripts and Executables - remove all restrictions so that all file types can be
executed.

ASP Settings - set specific settings for ASP-based web applications.


If you are using ASP-based applications that cannot operate correctly under data
transfer restrictions currently set by IIS, clear the Defined by parent directory
checkbox corresponding to the field you want to change and type in the required
number.



If you want to enable debugging of ASP applications on the server side, clear the
corresponding Defined by parent directory checkbox and select the Enable ASP serverside script debugging checkbox.



If you want to enable debugging of ASP applications on the client side, clear the
corresponding Defined by parent directory checkbox and select the Enable ASP clientside script debugging checkbox.

Note that if you are trying to change ASP Settings for the root virtual directory, the
default checkbox names will be Defined by IIS instead of Defined by parent directory.

7. Click OK.

 To remove a virtual directory from a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Select the checkbox corresponding to the directory you want to remove.
5. Click Remove.
6. Confirm the removal and click OK.
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Configuring ASP.NET for Virtual Directories
 To configure ASP.NET settings for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Browse to the required directory and click a link with its name.
5. Click ASP.NET Settings.
6. Set up the strings that determine database connection data for ASP.NET
applications that use databases. This option is available only for ASP.NET
2.0.x.
When you open the ASP.NET configuration page for the first time, sample connection
parameters with common constructions are displayed. You can delete them and
specify your own strings.


To add a string, enter the required data into the Name and Connection Parameters input
fields and click
next to them.



To remove a string, click

next to it.

7. Set up custom error messages that will be returned by ASP.NET
applications:




To set the custom error messages mode, select an appropriate option from the Custom
error mode menu:


On - custom error messages are enabled.



Off - custom error messages are disabled and detailed errors are to be shown.



RemoteOnly - custom error messages are displayed only to remote clients, and
ASP.NET errors are shown to the local host.

To add a new custom error message (which will be applied unless the Off mode was
selected), enter the values in the Status Code and Redirect URL fields, and click .


Status Code defines the HTTP status code resulting in redirection to the error page.



Redirect URL defines the web address of the error page presenting information
about the error to the client.

Due to possible conflicts, you cannot add a new custom error message with an error
code that already exists, but you can redefine the URL for the existing code.


To remove a custom error message from the list, click

next to it.
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8. Configure compilation settings in the Compilation and Debugging field:


To determine the programming language to be used as default in dynamic compilation
files, choose an entry from the Default web page language menu.



To enable compiling of retail binaries, leave the Switch on debugging checkbox empty.



To enable compiling of debug binaries, select the Switch on debugging checkbox. In this
case, the source code fragments containing error will be shown in a diagnostic
message.

Note: When running applications in debug mode, a memory and performance overhead
occurs. We recommended that you use debugging when testing an application, and
disable it before deploying the application into production scenario.

9. Configure encoding settings for ASP.NET applications in the Globalization
Settings section:


To set an adopted encoding of all incoming requests, enter an encoding value into the
Request encoding field (default is utf-8).



To set an adopted encoding of all responses, enter an encoding value into the
Response encoding field (default is utf-8).



To set an encoding which must be used by default for parsing of .aspx, .asmx, and
.asax files, enter an encoding value into the File encoding field (default is Windows1252).



To set a culture which must be used by default for processing incoming web requests,
select an appropriate item from the Culture list.



To set a culture which must be used by default when processing searches for a
locale-dependent resource, select an appropriate item from the UI Culture list.

10. Set a code access security trust level for ASP.NET applications in t he Code
Access Security field.
CAS trust level is a security zone to which applications execution is assigned, defining
what server resources the applications will have access to.
Important: When an assembly is assigned a trust level that is too low, it does not
function correctly. For more information on the permission levels, see
http://msdn.microsoft.com/library/enus/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010.

11. If you are using ASP.NET 1.1.x, then you can enable the usage of the
auxiliary scripts in the Script Library Settings field. Specifying the script library
settings is necessary if the validation web controls are used on your web
site.


If you need to use auxiliary scripts (specifically, scripts implementing objects for
validating input data), provide the settings for .NET framework script library. To do so,
enter the path beginning with the domain root directory preceded by the forward slash
into the Path to Microsoft script library field, or click the folder icon next to the Path to
Microsoft script library field and browse for the required location.



To initiate installation of files containing the scripts to the specified location, select the
Install checkbox. If the files already exist there, they will be rewritten.
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12. Set client session parameters in the Session Settings field:


To set up the default authentication mode for applications, select an appropriate item
from the Authentication mode list. Windows authentication mode should be selected if
any form of IIS authentication is used.



To set up the allowed session idle time, enter appropriate number minutes into the
Session timeout field.

13. Click OK to apply all changes.

Configuring PHP for Virtual Directories
To be able to use web applications that require PHP4 or PHP5, you can select the required
PHP version for individual virtual directories.

 To select PHP version for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Browse to the required directory and click a link with its name.
5. In the Tools group, click PHP Settings.
6. Select the required version of PHP and click OK.
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Setting Up Access to Virtual Directories
 To set access permissions for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. To set access permissions for the current virtual directory, in the Tools group,
click Directory Access Permissions. If you want to set permissions for a
subdirectory located within the current directory, click the corresponding icon
.
5. Do the following:


To make the file/folder inherit permissions from a parent folder (if it does not), select
the checkbox Allow inheritable permissions from the parent to propagate to this object and all
child objects. Include these with entries explicitly defined here.



To make the files and folders, which are contained in this folder, inherit the folder
permissions you define, select the checkbox Replace permission entries on all child objects
with entries shown here that apply to child objects.



To change or remove permissions from a group or a user, click the required name in
the Group or user names list. If the group or user is not listed in the Group or user names
list, select the required user or group name from the menu located above the list and
click : the user/group appears in the list. Select it.
To allow or deny permissions to a selected group/user, select the Allow or Deny
checkboxes corresponding to permissions listed under Permissions for <user/group
name>. If the checkboxes in Allow or Deny columns are shown in grey, it means that the
corresponding permissions are inherited from a parent folder.



To deny the permissions, which are inherited from a parent object as allowed, select
the required checkboxes under Deny. This will override inherited permissions for this
file/folder.



To allow the permissions, which are inherited from a parent object as denied, clear the
Allow inheritable permissions from the parent to propagate to this object and all child objects.
Include these with entries explicitly defined here checkbox: this removes the inherited
permissions. Then select the required checkboxes under Allow and Deny.



To remove access permissions from a group or user, select the required name in the
Group or user names list and click the icon
next to it.
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6. If you need advanced fine-tuning of permissions, click the Advanced button,
and do the following:


To create a permission entry for a group or user, select the required name from the
Group or user names list and click .



To set or change file/folder permissions for a group or user, select the required name
from the Group or user names list, select the required Allow and Deny checkboxes
corresponding to permissions listed under Permissions for <user/group name>.



To remove a permission entry for a group or user, select the required name from the
Group or user names list and click .



To make child objects of a folder inherit its permissions defined under Permissions for
<user/group name>, select the Replace permission entries on all child objects with entries
shown here that apply to child objects checkbox, and select checkboxes in the Apply to list
which correspond to the objects that must inherit the permissions.

7. Click OK.

 To restrict access to files and directories located within a virtual directory:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Navigate to the directory you want to protect and click the Protection tab.
5. Click Protect.
6. To specify users who will be able to access the directory, click Add User,
specify username and password, and click OK.
7. If you want to specify a title for the protected area that will be shown to users
when they attempt to access the directory, click Settings, specify a title, and
click OK.

 To revoke a permission to access a directory from a user:
1. Go to the Websites & Domains tab and click the website's domain name.
2. Go to the Virtual Directories > Protection tab.
3. Select the checkbox corresponding to the user's name and click Remove.
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 To remove protection from a directory and allow the general public to see the
directory contents without restrictions:
1. Go to the Websites & Domains tab and click the website's domain name.
2. Go to the Virtual Directories > Protection tab.
3. Click Remove Protection.
4. Click OK to confirm removal.

191

192

Website Management

Changing Virtual Directory Settings
 To change settings of a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Browse to the directory whose preferences you want to change, and click the
corresponding icon , or click Directory Properties when inside the required
directory.
5. Change the settings as required:


Name - specify virtual directory name.



Path - specify the path to the physical directory to which the virtual directory is linked.



Script source access - select this checkbox to allow users to access source code if
either Read or Write permissions are set. Source code includes scripts in ASP
applications.



Read permission - select this checkbox to allow users to read files or directories and
their associated properties.



Write permission - select this checkbox to allow users to upload files and their
associated properties to the virtual directory or to change content in a write-enabled
file. Write access is allowed only if browser supports the PUT feature of the HTTP 1.1
protocol.



Directory browsing - select this checkbox to allow users to see a hypertext listing of the
files and subdirectories in the virtual directory.



Log visits - select this checkbox if you want to store the information about visits to the
virtual directory.



Create application - select this checkbox to make the web directory an IIS application.
The directory becomes logically independent from the rest of the website.



Execute permissions - select the appropriate program execution level allowed for the
virtual directory.





None - allow access only to static files such as HTML or image files.



Scripts only - allow running scripts only, not executables.



Scripts and Executables - remove all restrictions so that all file types can be
executed.

Allow to use parent paths - select this checkbox to allow using double period in the path
name when referring to a folder above the current directory. This enables users to
move up the folder tree without knowing the folder name or the whereabouts in the
hierarchy. If the option is selected, parent path directories should not have the Execute
permission checkbox selected in their properties, so that applications do not have the
ability of unauthorized running of programs in the parent paths.
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Allow application execution in MTA (multi-threaded apartment) mode - select this checkbox to
allow the application execution in multi-threaded apartment (MTA) mode. Otherwise,
the application will run in a single-threaded apartment (STA) mode. Using STA, each
application pool is executed in a dedicated process. With MTA, several concurrent
application pools are executed in one thread which can increase performance in some
cases.



Use default documents - select this checkbox to allow the use of default documents for
the current directory. The default document is sent when users access the directory
on the web without a specific file name (for example, using http://www.example.com
as opposed to http://www.example.com/index.html). If this checkbox is cleared and
the Directory browsing checkbox is selected, the web server returns a folder listing. If
this checkbox is cleared and the Directory browsing checkbox is cleared as well, the
web server returns an "Access Forbidden" error message.



Default documents search order - specifies the order in which IIS searches for the default
document, sending user the first available file it finds. If no match is found, IIS
behaves as in the cases when the default content page is disabled.



Allow anonymous access - select this checkbox if you want to make the directory public
so that the Internet users could access it without authentication.



Require SSL - select this checkbox to enable access to the folder only via SSLencrypted connections.



ASP Settings - set specific settings for ASP-based web applications.


If you are using ASP-based applications that cannot operate correctly under data
transfer restrictions set by IIS, clear the Defined by parent directory checkbox
corresponding to the field you want to change and type in the required number.



If you want to enable debugging of ASP applications on the server side, clear the
corresponding Defined by parent directory checkbox and select the Enable ASP serverside script debugging checkbox.



If you want to enable debugging of ASP applications on the client side, clear the
corresponding Defined by parent directory checkbox and select the Enable ASP clientside script debugging checkbox.
Note that if you are trying to change ASP Settings for the root directory, the default
checkbox names will be Defined by IIS instead of Defined by parent directory.

6. Click OK to save changes.
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Adding and Removing MIME Types
Multipurpose Internet Mail Exchange (MIME) types instruct a web browser or mail application
how to handle files received from a server. For example, when a web browser requests an
item on a server, it also requests the MIME type of the object. Some MIME types, like
graphics, can be displayed inside the browser. Others, such as word processing documents,
require an external application to be displayed.
When a web server delivers a web page to a client web browser, it also sends the MIME type
of the data it is sending. If there is an attached or embedded file in a specific format, IIS also
tells the client application the MIME type of the embedded or attached file. The client
application then knows how to process or display the data being received from IIS.
IIS can only operate files of registered MIME types. These types could be defined both on
the global IIS level and on the website or virtual directory level. Globally-defined MIME types
are inherited by all websites and virtual directories while ones defined on the website main or
virtual directory level are used only for the area where they are defined. Otherwise, if the web
server receives request for a file with unregistered MIME type, it returns the 404.3 (Not
Found) error.

 To add a new MIME type for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Navigate to the required virtual directory and click the corresponding link
with its name.
5. Click the MIME Types tab.
6. Click Add MIME Type.
7. Specify the following:


Type the file name extension in the Extension field. File name extension should begin
with a dot (.), or a wildcard (*) to serve all files regardless of file name extension.



Specify the file content type in the Content field.



You can either select the appropriate value from the list or define a new content type.
To do this, select Custom and enter the content type in the input box provided.

8. Click OK to finish the creation.
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 To edit a MIME type for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Navigate to the required virtual directory and click the corresponding link
with its name.
5. Select the MIME Types tab.
6. Select the required MIME type in the list.


Type the file name extension in the Extension field. File name extension should begin
with a dot (.), or a wildcard (*) to serve all files regardless of file name extension.



Specify the file content type in the Content field.



You can either select the appropriate value from the list or define a new content type.
To do this, select Custom and enter the content type in the input box provided.

7. Click OK to save changes.

 To remove a MIME type for a virtual directory within a website:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab and click the website's domain name.
3. Click Virtual Directories.
4. Navigate to the required virtual directory and click the corresponding link
with its name.
5. Select the MIME Types tab.
6. Select the checkbox corresponding to the MIME type you want to remove.
7. Click Remove.
8. Confirm removal and click OK.
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Setting Up IIS Application Pool (Windows)
IIS Application Pool contains all web applications installed on your sites. If your service
provider allocated a dedicated IIS application pool for your sites, then you can have a level of
isolation between web applications used by your sites and web applications used by other
hosting users who host their websites on the same server. Because each application pool
runs independently, errors in one application pool will not affect the applications running in
other application pools.
Once you switch on the application pool, all web applications on your websites will be using
it.

 To switch on dedicated IIS application pool for your websites:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Dedicated IIS Application Pool for Your Websites.
3. Click Switch On.
4. To limit the amount of CPU resources that this application pool can use,
select the Switch on CPU monitoring checkbox and type a number in percents
into the Maximum CPU use (%) box.
5. Click OK.

 To stop all applications running in the application pool:
1. Go to the Websites & Domains tab > Dedicated IIS Application Pool for Your Websites.
2. Click Stop.

 To start all applications in the application pool:
1. Go to the Websites & Domains tab > Dedicated IIS Application Pool for Your Websites.
2. Click Start.
If you run applications that are known to have memory leaks or become unstable after
working for a long time, then you might need to restart them from time to time.

 To restart all applications running in the application pool:
1. Go to the Websites & Domains tab > Dedicated IIS Application Pool for Your Websites.
2. Click Recycle.
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 To switch off the dedicated IIS application pool for your websites:
1. Go to the Websites & Domains tab > Dedicated IIS Application Pool for Your Websites.
2. Click Switch Off.
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Web Publishing with Web Deploy (Windows)
Web Deploy (Web Deployment Tool) is a Microsoft tool that significantly simplifies the
migration, management, and deployment of your websites and web applications. More
precisely, you can write a code in your local environment, for example, in Visual Studio®
(IDE) or WebMatrix® (development tool), and then periodically publish the updates to your
production server by means of Web Deploy.

Differences Between Visual Studio® and WebMatrix®
If you are looking for an environment that allows you to seamlessly publish code updates to
your account, it is likely you will choose between Visual Studio® and WebMatrix®.


Visual Studio® is a classic integrated development environment (IDE) for writing .NET
applications and sites of any scale. It has a variety of plugins that extend its basic
functionality. However, to run and debug your applications in Visual Studio®, you should
perform extra configuration (such as preparing a database and adjusting environment
settings). Thus, this tool is more suitable for advanced users.



With WebMatrix® you have a built-in set of application templates and even working
applications (WordPress, Joomla) right out of the box. If you wish to instantly add an app
to your customer account or run it, you just need to select the app from the list and
WebMatrix® will transparently configure it for you. Moreover, you can promptly find and
subscribe to a hosting plan for your project without leaving WebMatrix®. Summing up,
this tool is suitable even for novice users, and encourages fast development by providing
ready-to-run applications and templates. The details on how to install and use
WebMatrix® are available at http://www.microsoft.com/web/webmatrix/.

It is up to you to decide which is better for your project.

How to Configure Web Publishing in Visual Studio® and WebMatrix®
To set up web publishing in your environment, you should open the publishing settings and
specify the IP address of your customer account and the username and password you use to
log in to the Control Panel.
In WebMatrix®, the publishing settings are found in Home > Publish. You can provide these
settings either manually or as an XML file that Panel automatically generates. To download
the file for a certain website, click on a corresponding Download link in Websites & Domains >
<domain_name> > Web Deploy Publishing Settings. The settings are only available if Web Deploy
is installed on the Panel server and is running. If you do not see these settings, contact your
hosting provider.
For step-by-step instructions on how to set up web publishing in WebMatrix®, see
http://www.microsoft.com/web/post/how-to-publish-a-web-application-using-webmatrix.
To learn more about publication settings in Visual Studio®, see
http://msdn.microsoft.com/en-us/library/7z83t16a.aspx.
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Note: You can decide whether to transfer updates securely to your customer account by
selecting the corresponding option in the publication settings. If your hosting provider does
not have a valid SSL certificate, you will receive an error message on attempting publication.
To resolve the problem, contact your hosting provider for assistance or avoid using the
secure connection.

Securing WebMatrix® Publishing Settings
An XML file which keeps WebMatrix® publishing settings may include the password to a
customer's account. Administrators have the option to configure Panel so that it excludes
these passwords from the XML files. If the administrators wish to improve the security of the
system and prevent stealing the passwords, they can specify to exclude the password from
the XML file. The customers then will have to enter the password directly in WebMatrix®.
The option is available on the Tools & Settings > Server Settings page.

Creating Sites with Presence Builder
Parallels Presence Builder (also referred to as editor) is a visual editor that lets small
business owners and individuals create their websites quickly and easily. With Presence
Builder, you do not have to write code or configure servers to start a blog, open an online
store, or set up any other form of website. You just add the content blocks that comprise your
site (text, image gallery, online store) by dragging them to pages, fill these blocks with your
content, and publish the result. That’s it!

Start Creating a Website
When you start working on your website, you do not have to write text, search for the
images, and adjust the site look. Just choose a topic that best suits your website, and
Presence Builder will generate a site template that already contains a set of pages, pictures,
and text relevant to the selected topic. Each time Presence Builder generates a website, it
uses a random set of element designs, so you can be sure that your website design is never
repeated.
Once you have selected the topic, you will be prompted to enter some additional information
that Presence Builder will add to the website's pages, for example, your phone number,
which will appear on the Contact Us page.
For more details on how to start creating your website, see the section Creating a Website (on
page 204).

Import Websites Created in SiteBuilder 4.5
If you already have a website created with SiteBuilder 4.5 and hosted elsewhere, you can
import your website to your new customer account. Learn how to move your SiteBuilder 4.5
website to Presence Builder in the section Importing Sites from SiteBuilder 4.5 (on page 205).

200

Website Management

Fill the Site with Content
As soon as Presence Builder creates your website, you can fill it with your content. Your
main editing tool is the Presence Builder's main menu. You can do the following by using the
menu:


Change the structure of your site: Add or remove pages.



Edit the website design: Change colors and layout.



Fill the site with your content: Remove unused predefined content and add your own
elements:





Text



Images and image galleries



Videos



Scripts



Blogs



Search boxes



Other elements

Let your visitors share the information in your website in social media such as Facebook
or Twitter: Add the corresponding buttons to the pages of your site.

To learn more about actions available to you in the editor, refer to the section Getting Familiar
With the Presence Builder Editor (on page 202).
Find instructions on managing website look and content in the section Editing a Website (on
page 206).

Make the Site Available on the Internet
After you finish editing the website, make it available on the Internet. To let people see your
site at your domain name, publish the website by clicking the corresponding button in the
main menu. When you click this link, Presence Builder generates the static pages and scripts
that comprise your website and places them in the appropriate locations on the server so that
people see them when they enter your domain name in their browsers. Learn more about
publishing websites in the section Publishing a Website to the Internet (on page 247).
You can also attract more visitors to your sites by placing a site copy on Facebook - a
popular social network. Refer to the section Publishing a Website Copy to Facebook (on page
248) for detailed instructions on how to do this.

Next in this section:
Getting Familiar With Presence Builder ............................................................. 202
Creating a Website ............................................................................................ 204
Importing Sites from SiteBuilder 4.5 .................................................................. 205
Editing Websites................................................................................................ 206
Saving and Loading Copies of a Website .......................................................... 245
Publishing a Website to the Internet .................................................................. 247
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Publishing a Website Copy to Facebook ........................................................... 248
Viewing Site Visits Statistics, Comments, and New Orders on the Dashboard .. 250
Deleting Websites ............................................................................................. 252
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Getting Familiar With Presence Builder
The interface of the Presence Builder editor has two main parts: your website and the main
menu.
A website consists of a number of elements, or modules. Each module can be edited
separately. Here we will familiarize you with the basic principles of website module editing.
These are similar for all modules.
When adding a module to a page, you can choose whether it should be shown only on the
current page (page-specific module) or on all pages of the site (site-wide module). The only
exceptions are the Search, Advertisement, Site Logo, Navigation, and Breadcrumbs modules:
when you add them, they are placed on all pages of the website.
To place a module only on the current page, select the module under the Modules tab, and
drag it to any of the areas marked with the text ONLY ON THIS PAGE. Such areas are located
within the main content block and near the top of each sidebar.
To place a module on all pages of the website, select the module under the Modules tab, and
drag it to any of the areas marked with the text ON ALL PAGES. Such areas are located above
and below the main content block, in sidebars, header, and footer.
To locate or edit a website module, hover the mouse pointer over the part of the website you
want to change. A dotted frame will appear around the module. A control panel prompting
you to move, edit, or remove the module will appear next to the dotted frame.
The dotted frame around page-specific modules is green, but around site-wide modules it is
blue.
The editor's main menu offers website editing options grouped under five tabs:


Modules. Here you can choose necessary modules and drag them to any place on the
page to fill your website with content.



Design. Here you can select the layout and general color scheme for your website,
change colors of different elements, and select fonts and border style.



Pages. Here you can add and delete pages, rename them, edit page meta information
such as descriptions and keywords for use by search engines, or mark a page as hidden
so that your visitors cannot access it from the site menu.



Documents. Here you can upload documents, images, and other files in various formats to
your hosting account. You can then easily insert links to these documents into your
website pages. Or, you can just keep the files on the hosting account for your own needs.



Settings. Here you can edit your website name, description and keywords for search
engines, upload a site icon (favicon), optimize the ranking of your website in search
engine results, connect your site to Google Analytics, and add a copy of your site to a
Facebook page.
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From the main menu, you can also do the following:


Access the Dashboard to perform the following operations:


View statistics on website visits. The statistics are provided by Google Analytics.



View new comments left by site visitors on your website pages. The commenting
functionality is provided by Disqus.



View new orders from customers visiting your online stores. The online store
functionality is provided by Ecwid.



Save and load copies of your website by using the Save and Revert options.



Access Presence Builder Getting Started video tutorial, view User’s Guide, or send us your
feedback. To do this, select the corresponding option from the Help menu.
Publish your website by using the Publish button.




Discard any changes made to a site and start creating the site anew by selecting More >
Start Over. This does not delete your already published site copy.



Delete a current website draft from the editor by selecting More > Remove Site. This does
not delete your already published site copy.

You can drag the main menu to any place on the page for your convenience, or minimize it.
You can also access all options of the main menu in the context menu at any place on the
page. To open the context menu, click the right mouse button.
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Creating a Website
To minimize your efforts when creating a website, Presence Builder offers you a set of
predefined website topics. When you start creating a website, choose a topic that is most
appropriate for you, and Presence Builder will generate a website with the content relevant to
this topic. For example, it will include a price list template for a retail store or an image gallery
for an artist's site. If you cannot find a suitable topic, you can contact your service provider to
ask them to create the corresponding template and add it to the list of available topics.
When you start creating a website, Presence Builder also prompts you to provide information
about yourself or your company. Presence Builder will automatically add this information to
certain pages as appropriate, for example, to the About Us and Contact Us pages.
Note: Presence Builder will not store or use the information you provide anywhere except for
your website pages. You can change or remove this information later.

 To start creating a website in Presence Builder:
1. Go to the Websites & Domains tab and click the desired domain name.
2. Click Launch Presence Builder.
3. Select a website topic.
4. Type the website name and select website language.
5. Provide the information to pre-fill your website.
6. Click Create Site.
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Importing Sites from SiteBuilder 4.5
If you have a site created with SiteBuilder 4.5, you can import it to Presence Builder.
Note: The import of sites from earlier versions of SiteBuilder or other content management
systems is not supported.
If your site was created with an earlier version of SiteBuilder (4.4 or earlier), and you would
like to transfer your site, you can do the following:



Contact your hosting provider and ask them to upgrade your account to the latest version
of Presence Builder.
Transfer your site manually by copying and pasting the content.

During site import, most parts of the site structure and content can be transferred
successfully. However, we cannot guarantee that all content will be transferred.
In most cases, the following elements are imported successfully:


Site map.





Static pages, including links and images in text modules. Note that text blocks exceeding
30 kilobytes may be cut; therefore, some parts of the text may be missing.
Banner (if it is not a custom image).
Slogan, site title.



Logo (if it is not a custom image).



Footer text.



Meta info (keywords, description).

The other modules can be imported only as text widgets with static content, links and
images. Buttons will not work. The image gallery structure can be imported without images.

 To import a site from SiteBuilder 4.5:
1. Open the Presence Builder editor, and on the topic selection screen, click
Import Site from SiteBuilder 4.5.
2. Type the Internet address (domain name) of the site that you want to import.
For example: http://example.com.
3. Select the checkbox to confirm that you are aware of possible import issues,
and click Import Site.
4. After the site is imported, review and edit it as required (on page 206). You
can compare the imported site version with your original site and add the
missing information manually.
5. When finished with editing, publish the site to your customer account (on
page 247).
If you are publishing your new site to the same webspace on which your site created with
SiteBuilder 4.5 was hosted, the old site will be overwritten.
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Editing Websites
In Presence Builder, you can change almost any element of your website. Most of the
elements are changed in place - you open a page where the element is used, edit it and see
the result right away. Site-wide elements, such as Search block and Advertisement block are
changed in one place but the changes are applied to each page of your website.
Note: If you are using Internet Explorer, we strongly recommend that you avoid using
browser zoom to change the size of text displayed in your browser window. Please note that
websites in Presence Builder will perform and look best at normal zoom (100%).

Next in this section:
Structure: Pages and Navigation ....................................................................... 206
Design: Design Templates, Layout, Styles, Color Scheme, and Header ............ 209
Content: Text, Tables, Images, Video, Forms, and Scripts ................................ 217
Settings and Tools for Webmasters ................................................................... 240

Structure: Pages and Navigation
This section describes how to add pages to a site, set their location in the site structure, and
add navigation links.

Next in this section:
Adding and Removing Pages ............................................................................ 207
Adding and Removing Navigation Links ............................................................ 208
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Adding and Removing Pages
Your site can have two levels of nested pages. The total number of pages you can create
depends on your hosting plan. The editor will let you know when you have reached the
allotted number of pages: an icon with the dollar sign ($) will be shown over the Add page
button.

 To add a new page to your website:
1. Go to the Pages tab.
2. Click Add page. The new page appears highlighted in green.
3. Position the new page by dragging it to the right place or by clicking the
arrows.
4. Specify the page title.
5. Give a concise description of the page content that will be displayed on
search engine results pages and the keywords by which the page will be
found by search engines.
Note: Page name and Page link name are required fields. Description and Keywords are
optional fields. If you specify keywords for a page, they should be separated by commas
without white spaces.

6. If you want to make the page invisible to your website visitors, select the
Hidden page checkbox.
7. If you want to restrict access to the page with password authentication,
select the Protected page checkbox and specify a username and a password.
8. Click OK to save changes.

 To change the location or properties of a page:
1. Go to the Pages tab.
2. Select the page you want to edit.
3. Change the page position by dragging it to the right place or by clicking the
arrows.
4. Edit the page title.
5. Edit or remove the concise description of the page content that will be
displayed on search engine results pages and the keywords by which the
page will be found by search engines.
Note: Page name and Page link name are required fields. Description and Keywords are
optional fields. If you specify keywords for a page, they should be separated by commas
without white spaces.

6. If you want to make the page invisible to your website visitors, select the
Hidden page checkbox.
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7. If you want to restrict access to the page with password authentication,
select the Protected page checkbox and specify a username and a password.
8. Click OK to save changes.

 To delete a page from your website:
1. Go to the Pages tab.
2. Select the page you want to delete.
3. Click Delete page.
4. Click OK to save changes.

Adding and Removing Navigation Links
By default, a horizontal navigation bar with links to site pages is inserted below or above the
header of your site. It is automatically updated every time you add, change, move, or remove
pages from the site.
If you use sidebars on the site, then the horizontal bar under the header includes only links to
the first level pages, and the sidebars show the links of the second and third levels.
You can move navigation blocks by dragging them to other areas of the site.
For each navigation block, you can specify what levels of pages should be included in the
menu, change menu alignment (for example, show it in the middle of the page instead of the
default alignment to the left), and change the color, style, and size of the font used for the
links. To change any of these settings, place the mouse pointer over a navigation block and
click Edit.
If you occasionally remove a navigation block, you can re-insert it. To do this, go to the
Modules tab, select Navigation, and drag the block to the area on the page where you want to
add it. The navigation block will be inserted into all pages of the website.
For the convenience of your site visitors, you might also want to add breadcrumb navigation
blocks. Breadcrumb navigation is a chain of links that represents the user's path from the
site's main page to a current page. To add a breadcrumb navigation block, go to the Modules
tab, select Breadcrumbs, and drag the module to the area on the page where you want to add
it. The navigation block will be inserted into all pages of the website.
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Design: Design Templates, Layout, Styles, Color Scheme, and
Header
This section describes how to change the layout, color scheme, and header elements of the
site.

Next in this section:
Selecting a Website Design Template ............................................................... 210
Changing Your Website Layout ......................................................................... 212
Selecting Website Colors, Background Images, Fonts, and Styles for Borders and Corners
Changing the Website Header Elements ........................................................... 216
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Selecting a Website Design Template
When a new website is generated, the editor applies a random design template to the site. A
design template is a combination of website elements (banner, footer, sidebars), page layout
settings, and colors.
The editor provides a selection of 24 design templates, 16 of which are randomly generated,
and 8, created by graphic designers especially for Presence Builder.
You can review the list of design templates and select the design you like the most, or you
can individually adjust the layout and colors of website elements, as described further in this
document.
You can also prepare your own design templates and save them to ZIP archives, upload
them to the editor, and apply to websites.

Selecting and Applying a Design Template
Note: When you apply a design template, all site-wide elements and modules are overwritten
along with the content they might contain.

 To select a design template and apply it to a site:
Go to the Design tab > Templates, select the template you want, and click OK.
Randomly generated designs are listed in the Generated section, and the templates prepared
by designers, in the Special section.

Preparing a Custom Design Template
The following site elements and settings can be saved in a design template:



The website layout: the location and size of the header, footer, content areas, and
sidebars.
The banner image.



All site-wide modules.



The color scheme or individually selected colors.



The fonts.



The information about the borders and shapes of the page elements' corners.
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 To create a custom design template:
1. Adjust the layout and design, as described in Changing Your Website Layout (on
page 212) and Selecting Website Colors, Fonts, and Styles for Borders and Corners (on
page 214).
2. Add the necessary site-wide modules and a banner, as described in the
chapter Content: Text, Tables, Images, Video, Forms, and Scripts (on page
217), and in the section Changing the Website Header Elements (on page
216).
3. Save the design template: Go to the Design tab, and click Export Design.

Importing and Applying a Custom Design Template
Note: When you import and apply a design template, all site-wide elements and modules
contained on the site are overwritten along with the content they might contain.

 To upload and apply a design template:
1. Go to the Design tab, and click Import Design.
2. Select the ZIP archive containing the design template.
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Changing Your Website Layout
The layout of your site can consist of the following elements:










Header. This is the topmost area where a banner image and a company logo are usually
placed. You can do the following to the header:


Move the banner image and logo from the header area to any place on the page.



Reduce the header height to 25 pixels by removing all elements from it.



Change the header width from the default size to 100 percent, so that it is expanded
to fit the page width.

Content area. This is the main part of a webpage where most of the content is placed. You
can do the following to the content area:


Adjust the height of the content area.



Divide the content area into several columns. You can do this by dragging new
modules to the left or right edge of the content area and inserting them.



Change location of the columns in the content area by moving the content to the left
or to the right.

Sidebars. These are vertical columns that can be used for placing all kinds of modules,
site-wide and page-specific. You can do the following to sidebars:


Add one sidebar and place it to the left or to the right of the content area.



Add two sidebars. They will be placed to the left and to the right of the content area.



Adjust the height and width of the sidebars.



Move the sidebars to the top of the page and place them to the left or to the right of
the header area.



Switch places of the sidebars.

Footer. This is the lowest area where the company name, contact information, or a
copyright notice are usually placed. You can do the following to the footer:


Reduce the footer height to 25 pixels by removing all elements from it.



Change the footer width from the default size to 100 percent, so that it is expanded to
fit the page width.

Advertisement block below the footer. Depending on your hosting plan, an additional text
block containing some advertisement from your hosting provider might appear below the
website footer. If that advertisement block appears on your site, you might want to
upgrade to another hosting plan to remove it.

 To change the layout of your site:
1. Go to the Design tab > Layout tab.
2. Select the number of sidebars: Under Sidebars, select No, One, or Two.

Website Management

213

3. Select the locations of sidebars:


To move a sidebar to another side of your website, or to switch places of sidebars (if
you have two sidebars on your site), click Switch sidebars.



To move the sidebars to the top of the page, click them in the layout model.

4. Set the size of page elements:


To set the total width of the website pages, under Website width, select either of the
following:


Fixed layout: your website will be of a specific size regardless of the size of the
browser window viewing the page. In this case, specify your website width in
pixels.



Liquid layout: based on percentages of the current browser window's size. In this
case, specify your website width as a percentage of the browser window's size.



To change the width of the header, footer, and the main content area to fit the page
width, click the corresponding elements in the layout model.



Under Minimal column height in pixels, specify the height of the main content area and
each sidebar, if you have chosen to use them.
This value shows the height of your website elements without content. When you add
content to the main content area and to the sidebars, they will stretch in height to fit
the content.



To ensure that the sidebars and the content area are vertically aligned, select the
checkbox Stretch the sidebars and the content area down to the footer.



If you use one or two sidebars, under Sidebar width in pixels, specify the width of each
sidebar. The size of the main content area will be determined automatically.



Under Margin sizes in pixels, specify the size of vertical and horizontal margins. A
margin is the space between the edges of neighboring elements.

5. Click OK to save changes.
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Selecting Website Colors, Background Images, Fonts, and Styles for Borders and
Corners
The general color scheme, or styleset, of your website comprises four colors. Each color is
used for several website elements at once. You can adjust colors of individual elements on
the Design tab > Colors tab.

 To select the general color scheme for your website:
1. Go to the Design tab > Scheme tab.
2. Select the color scheme, or styleset, of your website in the menu.
You will see the four colors used in the color scheme of your website.

3. To adjust one of the colors of your website color scheme, click the respective
color field and change the hexadecimal color code value or select a color
with the color picker.
Note: These changes will override any previous changes of individual elements' colors
made on the Colors tab.

4. Click OK to save changes.

 To set colors or background images for individual website elements:
1. Go to the Design tab > Colors tab.
2. Select the website element in the Page area menu.
3. Click the arrow in the Color or image menu.
4. Do any of the following:


To fill with a solid color, leave the Solid color option selected, and select a color with
the color picker.



To fill with a gradient, select the Gradient option, and then select a pattern from the
library.



To fill with a background image, select the Image option, select a pattern from the
library or click Upload to upload your own image. Specify where it should be placed
and whether it should be tiled.

5. For an element with text, adjust font colors by clicking the respective color
field and editing the hexadecimal color code value or by selecting a color
with the color picker.
Note: Modifying the styleset on the Scheme tab will override the changes made on the
Color tab.

6. Click OK to save changes.
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 To select fonts for headings and body text of your website:
1. Go to the Design tab > Fonts tab.
2. For each font type, select the font face and size in the menus.
3. For headings, select the font decoration. You can use bold (the B icon) and
italics (the I icon).
Note: The settings made here define only general rules for your website fonts. You can
always adjust fonts of individual elements in place.

4. Click OK to save changes.

 To select the shape of corners (square or rounded) for website elements:
1. Go to the Design tab > Corners tab.
2. In the Page area menu, select the element whose corners you want to change.
3. Do any of the following:


To make rounded corners, select the corresponding checkboxes.



To make square corners, clear the corresponding checkboxes.

4. Click OK to save changes.

 To select borders for website elements:
1. Go to the Design tab > Borders tab.
2. Select the border type for elements inside your website from the Internal
containers border menu.
3. Select the elements that will have the border.
Note: You can select only one internal border type for all elements on your website, but
you can select whether this border will be used for certain elements.

4. Select the external border for your website from the External site border menu.
5. Click OK to save changes.
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Changing the Website Header Elements
The site header consists of the following elements:


Banner. You can do the following to the banner:


Upload your own banner image or a Flash file in SWF format.



Select and apply a banner from the Presence Builder library.



Remove the banner and use a background filled with a color or images.



Remove the banner and all other elements from the header area to reduce its height
to 25 pixels.



Move the banner to the content area and insert it into a specific page or into all pages
of the website.
Note: You can use only one banner per site. If you choose to insert it into a specific
page, you will not be able to add it to other pages of the website. For this reason,
we recommend that you place it into the site-wide areas.






Logo image. You can do the following to the logo:


Upload your own logo image or a Flash file in SWF format.



Move the logo from the header area to other parts of webpages, such as sidebars and
content area.



Insert any number of logo images into the site-wide areas.



Resize the logo by specifying the desired dimensions in pixels, or by dragging the
sides and corners of the image with a mouse pointer.



Remove the logo.

Site name. This usually contains a company name or a brief site description like, for
example, "John Doe's Recipes".
Site slogan. This usually includes a description of your site or a company slogan.

 To change the banner image or other elements of the header (logo, site name,
or slogan):
1. Click the banner image.
2. Select the option Use an image, and then click the image in the Image list menu.
3. Do any of the following:


To use an image from the library, select it. To find relevant images, type a keyword
into the input box.



To use your own image or a Flash file in the SWF format, click Upload, and select the
file that you want to use. Images should be in the GIF, JPEG, and PNG formats,
preferably not wider than 900 pixels.

4. If you want to scale a banner to fit the header area, select the Fit image size
checkbox.
5. Under Show banner elements, select the checkboxes corresponding to the
elements that you want to show in the header.
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6. If you want to remove a logo image or upload your own logo, click the logo
image.
7. If you want to change the site name or slogan, click the corresponding fields
on the header and change them as you want.
To make it easier to see the site name or slogan, select the Outline checkbox. This adds a
black or white outline around text, one pixel in width. If the font color in site title or slogan
is black, then the outline is white, and vice versa.
Note that you can freely move the blocks with website name, description, and logo within
the header area.
If you occasionally remove the banner, you can re-insert it.

 To remove the banner:
Click the banner, select.the option Do not use an image, and specify the height of the header
block in pixels. Click OK.

 To insert a banner:
Go to the Modules tab, select Banner, and drag the module to any of the site-wide areas on the
page where you want to add it.

 To insert a logo:
Go to the Modules tab, select Site Logo, and drag the module to any of the site-wide areas on
the page where you want to add it. You can upload a new logo image or a Flash file in the
SWF format, and align it to the left, center, or right.
You can also resize the logo image by specifying the desired dimensions in pixels, or by
dragging the sides and corners of the image with a mouse pointer.
Note: When you resize the image with a mouse pointer, the option to keep the original aspect
ratio is switched off automatically.

Content: Text, Tables, Images, Video, Forms, and Scripts
This section describes how to fill your site with content and enhance it with useful functions
provided by the editor's modules.
When adding a module to a page, you can choose whether it should be shown only on the
current page (page-specific module) or on all pages of the site (site-wide module). The only
exceptions are the Search, Advertisement, Site Logo, Navigation, and Breadcrumbs modules:
when you add them, they are placed on all pages of the website.


To place a module only on the current page, select the module under the Modules tab,
and drag it to any of the areas marked with the text ONLY ON THIS PAGE. Such areas are
located within the main content block and near the top of each sidebar.
To divide the content area into columns and insert a module into one of them, drag the
module to the left or right edge of the content area and then insert it. Note that sidebar
areas cannot be divided into columns.
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To place a module on all pages of the website, select the module under the Modules tab,
and drag it to any of the areas marked with the text ON ALL PAGES. Such areas are
located above and below the main content block, in sidebars, header, and footer.

The number of modules that you can add to a website depends on your hosting plan. The
editor will let you know when you have used the allotted number of modules: icons with the
dollar sign ($) will be shown over the module icons in the editor's toolbar.

Next in this section:
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Text, Tables, Hyperlinks, Flash Files, and Images
Before you start working on website content, we suggest that you select the appropriate
website language in Settings tab > Languages > Website language menu.
The website language is a site-wide setting that defines the language in which you will be
adding content to your website. It affects the following:


The language in which certain website elements (in particular those provided by thirdparty services), such as Google Search and navigation buttons in image galleries, will be
shown. Note that not all third-party services and modules provided by the editor support
all available languages.



The direction in which you will type text in the editor (from left to right or from right to left).
If you select a right-to-left language, your website content and design will be RTLenabled.

Note: Changing a website language does not reload the currently selected website topic in a
different language. The topic language will remain unchanged, however, the text orientation
will change.

 To add text, lists, tables, or images to a page:
1. Go to the Modules tab, select Text & Images, and drag the module to the page:


To add a block with text and images to the current page, drag the module to any of
the areas marked with the text ONLY ON THIS PAGE. Such areas are located within the
main content block and near the top of each sidebar.
To divide the content area into columns and insert a block into one of them, drag the
module to the left or right edge of the content area and then insert it. Note that sidebar
areas cannot be divided into columns.



To add a block with text and images to all pages of the site, drag the module to any of
the areas marked with the text ON ALL PAGES. Such areas are located above and
below the main content block, in sidebars, header, and footer.

2. Type the text on the screen and use the icons on the module's toolbar to
format the text, add tables, hyperlinks, and images.
The toolbar of the Text & Images module provides access to the following tools and functions.
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1. Move the text and image block within the webpage.
2. Remove the block with its contents.
3. Save changes.
4. Cancel the changes made.
5. Move the toolbar.
6. Select the paragraph style and font face. Note that the Terminal font is not supported by
Google Chrome.
7. Select the font size.
8. Select the font style: bold, italics, underlined, and strikethrough.
9. Select the text and background colors.
10. Select text alignment: left, center, right, or justified (aligned to both the left and right
margins with added extra spaces between words).
11. Increase and decrease the indent level of the paragraph.
12. Start a numbered or bulleted list.
13. Insert a table and specify the number of rows and columns.
After you insert a table, a number of additional icons become accessible from the toolbar.
Use them to change the properties of the table rows and cells, to insert and remove rows
and columns, or to split and merge table cells.
14. Insert symbols that are not on your keyboard, such as copyright and trade mark signs,
and other Unicode symbols.
15. Insert a horizontal line.
16. Edit the HTML source code of the page.
17. Undo and redo changes.
18. Insert a Flash object in the SWF format.
19. Insert an image, adjust its size, specify a description, and text wrapping.
You can choose to show the description below the image, show it over the image only
when users hover the mouse pointer over it, or to not show it. The description also serves
as alternative text: In browsers that do not support or are configured to not show images,
the description will be shown instead.
If you want to insert many pictures into a single page, consider using the Image Gallery
module instead of the Text & Images module. With Image Gallery, you can upload pictures
from your local computer or use pictures published to the Picasa Web Albums photo
sharing service. To learn more about the Image Gallery module, see the section Image
Gallery (on page 224).
If you want to add a slide show with multiple images, use the Image Slider module. To
learn more about the Image Slider module, see the section Image Slider (on page 226).
20. Insert HTML anchors into particular sections of webpages so that you can link to them
from the same or other pages of your site.
21. Remove hyperlinks from selected text.
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22. Add hyperlinks to pages of your website or external resources.
23. Add a link to an e-mail address.
To learn more about adding hyperlinks, see the section Hyperlinks, Links to E-mail
Addresses, and Anchors (on page 222).

Next in this section:
Hyperlinks, Links to E-mail Addresses, and Anchors ......................................... 222
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Hyperlinks, Links to E-mail Addresses, and Anchors

Creating Links to Other Pages
 To insert a hyperlink into text:
1. Select the text that you want to make a link.
2. On the toolbar of the Text & Images module, click the icon

.

3. Do any of the following:


To add a link to another webpage on your site, select the option A page of this site. In
the Select page menu, select the target webpage or a webpage section where you have
placed an anchor.



To add a link to a webpage or a file located on another site, select the option A
webpage or file on the Internet, and type the address. For example,
http://example.com.



To add a link to a document or another downloadable file that you have previously
uploaded through the Document Manager (as described in Documents and Other
Downloadable Files (on page 234)), select the option A document on this site, and select
the target file.

4. In the Open link in menu, select where you want to open the target page. You
can choose to open it in the same or in a new browser window or tab.
5. In the Title box, type the description that should appear when users place the
mouse pointer over the link.
6. Click OK.

Creating Links to Different Sections of a Webpage
If you have a lengthy webpage consisting of several sections, consider inserting a table of
contents with links to these sections in the top of the page, to help your site visitors navigate
through the page content. You can do this with the help of so-called anchors.

 To add links to different sections within a webpage:
1. Insert an anchor in the beginning of each section.
a. In the text block, highlight with the mouse pointer a section heading
or, if there is no heading, a first letter at the beginning of a
paragraph.
b. On the Text & Images module's toolbar, click the icon
c. Specify a name for the anchor and click OK.

.
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Anchor names should begin with a Latin alphabet letter. They can contain Latin
alphabet letters, underscore, and numbers. For example: section_1.

d. Repeat these steps to add as many anchors as needed.
2. Insert a table of contents or a list of sections in the top of the page.
3. Add hyperlinks to the table of contents or the list of sections.
a. Highlight with the mouse pointer a section name.
b. On the Text & Images module's toolbar, click the icon

.

c. Leave the option Link to a page of this site selected.
d. In the Select page menu, select the required anchor name.
e. Click OK.
f. Repeat these steps to add hyperlinks to all the sections you need.

Creating Links to E-mail Addresses
 To insert a link to an e-mail address into text:
1. Select the text that you want to make a link.
2. On the toolbar of the Text & Images module, click the icon

.

3. Specify the e-mail address and click OK.

If you want to specify multiple e-mail recipients or predefine the message subject, use the
following alternative method:

1. Select the text that you want to make a link.
2. On the toolbar of the Text & Images module, click the icon

.

3. Select the option A webpage or file on the Internet, and type
mailto:<address>. For example, mailto:postmaster@example.com.
You can also:


Specify multiple recipients in the To field, separating addresses with a comma (,)
or a semicolon (;). For example:
mailto:postmaster@example.com,mail@example.com.

Note: It is better to separate addresses with a semicolon because users of Microsoft
Office Outlook might experience issues with sending e-mail to recipient addresses
separated with commas. Microsoft Office Outlook 2003 and later versions do not
recognize a comma as an e-mail address separator, unless they are specifically
configured to do so. For details, see the article at
http://support.microsoft.com/kb/820868.


Predefine the message subject line. For example:
mailto:postmaster@example.com?subject=My%20Subject.
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Add recipients to CC and BCC lists. For example:
mailto:postmaster@example.com?subject=My%20Subject&cc=addres
s1@example.com&bcc=address2@example.com.



Predefine text to put in the message body. For example:
mailto:postmaster@example.com?subject=My%20Subject&body=This
%20is%20sent%20from%20your%20site!

Note: You should replace white spaces with %20.

4. Click OK.

Image Gallery
 To add an image gallery to your site and upload pictures:
1. Go to the Modules tab, select Image Gallery, and drag the module to the page.
2. In module settings, on the Image Storage tab, select where you want to keep
pictures:


If you do not have a Picasa Web Albums account that you would like to use, leave the
Presence Builder option selected. All images you use on your site will be kept on your
customer account.



If you have an account in Picasa Web Albums and want to use pictures that you store
there on your site, do the following:

a. Select the Picasa option, click the link on the Image Storage tab to sign
in to Google, and grant access to your albums from Presence
Builder.
b. Select the album whose pictures you want to use or click Create Album
to create a new album.
c. If you want Presence Builder to remove images from Picasa Web
Albums when you remove them from the gallery, select the checkbox
Delete images when I remove them from gallery.
When you upload images to an image gallery through the Presence Builder editor,
they are automatically copied to your Picasa Web Albums account. When you remove
images from the gallery, they are removed from Picasa Web Albums only if you have
selected the option Delete images when I remove them from gallery.

3. (Optional steps.) If you want to select the size of image thumbnails to be
shown in the image gallery, change the gallery alignment (place it to the left,
in the center, or to the right), or adjust the number of images to be displayed
per page, click the Gallery Properties tab and make the desired changes.
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The following thumbnail sizes are available:


Small (95 x 75 pixels).



Normal (140 x 130 pixels). This is the default setting.



Large (170 x 170 pixels).

4. To add images to the gallery, on the Image Storage tab, click the text Click here
to upload your images, select the images that you want to upload, and click OK.
You can select and upload multiple images at once. Only images in GIF, JPEG, and PNG
formats are supported.
We recommend that you use resized images that do not exceed 1024 x 768 pixels.

5. To change image title and description, click the corresponding thumbnail,
click the title or description, and edit the text.
If you delete the default text entirely, it will not be shown on your published site; however,
it will still be shown when you edit the site in the Presence Builder editor.

6. To rearrange images in the gallery, drag them to the desired location.

 To remove an image from the gallery:
Place the mouse pointer over the image thumbnail and click the icon [x].

 To remove an image gallery with all pictures:
Place the mouse pointer over the image gallery block and click Remove.
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Image Slider
The Image Slider module enables you to add a slide show with multiple images and various
transition effects. The following image formats are supported: GIF, JPEG, and PNG.
Images are not resized automatically; for this reason, we recommend that you upload images
of the same dimensions. Otherwise, the slide show will not look good.
When adding images, you can add descriptions to them and link the images to specific
pages of your website.
The following transition effects are supported:


Random



Slice down and to the right



Slice down and to the left



Slice up and to the right



Slice up and to the left




Slice up and down
Slice up and down and to the left



Fold



Fade




Box random
Box rain



Reverse box rain




Growing box rain
Reverse growing box rain

The effect names might tell you little about how the effects look, so it is better to see them in
action. To do this, add the Image Slider module, upload at least two images, go to the
module settings (Settings tab), and select an effect from the Transition effect menu.

 To add Image Slider to your site and upload pictures:
1. Go to the Modules tab, select Image Slider, and drag the module to the page.
2. Click Add Images, select the images that you want to upload, and click OK.
You can select and upload multiple images at once. We recommend that you use resized
images that do not exceed 1024 x 768 pixels.
Once you have uploaded images, you can arrange them in the desired order, and remove
them. To do any of these actions, place the mouse pointer over an image thumbnail, and
use the corresponding icons:

.

3. To add an image description, select a thumbnail, and type the text into the
Description box.
4. To add a link to a webpage, select a thumbnail, select the option Link to a
webpage, and select the page from the menu below.
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5. Click the Settings tab and select the desired transition effect from the Transition
effect menu.
6. Specify how long each image must be shown.
7. Specify whether the round navigation icons for switching between slides
must be shown.
The option Inside will show the icons over the images, in the upper right corner of Image
Slider, and Below will show the icons below the images.

8. Specify whether the navigation arrows for switching between slides must be
shown.
9. Click OK.

 To remove an image from the slide show:
Click on the slide show block, place the mouse pointer over the image thumbnail, and click
the icon

.

 To remove a slide show with all pictures:
Place the mouse pointer over the slide show block and click Remove.
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Embedded Video
You can embed into website pages video clips located on popular video sharing sites, such
as YouTube (youtube.com), Vimeo (vimeo.com), MySpace (myspace.com), and Dailymotion
(dailymotion.com).

 To insert a video into a webpage:
1. Go to the Modules tab, select Embedded Video, and drag the module to the
page.
2. Insert a link to the video or select the option Embed code if you have obtained
a code from a file sharing site, and then paste the code.
3. Click OK.

 To remove a video:
Place the mouse pointer over the video and click Remove.

Contact Form
If you want your site visitors to be able to send you messages from your site, you can add a
contact form.

 To add a contact form:
1. Go to the Modules tab, select Contact Form, and drag the module to the page.
2. On the Settings tab, specify the following:


Recipient's e-mail address. You can specify several e-mail addresses separating
them with commas (,) or semicolons (;).



Message subject.



Text to be shown on the button that sends the message.



Protection from automated spam postings. Leave the checkbox Enable the protection
from automated spam postings selected if you want to avoid receiving spam sent by
scripts or spam bots through the contact form.
The protection is based on a highly efficient mechanism, called reCAPTCHA. In the
contact form, it is shown as an input box accompanied by a combination of distorted
words or symbols that can be recognized only by humans. Before a message can be
sent through the contact form, a user is prompted to recognize the symbols and type
them in.

3. If you want to add, move, or remove input fields from the form, or change
their labels, click the Fields tab, and make the required changes.
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4. If you want to change the default message "Your message was sent. Thank
you." which is shown when a message is sent, click the Reply tab and type
the new text.
5. Click OK.

 To remove a contact form:
Place the mouse pointer over the form and click Remove.

Blog
If you want to maintain an online diary on your site, or regularly publish articles on a subject
and automatically present them in a chronological order, then you need a blog.
A blog module can be added only to the first-level pages that do not have subpages. Within
blog posts, you can use text, images, embedded videos and scripts. Each blog post can
have its distinctive page description and meta information to be used by search engines.
Note that blog posts are not listed on the Pages tab (on page 207).
To let your visitors comment on your blog posts, you need to register with Disqus, a free
third-party service that provides commenting functions for your sites and keeps all
comments.

 To add a blog to your webpage:
1. Go to the Modules tab, select Blog, and drag the module to the page.
2. In the module properties, specify the following:


Number of blog posts to show on the page.



Specify whether the site visitors will be able to leave their comments.

3. Click OK.
4. To enable commenting, click the link Click here to add a new blog post.
5. Click within the gray information box at the bottom of the blank blog post.
6. To register with Disqus, click the Register button. A registration form will open
in a new browser window or tab.
7. Specify the following:


Your site's URL, desired name and shortname (unique ID). You will need to specify
this site ID (shortname) later in the Blog module settings to enable commenting.



Comment moderator's username, password, and e-mail address. A confirmation
message will be sent to this e-mail address, so be sure that it is valid.

8. Click Continue.
9. Specify your language and other settings, and click Continue.
10. On the last step of the registration form, no further action is required. Just
log out of the Disqus site.
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11. Check your e-mail inbox for the confirmation message from Disqus. In this
message, click the link to verify your address.
12. Return to the browser window where you have the Presence Builder editor
with the Blog module properties opened.
13. In the box titled Apply here the website ID (shortname) received during registration, type
or paste the site ID that you specified during registration with Disqus in step
7.
14. Click Apply.
15. Click OK.
Now your blog can accept comments from visitors, and you can make the first post.

 To add a blog post:
1. Go to the website page containing a blog module.
2. Click the link Click here to add a new blog post (might also appear as New Post
Title).
3. Type the post title and content.
If you want to change the date of posting, click within the field Posted dd.mm.yy and then
select a date from the calendar.
If your post is lengthy and contains numerous text blocks, images, and embedded videos,
you might want to show only a portion (beginning of the post) to site visitors in your blog's
main page. To do this, while editing a blog post, move the divider element (containing the
line -------- Drag this above modules that should not appear in the list of posts --------) to the desired
area.

4. Click OK.
5. If you want to view, edit, or remove a concise description of the page that will
be displayed on search engines results pages and the keywords by which
the page will be found by search engines, click in a blank area to the right of
the post title, and then click the SEO Settings tab.
Note: Post link name is a required field. Meta description and Meta keywords are optional
fields. If you specify keywords for a page, they should be separated by commas without
white spaces.

6. To return to the blog's main page, click the Back link below the post you have
just created.

 To remove a blog post:
1. Go to the website page containing a blog module.
2. Place the mouse pointer over the post title and click Remove.
3. Click Yes to confirm removal.
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 To edit a blog post:
1. Go to the website page containing a blog module.
2. Click the post title.
3. Make the required changes and click OK.

 To remove a blog with all posted content:
1. Go to the website page containing a blog module.
2. Place the mouse pointer over the link Click here to add a new blog post and click
Remove.
3. Click Yes to confirm removal.
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Commenting
If you want to let your site visitors leave comments on webpages, you need to insert the
Commenting module into those webpages.
The commenting functionality is powered by Disqus, a third-party service that stores and
processes all comments. Before your visitors can leave comments, you need to register an
account with Disqus and then specify a site ID in the Commenting module settings.
You can insert several Commenting modules into a single website. Because all Commenting
modules on the site will use the same site ID, you will only need to specify the site ID once in
the module settings, when inserting the first Commenting module.

 To add commenting functions to a webpage:
1. Go to the Modules tab, select Commenting, and drag the module to the page.
2. If you have not registered an account with Disqus yet, click the Register
button. A registration form will open in a new browser window or tab.
3. Specify the following:


Your site's URL, desired name and shortname (unique ID). You will need to specify
this site ID (shortname) later in the Commenting module settings to enable
commenting.



Comment moderator's username, password, and e-mail address. A confirmation
message will be sent to this e-mail address, so be sure that it is valid.

4. Click Continue.
5. Specify your language and other settings, and click Continue.
6. On the last step of the registration form, no further action is required. Just
log out of the Disqus site.
7. Check your e-mail inbox for the confirmation message from Disqus. In this
message, click the link to verify your address.
8. Return to the browser window where you have the Presence Builder editor
with the Commenting module properties opened.
9. In the box titled Apply here the website ID (shortname) received during registration, type
or paste the site ID that you specified during registration with Disqus in step
3.
10. Click Apply.
11. Click OK.
Now you can publish your website to the customer account and start receiving comments
from your visitors.
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In addition to adding and viewing comments, you can do the following:


Edit comments.




Delete comments.
Mark comments as spam.



Ban users (by e-mail or IP address) from posting comments on your site.



Change the settings, such as appearance of comments, and remove the trackback URL.
You can do this by logging in to your account at www.disqus.com, and going to the
Settings tab.

 To moderate comments:
1. Log in to Disqus as the site administrator. You can do this in either of the
following ways:


Visit the Disqus site at www.disqus.com and log in there.



In the Presence Builder editor, go to the page where you have the Commenting
module and click inside the Add New Comment field. Click the Post as button, click the
Disqus link in the left navigation pane, type your username and password, and click
Login.

2. After you are logged in to Disqus, you can moderate comments in either of
the following ways:


On the Disqus site, use the items in the Dashboard and Admin areas.



In the Presence Builder editor or on the published site, go to the page where you have
the Commenting module, place the mouse pointer over the comment you want to
moderate, and use the Moderate link that will appear next to the comment.

Alternately, you can moderate comments by using links in the notification messages that
Disqus sends you when someone leaves a comment on your site.

 To remove commenting functions from a webpage:
1. In the Presence Builder editor, go to the website page containing the
Commenting module.
2. Place the mouse pointer over the Add New Comment field and click Remove.
3. Click Yes to confirm removal.
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Documents and Other Downloadable Files
The editor now provides a convenient control panel for working with files in your customer
account. You can upload your documents, images, and other files in various formats to the
editor (on the Documents tab), and then insert links to them in your website pages.
Alternatively, you can just keep them in your customer account for your own needs.

 To upload a file to the customer account:
1. Go to the Documents tab.
2. Click Upload.
3. Select the file and click Open.
Now, to let your site visitors download this file, you can insert a link to it in a webpage.

 To insert a link to file:
1. Select the text that you want to make into a link.
2. On the Text & Images module's toolbar, click the icon
3. Select the option A document on this site.
4. Select your file and click OK.

 To remove a file from the customer account:
1. Go to the Documents tab.
2. Select the file and click Remove.
3. Confirm removal and click OK.

.
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Buttons for Sharing on Social Networks
If you want to let your visitors easily share your content on social networks or online
bookmarking services, you can insert a toolbar with buttons for sharing on Facebook, Twitter,
Myspace, and other popular services.

 To add the Share on Social Media toolbar to a webpage:
1. Go to the Modules tab, select Social Sharing, and drag the module to the page.
2. Select the appearance of the toolbar.
3. If you want to modify the list of social networks and sharing services shown
on the toolbar, place the mouse pointer over the icon [+] and click the Settings
link.
The changes you make to the list of services will be visible after you publish the site.

4. Click OK.
Note: When someone shares your content on Twitter by using the Tweet button, the counter
of tweets is not increased immediately. It can take several hours for the counter to update.

 To remove the Social Media toolbar:
Place the mouse pointer over the toolbar and click Remove.

Site Search
If you want to let your visitors search for information on your website, you can add a search
bar to the site. After inserting the search bar into a webpage, it is automatically added to all
pages of the site.
By default, the search bar is configured to use the Google search engine. If you want to use
another search engine, you can obtain the search script code and insert it into the Search
module.

 To add a search bar to the site:
1. Go to the Modules tab, select Search, and drag the module to the page.
2. Do any of the following:


If you want to use the search service provided by Google, leave the Google option
selected.



If you want to use another search engine, select Other and paste the code that you
have obtained from that service.
Make sure that the code you insert is correct, as Presence Builder does not validate it.

3. Click OK.
The search bar will appear on your site after publishing.
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 To remove a search bar:
Place the mouse pointer over the search bar and click Remove.

Online Store
If you want to sell products or services through your site, you can use the Online Store and
Shopping Cart modules to add a fully functional online store to the site. You can add only one
store per site.
The store functionality is provided by Ecwid - a third-party SaaS solutions provider that
securely stores and processes all your data, including product catalogs, images, orders, and
customers' payments.

 To add an online store to your site:
1. Go to the Modules tab, select Online Store, and drag the module to the page.
2. Create an account with Ecwid if you do not have one yet, or specify the ID of
an existing store if you have previously created a store at Ecwid through
Presence Builder and want to show it on your site.
If you do not have an account with Ecwid yet, do the following:

a. In module settings, on the General tab, select the option Register with
Ecwid.
b. Type your name, e-mail address, and password. You will use the email address and password to sign in to Ecwid and manage your
store.
c. Click Send. A confirmation message from Ecwid will be sent to your email address. You will need to confirm that you own this e-mail
address within three days, otherwise the online store will be
deactivated.
If you already have an account with Ecwid, select the option Enter an ID of an existing shop,
specify the store ID and e-mail address that you specified during account registration,
and click Apply.
Note: If the online store was created directly at the Ecwid website without using Presence
Builder, you can do the following: Create a new Ecwid account through Presence Builder,
log in to the previously existing Ecwid account, export all the goods to a CSV file. After
that, log in to the new account and import the file.

3. (Optional step.) If you want to let your customers add items to the cart by
dragging them to a shopping bag icon, go to the Modules tab, select the
Shopping Cart module, and drag it to the page.
Note that the shopping bag icon will be inserted into all pages of your site. If you do not
want that, do not use the Shopping Cart module. Your customers will still be able to add
items to the cart and proceed to checkout by using the Shopping Bag link that appears at
the top of the product catalog area.
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4. (Optional step.) If you want to change the appearance of the product catalog,
in module settings, go to the View tab.
5. To set up your store, fill the product catalog with items, and remove the
default fruit and vegetable items added by Ecwid, click the Manage link on the
module's toolbar.
The Ecwid control panel will open in a new browser window or tab.

6. After you have finished setting up the store in the Ecwid control panel, return
to the Presence Builder editor and click the Reload link on the Online Store
module's toolbar.
You must use the Reload link to synchronize the content of your online store with online
store at Ecwid.

7. Click OK to finish setting up the store.

 To manage a store:
Place the mouse pointer over the product catalog and click Manage. The Ecwid control panel
will open in a new browser window or tab.
Note: After publishing your site, you can also view information about new orders on the
Dashboard (on page 250).

 To remove a store:
Place the mouse pointer over the product catalog and click Remove.

Map
With the Map module, you can easily add a map with your location to a website. Maps are
provided by the Google Maps service, which is available free of charge.
The following functions are supported:


Searching for an object on a map by address or by latitude and longitude coordinates.



Selecting the mode of map display by switching between Map, Satellite, Satellite with labels,
and Terrain views.



Adjustment of the map scale: zoom in or out on House, Street, or Town.

When you add a map, the module uses the information about your location that you specified
after selecting a website topic. You can specify a new location at any time.

 To add a map to your site:
1. Go to the Modules tab, select Map, and drag the module to the page.
2. Specify the desired location and click Search. You can type an address or
coordinates. For example: 37.754481,-122.383772.
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3. Select the desired map view from the Map mode menu, and the zoom level
from the Zoom level menu. To show your organization's location on the map,
you might want to choose the Map option and the Street zoom level.
4. Select the desired map size from the Map size menu.
5. Click OK.

 To remove a map:
Place the mouse pointer over the map and click Remove.
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Custom Scripts
You can insert custom scripts written in PHP, JavaScript, or VBScript in any page of your
website.

 To insert a script in a webpage:
1. Go to the Modules tab, select Script, and drag the module to the page.
2. Paste the code into the input field.
For PHP, use the opening tag <?php. Make sure the code you insert into this field is
correct, as Presence Builder does not validate it.

3. Click OK.
Your code will be active only on the published website.

 To remove a script:
Place the mouse pointer over the script block and click Remove.

Advertisements
If you are participating in a banner exchange or other online advertising programs, you might
want to add an advertisement block to your site. After inserting the block in a webpage, it will
be automatically added to all pages of your site.

 To add an advertisement block:
1. Go to the Modules tab, select Advertisement, and drag the module to the page.
2. Paste the code provided by your advertising vendor into the input field.
Make sure that the code you insert into this field is correct, as Presence Builder does not
validate it. With some advertising vendors, you will need to validate your account first.

3. Click OK.
Advertisements will appear on your website after publishing.

 To remove an advertising block:
Place the mouse pointer over the block and click Remove.
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Settings and Tools for Webmasters
This section describes how to do the following:


Change website name, description, and keywords.



Upload a site icon (favicon) for your website.



Make your website more visible in search results, and embed various search engine
services.



Prevent certain pages or areas of your website from being indexed by search engines
and shown in search results.



Notify site visitors about the use of non-essential cookies on your site. This might be of
interest only to webmasters residing in the European Union.

Changing Website Name, Description, and Keywords
Website name is a line of text that is shown in the title bar of a user's browser when they visit
your website. By default, it is "My website", but you can change it to anything you want.
Website description is shown by search engines when your website is listed in search
results. Website keywords are analyzed by search engines and are used for displaying your
website when people search for these keywords.
You can specify the site description and keywords that the editor will use for all pages of your
website (in Settings tab > Basic), and specify custom values for specific pages (in Pages tab >
page name > Edit page description and keywords).

 To edit your website name, description, and keywords:
1. Go to the Settings tab > Basic tab.
2. Specify the website name that your visitors will see as the title of their
browser window when they visit your website.
3. To show both your website name and the current page name in the browser
title window and to increase your website recognition in search engine
results, select the Add website name to page titles checkbox.
4. Add short description (up to 255 symbols) of your website.
5. Provide a list of keywords that describe your website (10-15 keywords are
recommended).
The description and keywords will be used by default for new and existing pages.

6. Click OK to save changes.
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Uploading a Site Icon (Favicon)
A favicon is a small icon displayed in the browser’s address bar when you visit a website,
and also appears next to the website name in the list of favorite bookmarks. You can create
a favicon using a variety of online tools and then upload your favicon through the Presence
Builder editor. All your website visitors will see this favicon.

 To upload a favicon for your website:
1. Go to the Settings tab > Basic tab.
2. Click Browse and select the location of the favicon to upload. The favicon will
be uploaded.
3. Click OK to save changes.

 To remove a favicon from your website:
1. Go to the Settings tab > Basic tab.
2. Click Remove in the Favicon section. The favicon will be removed.
3. Click OK to save changes.

Verifying Website Ownership
Most search engines require you to verify website ownership when you register your website
or sign up for webmaster assistance services. Verification is typically done by uploading or
creating a file with a specific file name.

 To verify website ownership:
1. Go to the Settings tab > Advanced tab.
2. Provide the verification file:


If you know the name of the verification file requested by a search engine, provide the
verification file name in the Create verification file field and click OK. Presence Builder
will create it in the correct place.



If you have already downloaded your verification file from a search engine, upload the
verification file to the Upload verification file field and click OK.

3. After the verification file is created or uploaded and your website is
published, confirm your ownership on the search engine website.
4. Click OK to save changes.
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 To edit the HTML <head> section of your website (for example, to add
ownership verification meta code):
1. Go to the Settings tab of the Presence Builder's main menu, then go to the
Advanced subtab.
2. Click Edit Metadata.
3. Insert the code into the provided field and click Add.
Note: Only valid HTML tags permitted for <head> section by HTML standards are
supported. Metadata changes will be available only after you publish your website.

4. Click OK to save changes.

Embedding Google Analytics Code
Google Analytics is a tool that allows you to obtain information about your visitors. After you
register with Google Analytics and acquire the required code, you can embed Google
Analytics on your website.

 To embed Google Analytics:
1. Register with the Google Analytics service and acquire the code.
2. Go to the Settings tab > Advanced tab.
3. Click Embed Google Analytics.
4. Insert the code you have received from Google Analytics into the provided
field and click Add.
Note: Google Analytics will start working only after you publish your website.

5. Click OK to save changes.

Downloading the Sitemap
Some search engines will ask you to provide your sitemap for analysis and optimization
purposes. You can download your sitemap from the Presence Builder editor.

 To download your website sitemap:
1. Go to the Settings tab > Advanced tab.
2. Click Download Sitemap.
3. Click OK to start downloading the sitemap.xml file.
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Preventing Search Engines from Indexing Certain Pages of Your Site
To prevent search engines from indexing certain pages of your website, you can add the
appropriate directives into the robots.txt file. This file is stored on the customer account
to which your site is published.

 To prevent search engines from indexing certain areas of your website:
1. Go to the Settings tab > Advanced tab.
2. Click the link Edit robots.txt.
3. Type your directives into the input field. Place each directive on a new line.
For example, to prevent all search engine robots and crawlers from indexing the contents
of the directory /private and the file /my_secret.html on your customer account,
add the following lines:
User-agent: *
Disallow: /private/
Disallow: /my_secret.html
For more information about the robots.txt file and directives you can use, refer to
http://www.robotstxt.org/robotstxt.html.

Notifying Site Visitors About the Cookie Policy
If you are located in the European Union, your site must inform its visitors about the use of
non-essential cookies and obtain informed consent.
Cookies are small files that web servers save on visitors' computers. Cookies may be used
for a number of purposes, from remembering personal preferences to tracking users'
behavior for presenting targeted advertisements. Non-essential cookies are those that are
not required for websites to function properly. Examples of non-essential cookies include
those from analytics, advertising, and affiliate networks such as Google Analytics and Google
AdSense.
Most likely, your site uses non-essential cookies if it uses the following functions:


Google Analytics



Publishing to Facebook



Embedded video




Image gallery module (with Picasa selected as storage)
Online store module



Map module



Commenting module



Social sharing module



Script module



Site search
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If you choose to show a notice on the site, its visitors will be prompted to confirm that they
accept your policy.

If they accept it, the notice is no longer shown (the icon
is shown instead in the
page corner), and they can continue browsing your site. If they do not accept it, they are
taken to google.com.

 To show a cookie notice on the site:
1. Go to the Settings tab > Advanced tab.
2. Click the link Notify Site Visitors About the Cookie Policy.
3. Select the checkbox Show the cookie notice on the site and click OK.
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Saving and Loading Copies of a Website
While working on the content and design of a website, you can save several copies of each
site to the server and restore sites from the saved copies (also referred to as snapshots).
Saving site copies can be useful in the following cases:


You want to prepare several versions of the same website, so that you can later load
them for review, choose the best designed or the most appropriate version, and publish it
to the Internet.



You want to make significant changes or experiment on the site design or content, but be
sure that you can safely undo the changes should anything go wrong.

Note: Pictures from the Image Gallery modules are not saved in snapshots. Images are stored
on your customer account or Picasa Web Albums (if you use that option).

 To save the current design and content of a site:
1. In the Presence Builder editor's main menu, click the icon
option.

next to the Save

Note: If you click Save, a quick-save site copy will be saved under the name auto-saved
snapshot. You will be able to restore a site from this copy later, by clicking Revert in the
main menu.

2. In the list that opens, select a free saving slot, type a name for the backup
copy, and click Save.

 To restore a site from a saved copy:
1. In the Presence Builder editor's main menu, click the icon
Revert option.

next to the

Note: If you click Revert, a site will be restored from the quick-save copy that was made
the last time you clicked Save.

2. In the list that opens, select a site copy and click Load.
3. Click Yes to confirm you want to restore.

 To download a site copy:
1. In the Presence Builder editor's main menu, click the icon
option.
2. Locate the copy that you want to download and click the

next to the Save
(Download) icon.

3. Select the directory on your computer where you want to save the file and
click OK.
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 To upload a site copy:
1. In the Presence Builder editor's main menu, click the icon
Revert option.
2. Click the
copy.

next to the

(Upload) icon next to the slot to which you want to upload the

3. Browse to the site snapshot file in the SSB format and select it.
4. If you want to restore a site from the uploaded snapshot, select it and click
Load.

 To remove a site copy:
1. In the Presence Builder editor's main menu, click the icon
option.

next to the Save

2. Locate the site copy that you want to remove and click the corresponding
(Remove) icon.
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Publishing a Website to the Internet
When your website design and content are ready to be published to the Internet, click Publish
in the top right corner of the main menu. Presence Builder will publish your website
automatically to the location specified by your hosting provider.
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Publishing a Website Copy to Facebook
After publishing a site on the Internet, you can drive more visitors to it by publishing a site
copy to the popular social network site - Facebook (www.facebook.com).
A site copy on Facebook will show most of the content from your site; however, the following
changes will be applied to its design, layout, and functionality:


Headers, sidebars, and footers will not be shown.



The navigation menu will be shown only at the top of the site pages.



Page width will be limited to 520 pixels. For pages wider than 520 pixels, a horizontal
scrollbar will be shown.



The font face, size, and color will be changed to comply with the Facebook design,
unless these font properties were specifically selected by the site owner in the Presence
Builder editor.



Image galleries, online store, and links for sharing on social media sites will not be
shown.
Any links pointing to other pages on Facebook will not work.



 If you want to add a site copy to Facebook, do the following:
1. In the main menu, click the Settings tab > Social Media tab.
2. Leave the checkbox Show a copy of my site on Facebook selected.
3. Click the link Add your site copy to Facebook. The Facebook home page opens in
a new browser window or tab.
4. To log in to your Facebook account, type your e-mail address and password,
and click Log In.
5. If you do not have a Facebook page where you want to show a site copy,
create one. To do this, click Create It Now, and follow the onscreen guidelines.
After your page is created, return to the Parallels Presence Builder at Facebook
page, which is shown in another browser window or tab.
6. Click Add Parallels Presence Builder Application. This application provides
synchronization between the website on your hosting account and its copy
on Facebook.
7. To confirm that you want to add the application to your page, click Add
Parallels Presence Builder.
Now your site copy is added. To see it, click the Website link in the Facebook navigation pane
on your left.
Whenever you make changes to your site and republish it through the Presence Builder
editor, your site copy on Facebook will be updated accordingly.
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 To remove a site copy from Facebook, do the following:
1. In the Presence Builder editor's main menu, click the Settings tab > Social
Media tab.
2. Clear the checkbox Show a copy of my site on Facebook.
3. Click Yes to confirm.
4. Go to your Facebook page and remove the Presence Builder application
from there.
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Viewing Site Visits Statistics, Comments, and New Orders
on the Dashboard
After publishing a site, you can access the Dashboard from the Presence Builder's main
menu to perform the following tasks:


View statistics on website visits. The statistics are provided by Google Analytics and are
available after you specify the code for Google Analytics in website settings, as described
in the section Settings and Tools for Webmasters (on page 240).



View new comments left by site visitors on your website pages. The comments are visible
on the Dashboard after you set up the commenting functionality, as described in the
sections Blog (on page 229) and Commenting (on page 232).



View new orders from customers visiting your online stores. The new orders are visible
on the Dashboard after you set up an online store, as described in the section Online
Store (on page 236).

 To view website visits statistics:
1. On the main menu, click Dashboard.
2. If you access the dashboard for the first time, confirm association of your site
with your Google Account:
a. Click Log In to Google Analytics.
b. Log in to your Google Account.
c. Confirm that you want to allow access to your account.
3. Under the Website Visits Statistics chart, click the link See more charts, or click the
icon.
The Overview section shows the following statistics for the past 30 days:


A detailed chart for the metric currently selected under Profile report.



The total number of visits during the past 30 days.



The number of new visits.



Average time spent on a site by users.



The total number of page views.



The number of page views per each visit.



The percentage of new visits.

The Traffic sources overview section shows the addresses of websites from which your
visitors were coming during the past 30 days. The (direct) item shows the percentage of
visitors who accessed your site by typing its address directly in their browsers.
The Visitors' locations section shows the geographic locations of the visitors for the past 30
days.
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 To view comments from your site visitors:
1. On the main menu, click Dashboard.
2. Under Comments, click the link See them, or click the

icon.

3. To go to the webpage where the comment was left, click Link to the comment.
4. To go to the Disqus site for moderating the comments, click Manage Comments.

 To view orders submitted by the customers visiting your online stores:
1. On the main menu, click Dashboard.
2. Under Orders, click the link See them, or click the
Orders tab.

icon, and then click the

3. To go to the Ecwid site for processing the orders, click Manage Orders.
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Deleting Websites
When you delete a site from the Presence Builder editor, only the current site draft opened in
the editor and saved site copies (snapshots) are removed.
By default, the site copy published to your hosting account is not removed. However, this
policy might be changed by your hosting provider.

 To delete a current site copy from the editor:
In the Presence Builder editor's main menu, select More > Remove Site.

FTP Access to Your Websites
All files and directories related to your sites are kept on the server in a single directory,
commonly referred to as webspace. To connect to the webspace over FTP for uploading,
downloading, and deleting files, you use FTP account username and password.

Next in this section:
Changing FTP Access Credentials .................................................................... 252
Adding FTP Accounts ........................................................................................ 253
Setting Up Anonymous FTP Access .................................................................. 255

Changing FTP Access Credentials
 To change FTP account username or password:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the webspace where the website is hosted.
2. Click the Websites & Domains tab.
3. Click Web Hosting Access.
4. Type a new username or password.
5. Click OK.

Website Management

253

Adding FTP Accounts
If you are working on your website together with someone else or host subdomains for other
users, you might want to create separate FTP accounts for them.

 To create an additional FTP account:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab.
3. Click FTP Access.
4. On the Additional FTP Accounts tab, click Create Additional FTP Account.
5. Specify the following:


FTP account name. Type an arbitrary name.



Home directory. Select the directory to which the user will be taken when he or she
connects to the FTP account.



FTP password.



Hard disk quota (on Windows hosting). To limit the amount of disk space on the server
that the FTP user can occupy, clear the Unlimited checkbox next to the Hard disk quota
box, and type the amount of disk space in megabytes.



Read permission (on Windows hosting). To allow the FTP user to view the contents of
the home directory and download files from it, select the Read permission checkbox.



Write permission (on Windows hosting). To allow the FTP user to create, view, rename
and delete directories in the home directory, select the Write permission checkbox.
On Window hosting, if you do not grant any permissions, a connection to the FTP
account will be made, but the contents of the home directory will not be shown to the
user.

6. Click OK.

 To change the properties of an additional FTP account:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab.
3. Click FTP Access.
4. On the Additional FTP Accounts tab, click the required FTP account name in the
list.
5. Make the required changes and click OK.
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 To remove an additional FTP account:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab.
3. Click FTP Access.
4. On the Additional FTP Accounts tab, select the checkbox corresponding to the
FTP account you want to remove and click Remove.
5. Confirm removal and click OK.
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Setting Up Anonymous FTP Access
If your site is hosted on a dedicated IP address (not shared by other users or sites), you can
set up a directory within the site, where other users will be able to anonymously download or
upload files through FTP. Once anonymous FTP is switched on, the users will be able to log
in to the directory at an address like ftp://ftp.your-domain.com with the "anonymous"
username and any password.

 To allow anonymous FTP access:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab.
3. Click FTP Access.
4. Click the Anonymous FTP tab.
5. Do the following:
a. To activate anonymous FTP service, click Switch On.
b. To set up a welcoming message to be displayed when users log in to
FTP site, select the Display login message checkbox and type the
message text in the input field as desired.
Note that not all FTP clients display welcoming messages.

c. To allow visitors to upload files to the /incoming directory, select
the Allow uploading to incoming directory checkbox.
d. To allow users to create subdirectories in the /incoming directory,
select the Allow creation of directories in the incoming directory checkbox.
e. To allow downloading files from the /incoming directory, select the
Allow downloading from the incoming directory checkbox.
f. To limit the amount of disk space that can be occupied by uploaded
files, clear the Unlimited checkbox corresponding to the Limit disk space
in the incoming directory option, and specify the amount in kilobytes.
This is the hard quota: The users will not be able to add more files to the directory
when the limit is reached.

g. To limit the number of simultaneous connections to the anonymous
FTP server, clear the Unlimited checkbox corresponding to the Limit
number of simultaneous connections option and specify the number of
allowed connections.
h. To limit the bandwidth for anonymous FTP connections, clear the
Unlimited checkbox corresponding to the Limit download bandwidth for this
virtual FTP domain option and enter the maximum bandwidth in
kilobytes per second.
6. Click OK.
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 To change settings for anonymous FTP service or switch it off:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Click the Websites & Domains tab.
3. Click FTP Access.
4. Click the Anonymous FTP tab.
5. Perform the operation you need:


Adjust the settings as required and click OK.



To switch off the anonymous FTP service, click Switch Off.

Mail Accounts
You can create and remove mail accounts right from the Control Panel, set up mail
forwarding, protection from spam and viruses, and so on.
Panel allows you to configure mail services on two levels:


Configuring mail account settings. These settings affect mail account only. For example,
where to forward received messages or what to do with potential spam. Learn more about
possible operations on mail accounts in the section Configuring Mail Account (on page 258).



Configuring global mail settings. These are subscription-wide settings that affect all
mailboxes within a subscription. For example, which webmail system Panel should use,
or what to do with mail sent to nonexistent users. These settings may be unavailable in
your hosting plan. To get the details on how to change global mail settings, refer to the
section (Advanced) Configuring Global Mail Settings (on page 265).

If you want to use some of your e-mail addresses to distribute news and promotions, or set
up group discussions, consider setting up mailing lists. These are e-mail addresses to which
a number of users are subscribed. Learn more in the section Using Mailing Lists (on page
266).

Next in this section:
Adding Mail Accounts ........................................................................................ 257
Configuring Mail Account ................................................................................... 258
(Advanced) Configuring Global Mail Settings .................................................... 265
Using Mailing Lists ............................................................................................ 266
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Adding Mail Accounts
 To create an e-mail address:
1. Run the Create E-mail Address wizard from the Mail tab of the Control Panel.
2. Specify the following mailbox settings:


E-mail address. Type the left part of the e-mail address before the @ sign, and, if you
have several domain names on your account, select the domain name under which
the e-mail address will be created.



Access to the Control Panel. Select this option if you want Panel to create an auxiliary
user for the mail account owner. By default, this user has the role Application user.
However, you can change this role and other user's properties later. For details, see
the section (Advanced) Managing Auxiliary User Accounts (on page 101).



Password. Set the password for accessing the mailbox. If you leave the option Access
to the Control Panel selected, the same password will be used for logging the user in to
to the Control Panel.



Mailbox. Turning off this option makes sense only if you want to use this address as a
mail forwarder, which will forward all incoming mail to another address.



Mailbox size. If you leave the option Mailbox selected, specify the mailbox size or use
the default size defined by the provider's policy or your service plan.
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Configuring Mail Account
If the provider's policy allows setting up mail accounts and services , then you can set up and
use multiple email services services located on the following tabs of the mail account page:


General. General mail account properties, such as its address, password and size.



Forwarding. Email forwarding service that will send copies of all incoming messages to
another email address.



Email Aliases. Additional email addresses that are associated with a user's primary (or
main) email address. Email aliases can be used as temporary disposable addresses that
can be published on the Internet. When spam starts coming to an address that was set
up as an email alias, you can remove that alias and create another one.



Auto-Reply. Automatic response service that sends a predefined email message in reply to
any incoming message. This is useful for sending "out of office" or "on vacation" notices
when you are away.



Spam Filter. Checking all incoming messages by antispam filter. In addition, you can
specify what to do with messages identified as spam: Remove them, move to a special
folder, or just add some text to the message subject.
Antivirus. Checking all incoming and outgoing mail for viruses.




Additional Services. If you use web apps that provide email-related services, for example,
antispam or webmail, you can define if each of these services is able to access this mail
account.

Next in this section, we will provide instructions on how to configure these services for mail
accounts.

Next in this section:
Setting Up Mail Forwarding ............................................................................... 259
Creating Mail Aliases ......................................................................................... 259
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Protecting from Spam ........................................................................................ 260
Protecting from Viruses ..................................................................................... 263
Additional Services ............................................................................................ 264
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Setting Up Mail Forwarding
 To set up e-mail forwarding for an e-mail address:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > Forwarding tab.
3. Select the Switch on mail forwarding checkbox.
4. Specify one or several e-mail addresses to which e-mail must be forwarded.
When specifying e-mail addresses, separate them with white spaces,
commas, semicolons, or type each of them on a new line.
5. Click OK.
6. If you do not want to keep copies of forwarded messages in the mailbox, go
to the Mail tab > e-mail address, clear the Mailbox checkbox, and click OK.

 To switch off mail forwarding:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > Forwarding tab.
3. Clear the Switch on mail forwarding checkbox, and click OK.

Creating Mail Aliases
 To add or remove additional e-mail addresses (e-mail aliases) for a mail
account:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > E-mail Aliases tab.
3. Do any of the following:


To add an address, type it into the E-mail alias box, and click OK.



To remove an address, click the Remove link to the right of the address you want to
remove.
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Setting Up Auto-Reply
 To set up automatic reply settings for an e-mail address:
1. Go to the Mail tab > e-mail address > Auto-Reply tab.
2. Select the Switch on auto-reply checkbox, and specify the following settings:


Auto-reply message subject.



Message format. We recommend that you leave the option Plain text selected because
some of your recipients might be unable to see the text formatted with HTML.



Encoding. We recommend that you leave the UTF-8 encoding selected to ensure that
the letters in your message are displayed properly.



Message text.



Forward to. If you want to forward incoming messages to another email address, type
an email address in this box.



Send an automatic response to a unique e-mail address no more than... The default value is "1
time a day", meaning that if your mailbox receives several messages from the same
email address in one day, Panel will send automatic response only to the first
message. If the value is "2", than Panel will send automatic response to the first and
the second messages, and so on.



Attached files. If you want to attach a file to your message, click Browse and select a
file.

3. Click OK.
To switch off automatic reply, deselect the Switch on auto-reply option and click OK.

Protecting from Spam
 To switch on spam filtering for a mailbox:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > Spam Filter tab.
3. Select the checkbox Switch on spam filtering for this e-mail address.
4. Specify what to do with messages classified as spam.


If you want to filter mail with the software on your local computer, select the option
Mark spam messages by adding the following text to message subject, and then specify how
spam filter should mark the messages recognized as spam. "X-Spam-Flag: YES" and
"X-Spam-Status: Yes" headers are added to the message source by default, and if
you want, the spam filter will also add a specific text string to the beginning of the
subject line and to the message body.
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If you are sure that your spam filter is accurate, you may want to set the filter to
automatically delete all incoming messages recognized as spam. To do this, select
the option Delete all spam messages.



If you are accessing your mailbox over IMAP protocol and want the spam filter to
move all messages considered spam to the IMAP folder called Spam, select the
option Move spam to the Spam folder.
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Because all messages are automatically removed from the Spam folder after 30 days,
you will need to review the contents of the Spam folder on a regular basis to make
sure you do not miss any important messages, and move all non-spam messages
back to the Inbox folder.
When the option Move spam to the Spam folder is selected, you can train the spam filter
and improve its accuracy by moving spam messages from Inbox to Spam, and nonspam messages from Spam to Inbox.

5. If you want to adjust spam filter sensitivity, click Show Advanced Settings, and
type a number of points that a message must score to be considered spam.
SpamAssassin performs a number of different tests on contents and subject line of each
message. As a result, each message scores a number of points. The higher the number,
the more likely a message is spam. For example, a message containing the text string
"BUY VIAGRA AT LOW PRICE!!!" in subject line and message body scores 8.3 points.
By default, the filter sensitivity is set so that all messages that score 7 or more points are
classified as spam.


If you receive lots of spam messages with the current setting, to make filter more
sensitive, try setting a lesser value in the Spam filter sensitivity box; for example, 6.



If you are missing your e-mails because your spam filter thinks they are junk, try
reducing filter sensitivity by setting a higher value in the Spam filter sensitivity box.

Note: To further improve spam filter accuracy, you may want to train your spam filter on
e-mail messages you receive, as described further in this section.

6. If you want to be sure that you will not miss e-mail from specific senders,
type e-mail addresses or domain names into the White list field.
Place each address in one row, or separate addresses with a coma, a colon, or a white
space. You can use an asterisk (*) as a substitute for a number of letters, and question
mark (?) as a substitute for a single letter. For example: address@mycompany.com,
user?@mycompany.com, *@mycompany.com. Specifying *@mycompany.com will add
to the white list all e-mail addresses that are under the mycompany.com mail domain.

7. If you do not want to receive e-mail from specific domains or individual
senders, type e-mail addresses or domain names into the Black list field.
Place each address in one row, or separate addresses with a coma, a colon, or a white
space. You can use an asterisk (*) as a substitute for a number of letters, and question
mark (?) as a substitute for a single letter. For example: address@spammers.net,
user?@spammers.net, *@spammers.net. Specifying *@spammers.net will block the
entire mail domain spammers.net.

8. If you use a Windows-based customer account, then you can also specify
trusted languages and character sets. E-mail messages written in the
specified languages and with the defined character sets will pass the spam
filter and will not be marked as spam.
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9. On Windows-based customer accounts, you can also specify IP addresses of
computers or networks from which e-mail must always be accepted. When
specifying network addresses, type an address and add a network mask
after a slash. For example, 192.168.10.10/24.
10. Click OK.
You can improve accuracy of spam detection if SpamAssassin spam filter on the server is
switched on for your account and you are accessing your mailbox over IMAP protocol.

 To improve accuracy of spam detection:
1. Access your mailbox with webmail or a mail client program on your
computer.
2. Review the messages in your Inbox folder. Move all spam messages to the
Spam folder. This will make the SpamAssassin spam filter recognize spam
more efficiently.
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Protecting from Viruses
To defend your system from viruses, do not open suspicious e-mail attachments, enable
antivirus protection on the server side, if this service is provided by your hosting company,
and be sure to have a firewall and antivirus software installed on your personal computer.
Also keep your operating system up-to-date and timely install security hot fixes and patches.

 To switch on antivirus protection for a mailbox:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > Antivirus tab.
3. Select the checkbox Switch on antivirus protection for this e-mail address.
4. Choose the desired mail scanning mode. You can switch on scanning for
incoming mail, outgoing mail, or both.
5. Click OK.
When an infected message comes, you will be notified by e-mail. If Kaspersky Antivirus is
used by your provider, then you might be able to configure it at the Mail tab > e-mail address >
Antivirus tab.

 To switch off antivirus protection for a mailbox:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > e-mail address > Antivirus tab.
3. Clear the checkbox Switch on antivirus protection for this e-mail address.
4. Click OK.
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Additional Services
Some email-related web apps (like webmail or antispam) are able to provide a part of their
functionality right in your Control Panel. For example, you can associate a mail account with
an account in the Open-Xchange webmail. In this case, the mail user will see the link to
webmail right in their Control Panel.
To integrate an app in such a way, you should allow these app to access a certain mail
account. You can do this on the mail account settings page during the account creation or
editing.

 To allow certain apps to access an email account:
1. Go to the Mail tab > select an email address > Additional Services tab.
2. In the list of installed apps that provide email-related services, select the
Granted option for the apps that should access this email account.
3. Click OK.

 To deny certain apps to access an email account:
1. Go to the Mail tab > select an email address > Additional Services tab.
2. In the list of installed apps that provide email-related services, select the
Denied option for the apps that should not access this email account.
3. Click OK.
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(Advanced) Configuring Global Mail Settings
You can configure the following mail service settings that apply to all domains created under
a subscription:


Mail service status. You can switch the mail service on or off. If the mail service is
switched off, then e-mail messages cannot be sent or received.



Mail bounce settings. When somebody sends an e-mail message to an e-mail address
that does not exist under your domain, the mail server, by default, accepts mail,
processes it, and when it finds out that there is no such a recipient under the domain, it
returns the mail back to sender with an error message. You can choose to:





Continue returning all such mail back to senders (Bounce with message option),



Forward all such mail to the specified e-mail address (Forward to address option),



Forward all such mail to another mail server with the specified IP address using the
option Redirect to external mail server with IP address (available only for Windows hosting),



Reject such mail without accepting it and without notifying senders (Reject option).

Webmail. If your service plan provides the option to choose which webmail program to
use for your account, then you can select it in the global mail settings.

 To configure the mail service settings:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab, and then click Change Settings.
3. Select the required options, and click OK.
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Using Mailing Lists
Mailing list is a group e-mail address to which a number of users are subscribed. Mailing lists
are used for sending e-mail messages to multiple recipients at once. E-mail messages sent
to mailing list subscribers can include anything from plain text to colorful newsletters and
promotions with embedded images and links, and attached multimedia and presentation
materials.
How it all works: you create a mailing list e-mail address in the Panel, and subscribe users to
it. Then you send your message to the mailing list address, and all subscribers receive it.

 To set up a mailing list and subscribe users to it:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > Mailing Lists tab.
3. Click Create Mailing List.
4. Type the mailing list address and, if you have several websites, select the
website under which the mailing list will be created.
5. To subscribe users to the mailing list, type their e-mail addresses, one
address per line.
6. To notify the mailing list administrator about mailing list creation, select the
checkbox Notify administrator on the mailing list creation.
7. Click OK.

 To subscribe or unsubscribe users:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > Mailing Lists tab.
3. Click the mailing list address.
4. Do any of the following:


To subscribe users to the mailing list, type their e-mail addresses into the Subscribers
field, one address per line.



To unsubscribe users, remove their addresses from the Subscribers field.

5. Click OK.
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 To remove a mailing list:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Mail tab > Mailing Lists tab.
3. Select a checkbox corresponding to the mailing list you want to remove and
click Remove.
4. To confirm removal, click Yes.

 To switch off the mailing lists service and all mailing lists created under the
currently selected subscription:
1. Go to the Mail tab > Mailing Lists tab.
2. Click Switch Off the Service.

 To switch on the mailing lists service for the currently selected subscription:
1. Go to the Mail tab > Mailing Lists tab.
2. Click Switch On the Service.

Scheduling Tasks
If you need to run scripts on your hosting account at specific time, use the task scheduler in
the Panel to make the system automatically run the scripts for you.

Next in this section:
Scheduling Tasks (Linux) .................................................................................. 268
Scheduling Tasks (Windows) ............................................................................ 270
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Scheduling Tasks (Linux)
If you need to run scripts on your hosting account at specific time, use the task scheduler in
the Panel to make the system automatically run the scripts for you.
During installation of the Panel, the following tasks are automatically created:


autoreport.php – delivers daily, weekly and monthly reports on domains (three
separate tasks)



backupmng – initiates scheduled backing up of domains once every 30 minutes



statistics – generates statistics on resource usage by domains



mysqldump.sh - creates a backup copy of three MySQL databases: psadump, MySQL,
and Horde databases

As all these tasks are related to statistics, databases, and reports, it is strongly
recommended that you neither change nor remove them.

 To schedule a task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Click Schedule New Task.
4. Leave the Switched on checkbox selected.
5. Specify when to run your command:


Minute - enter the value from 0 to 59



Hour - enter the value from 0 to 23



Day of the month - enter the value from 1 to 31



Month - enter the value from 1 to 12, or select the month from a drop-down box



Day of the week - enter the value from 0 to 6 (0 for Sunday), or select the day of the
week from a menu.

You can schedule the time using the UNIX crontab entry format. In this format, you can:


Enter several values separated by commas. Two numbers separated by a hyphen
mean an inclusive range. For example, to run a task on the 4th, 5th, 6th, and 20th of a
month, type 4-6,20.



Insert an asterisk to specify all values allowed for this field. For example, to run a task
daily, type * in the Day of the month text box.

To schedule the task to run every Nth period, enter the combination */N, where N is a
value for this field (minute, hour, day, month). For example, */15 in the Minute field
schedules the task to start every 15 minutes.
You can type the contracted names of months and days of the week, which are the first
three letters: Aug, Jul, Mon, Sat, and so on. However, the contracted names cannot be
separated with commas or used together with numbers.
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6. Specify which command to run. Type it into the Command input box.
For example, if you want to run the backup creation task at the specified time and have
the backup file sent to your e-mail, you need to specify the following command in the
Command input box:
/usr/local/psa/admin/sbin/backupmng

7. Click OK.

 To receive notifications when the tacts are started:
1. Go to the Websites & Domains tab > Scheduled Tasks.
2. Click Settings and specify the notification policy.

 To temporarily suspend execution of a scheduled task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Locate the task that you want to suspend and click the corresponding link in
the Command column.
4. Clear the Switched on checkbox and click OK.

 To resume execution of a scheduled task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Locate the task whose execution you want to resume and click the
corresponding link in the Command column.
4. Select the Switched on checkbox and click OK.

 To cancel a task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Select a checkbox to the left of the task that you want to cancel and click
Remove.
4. Confirm removal and click OK.
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Scheduling Tasks (Windows)
If you need to run scripts on your hosting account at specific time, use the task scheduler in
the Panel to make the system automatically run the scripts for you.
During installation of the Panel, the following tasks are automatically created:


Update antivirus database – updates Parallels Premium Antivirus database.



Statistics calculation - generates statistics on resource usage, such as traffic and disk
space.

As all these tasks are related to site statistics, databases and reports, it is strongly
recommended that you neither change nor remove them.

 To schedule a task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Click Schedule New Task.
4. Leave the Switched on checkbox selected if you want your scheduled task to
be active immediately after the creation.
5. Type a name for your task in the Description field.
6. In Scheduler notification, specify whether the scheduler should notify you when
it runs this task. The following options are available:


Switched off - do not notify you.



Send to the default e-mail - send the notification to your default e-mail address.



Send to the e-mail I specify - send the notification to the e-mail specified in the
corresponding field. After selecting this option, you need to type the required e-mail
address in the field on the right.

7. Specify which command or executable file to run. Type it into the Path to
executable file input box. If you need to run the command with certain options,
type them in the Arguments field.


For example, if you want to run the statistics calculation task to count disc space and
see more detailed information for the example.com and example.net domains, you
need to specify the following path in the Path to executable file input box:
C:\Program Files\Parallels\Parallels
Panel\admin\bin\statistics.exe
and the following options in the Arguments field:
--disk-usage --process-domains=example.com, example.net –
verbose
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If you want to run your own PHP script using the task scheduler, you need to specify
the following path in the Path to executable file input box:
C:\Program Files (x86)\Parallels\Parallels
Panel\Additional\PleskPHP5\php.exe
and specify the script location in the Arguments field:
C:\Inetpub\vhosts\mydomain.tld\httpdocs\myscript.php

8. Select the appropriate priority in the Task priority field. Task priority can be set
to Low, Normal or High.
9. Specify when to run your command by selecting the appropriate checkboxes
in the Hours, Days of month, Months or Days of week fields.
10. Click OK to schedule the task or click Run Now to schedule the task and
immediately run it.

 To temporarily suspend execution of a scheduled task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Choose a task that you want to suspend and click the corresponding link in
the Description column.
4. Clear the Switched on checkbox.
5. Click OK.

 To resume execution of scheduled task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
3. Choose a task whose execution you want to resume and click the
corresponding link in the Description column.
4. Select the Switched on checkbox.
5. Click OK.

 To cancel a task:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Websites & Domains tab > Scheduled Tasks.
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3. Select a checkbox to the left of the task that you want to cancel and click
Remove.
4. Confirm removal and click OK.

Website Databases
If your website incorporates custom data processing applications or is designed to generate
web pages dynamically, you will probably need a database for storing and retrieving data.
In Panel, you can manually create a new database (on page 273) for your site, make a
database copy (on page 274) and manage database user accounts (on page 275). These
operations are available in Websites & Domains tab > Databases. In addition, you can use the
third-party database management tools supplied with Panel to edit tables in databases,
export and import data (on page 274), and run SQL queries. These tools are available under
the Webadmin link in Websites & Domains tab > Databases and may vary depending on the
database type. For example, Panel employs phpMyAdmin to manage MySQL databases.
Note that when you install an app from the Application Catalog, all required databases and
database user accounts are created automatically. Alternatively, you can assign a manually
created user account to a database created by a web app. For more information, see the
section Using Website Applications > App Databases.

Accessing Databases with ODBC
If you wish to deploy an application which works with a database through an Open Database
Connectivity (ODBC) driver, you will need to create an appropriate ODBC data source in the
operating system. In Panel for Windows you can add new ODBC data sources for a number
of supported ODBC drivers. For more information, see Accessing Databases with ODBC
(Windows) (on page 276).
For the details on operations with databases and database users, refer to the relevant
sections of this chapter.

Next in this section:
Creating Databases........................................................................................... 273
Accessing Databases ........................................................................................ 273
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Accessing Databases with ODBC (Windows) .................................................... 276
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Creating Databases
Panel allows you to create and remove databases on the Websites & Domains tab > Databases
page.
You can create a database by specifying its name. If your subscription grants you the
corresponding permission, you can choose a database type and the database server on
which the database should be created.
A database must have at least one user account associated with it. Otherwise, it will be
impossible to access the database. You can create a database user while creating a
database by selecting the Create a new database user checkbox. Alternatively, you can clear the
checkbox and select a user later, for example, if you want to use one of the existing user
accounts. For more information, see Database User Accounts (on page 275).
Note that you can only remove the databases and database users that are not used by APS
apps. If the required checkbox appears grayed out, it means that this database is used by an
app and you can remove it only by removing the respective app.

Accessing Databases
After you have created a database and assigned a database user to it, you can access it
from Panel using the Webadmin link on the Websites & Domains tab > Databases page. In this
case, Panel automatically uses the corresponding database user credentials.
If you want to access your database using other tools (like SQL Server Management Studio)
or want to give other applications access to it, you will need to provide these tools and
applications with the following:


To connect to MySQL and PostgreSQL, you will need to provide the host name (or IP
address) and the database user login and password.



To connect to Microsoft SQL Server, you will also need to specify the Microsoft SQL
Server instance. For Microsoft SQL Server 2008, Panel uses the MSSQLSERVER2008
named instance. Therefore, the host can be specified as
mydomain.com\MSSQLSERVER2008 or 123.123.123.123\MSSQLSERVER2008. For
Microsoft SQL Server 2005, Panel uses the default instance (MSSQL 2005), and you do
not need to specify the instance name.
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Copying Databases
Panel allows you to copy databases from one database server registered in Panel to
another, as well as to any remote server, provided that the source and the destination
servers are of the same type, for example, MySQL.
You can copy a database by running Websites & Domains > Databases > Copy for this database
and specifying the destination server, the subscription and the database name. For a remote
server, you should select Other in the Database destination server list and provide the following
additional information:


Host name or IP address of the remote database server.



Username and password of the remote database server’s administrator. For example,
the MySQL administrator’s credentials.

Note: When you choose an existing database as a destination, those tables in the
destination database whose names also appear in the source database will be fully replaced.

Types of Copy
When you copy a database, you can choose whether to create a full database copy including
data in the tables (the Create a full copy option), or to copy only the database structure. In the
latter case, Panel will create tables without data in the destination database.

Exporting and Importing Databases
With Panel, to export a database means to save a source database in a file which can be
used for storage or distribution. To import a database means to restore data from the file to a
destination database. You can import a database to the same or another database server.
The only restriction is that the destination database should be of the same type, for example,
MySQL.
One reason for exporting databases is to back them up. While Panel for Windows offers a
separate functionality for backing up databases (on page 282), on Panel for Linux, exporting
is the only option for creating separate database backup files.
The export and import functionality is provided by the database management tool available
through the Webadmin link in Websites & Domains > Databases.
Note: It is recommended that you import data into a new database.
For the instructions on how to perform import and export with database management tools,
refer to the tools' built-in help sections.
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Managing Database User Accounts
When you work with a database in Panel, the latter accesses the database on behalf of a
user account associated with the database. Therefore, every database should have at least
one associated user account; otherwise, you will be unable to access it.
Any database user can be set as default for a certain database. Panel will always access the
database using this default user even if there are other users associated with it. If a database
has several associated user accounts, none of which are default, the first account from the
list will be used.

Types of Database Users
There are two types of database user accounts in Panel:


User accounts which have access to only one particular database.
If you collaborate with other people on managing a website and wish to give them access
to the database, you should create separate user accounts for them. Each of these
accounts is used to access only one database. In this case, you first create a database
and then user accounts.



Universal user accounts which have access to all databases.
Universal users have access not only to all existing databases, but to all newly created
databases as well.
If you plan to install a number of web apps on your site, it may be convenient to create
one universal user account, so that all the apps can access their databases using this
account. In this case, you first create a user account and then specify it when installing
apps.
Note: A universal user acts only within one database server. If you use several database
servers, create a separate universal user account for each server.

Operations with Database Users
You can create, update or remove a database user by going to Websites & Domains >
Databases, and selecting the Users tab of the required subscription.
When creating a database user, you will be prompted to provide the user credentials for
accessing the database and the name of the database which the specified user will access.
A universal database user can be created by selecting Any for a Database name.
Notes:
1. You can remove a default database user only by removing the database associated with
this user. Alternatively, you can edit the user and clear the Make the user default for this
database option, and then remove the user.
2. If a database user was created by an APS app, you can remove this user only by
removing the respective app.
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Accessing Databases with ODBC (Windows)
If your application needs to access external databases through ODBC, you can create the
necessary ODBC connection in Panel. After you have created the ODBC connection, you
can customize the application to use that ODBC connection to access information in the
database.
Note that the database does not necessarily need to be external; ODBC can be used to
access local databases as well.

Operations with ODBC Connections
You can create, change or remove ODBC connections on the Websites & Domains >
<domain_name> > ODBC Data Sources page.
When you create an ODBC connection, you should provide the connection name and
description as well as the required driver. Depending on the selected driver, you will be
prompted to specify some additional parameters, such as the path to the database, user
credentials, and other connection options.
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Backing Up and Recovering Websites
Unfortunately, data loss events are quite common problem today. The reasons of these
events may vary: Hardware failures, hacking attacks, and so on. To minimize the
consequences of data loss, Panel provides the back up / restore feature. During the backup
Panel saves your account configuration along with all websites content into a number of files.
You can restore the backup at any time later to recover corrupted data, or just to return Panel
to stable state.
This chapter describes how to perform the following operations in your Panel:


Back up all data related to your account and sites. Learn more in the section Backing Up
Account and Websites (on page 280).



Back up databases (Windows). Learn more in the section Backing Up Databases (Windows)
(on page 282).
Schedule backups. Learn more in the section Scheduling Backups (on page 283).




Restore data from backup archives. Learn more in the section Restoring Data (on page
286).

Next in this section:
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Backing Up Data
Depending on your needs, Panel can perform two types of backup:


Customer account configuration. Such backups have small size and are convenient for
restoring account settings in case of configuration problems.



Customer account configuration and websites content. This type of backup requires more
disk space and system resources because the Panel also saves the content of all
websites. Such full backups are the best way to prevent data loss.

You can perform backup manually at any time, or schedule it for a specific time. For
example, make the full backup once a day at night time when the number of site visits is
minimal. To get the details on scheduling backups, refer to the section Scheduling Backups (on
page 283).

Storing Backups
There are two ways of storing backups in Panel:


On the Panel-managed hosting server. All backup files are stored on your Panel server
along with other account content. Note that in this case backup files occupy the disk
space provided by your subscription.



On a remote FTP server. All backup files are stored on a remote FTP repository. In this
case, backup files do not occupy the disk space provided by your subscription. The
instructions on how to configure Panel to save backups to an FTP account are provided
below in this section.

Creating Password-protected Backups
Since Panel 11.0, you are able to secure sensitive data in your backups by protecting them
with a password. Protection makes it impossible for an attacker to reveal backup data if the
security of your external backup storage is compromised.
You can specify a backup password in the following circumstances:


In your FTP repository settings (Websites & Domains > Backup Manager > Personal FTP
Repository Settings).



When downloading a backup file from the Panel internal repository to some external
location.

When uploading these backups back to Panel and restoring them, you will be prompted to
provide the password you used for protection.
Important:
If you forget the password you used for backup protection, it cannot be recovered.
Therefore, it is strongly recommended to keep a list of your passwords and corresponding
backup file names in a safe place.
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Configuring Panel for Working with an FTP Repository
If you are going to use an FTP server for storing backup files, you should specify its settings
in Account tab > Back Up My Account and Websites > Personal FTP Repository Settings:


FTP server's IP address or host name.



Directory on the server where you want to store backup files.



User name and password for access to the FTP account.



Password that Panel will use for protecting backup files.

Next in this section:
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Backing Up Account and Websites
 To back up all data related to your account and all your subscriptions:
1. Go to the Account tab > Back Up My Account and Websites > Back Up.
2. Specify the following:


Backup file name prefix and description. You cannot specify an arbitrary file name,
however, you can set the Panel to add a prefix to backup file names. Note that the
Panel automatically adds the date and time of backup file creation (in Universal Time)
to backup file names.



Splitting of the backup file. To create a multivolume backup, select the corresponding
checkbox and specify volume size in megabytes.



Location where to store the backup file. Select the repository where you would like to
store the backup file.



E-mail notification on backup completion. If you want to be notified of the backup
completion, type your e-mail address.



What data to back up. You can back up only the account settings or account settings
and all data (including databases).



Suspend domains until backup task is completed. Select this option to prohibit users from
making changes to content or settings of websites while they are being backed up.
Note: If you select this option, then, after restoring the data from this backup file, you
will need to manually switch on every domain alias for every site that needs to
have domain aliases. This can be done at Websites & Domains tab > domain alias
name > Switch On.

3. Click Back Up.
When backing up is finished, the backup file will be saved to the repository you selected.

 To back up all websites related to a subscription:
1. If you are subscribed to several hosting packages and have access to
several webspaces associated with your account, in the Subscription menu at
the top of the screen, select the required webspace.
2. Go to the Account tab > Back Up Websites > Back Up.
3. Specify the following:


Backup file name prefix and description. You cannot specify an arbitrary file name,
however, you can set the Panel to add a prefix to backup file names. Note that the
Panel automatically adds the date and time of backup file creation (in Universal Time)
to backup file names.



Splitting of the backup file. To create a multivolume backup, select the corresponding
checkbox and specify volume size in megabytes.



Location where to store the backup file. Select the repository where you would like to
store the backup file.
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E-mail notification on backup completion. If you want to be notified of the backup
completion, type your e-mail address.



What data to back up. You can choose to back up:





Only settings of websites.



All settings and data with or without mail accounts and messages in mailboxes.



Only mail accounts with messages.
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Suspend domains until backup task is completed. Select this option to prohibit users from
making changes to content or settings of websites while they are being backed up.
Note: If you select this option, then, after restoring the data from this backup file, you
will need to manually switch on every domain alias for every site that needs to
have domain aliases. This can be done at Websites & Domains tab > domain alias
name > Switch On.

4. Click Back Up.
When backing up is finished, the backup file will be saved to the repository you selected.
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Backing Up and Restoring Databases (Windows)
If you are using a Windows-based customer account, then you can back up and
subsequently restore databases, database user accounts, and data used by your websites.
You can:


Back up your domain databases with all data and user accounts.




Restore databases from backup files.
Download, upload and remove database backup files.



Recover users who became orphaned after the restoration.

Important: Panel does not back up stored procedures, views, and triggers. The backup
utility ignores them and, therefore, they cannot be restored.

 To back up databases:
1. Go to the Websites & Domains tab > Backup Manager > Database Backup Repository.
2. Using the Database menu, select the databases you want to back up.
3. Click Back Up.
4. Specify the name of the backup file and click OK.
5. If you want to download the resulting backup file, click the file name on the
next page after the backup process was finished. Specify the location where
you want to save the file and click Save.
6. Click OK.

 To restore a database:
1. Log in to Control Panel.
2. Go to Websites & Domains tab > Backup Manager > Database Backup Repository,
select the checkbox corresponding to the backup file you want to restore and
click Restore.
If you do not have the backup file on your server, you can upload the backup file to the
server repository from your local machine.

3. Confirm the restoration by selecting the corresponding checkbox and click
OK.
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 To upload a backup file to a backup repository:
1. Go to Control Panel > Websites & Domains tab > Backup Manager > Database Backup
Repository, and click Upload Backup File.
2. In the Database name menu, select the database in whose repository you want
to upload the backup file.
3. Click Browse... and select the required backup file.
4. Leave the Restore database backup immediately upon uploading check box selected
if you want the database contents to be restored immediately after the
backup file is uploaded.
5. Click OK.
The database backup file will be uploaded to the backup repository of the specified
database.

Scheduling Backups
 To schedule backing up of data:
1. Go to the Account tab > Back Up My Account and Websites > Scheduled Backup
Settings.
2. Select the Activate this backup task checkbox and specify the following:


When and how often to run the backup.



A prefix that should be added to the backup file name.



Splitting of the backup file. To create a multivolume backup, select the respective
checkbox and specify volume size in megabytes. Note that volume size cannot
exceed 4095 megabytes.



Location where to store the backup file. Select the repository where you would like to
store the backup file.



Maximum number of backup files stored in the repository. Type a number if you want
to recycle backup files: When this limit is reached, the oldest backup files are
removed.



E-mail notification on backing up errors. If you want to send an e-mail notice when
something goes wrong during backing up, type the e-mail address you need.



What data to back up. You can back up only account settings, or account settings and
all related data.



Suspend domains until backup task is completed. Select this option to prohibit users from
making changes to content or settings of websites while they are being backed up.

3. Click OK.
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Managing Backup Files
Next in this section:
Uploading and Downloading Backup Files......................................................... 284
Uploading and Downloading Database Backup Files (Windows) ....................... 285

Uploading and Downloading Backup Files
Downloading Backup Files from Panel
To download a backup file from the Panel repository, choose the corresponding backup file
name in Account tab > Back Up My Account and Websites and specify the location for the file.
Before starting the download, Panel will prompt you to enter the backup password.

Uploading Backup Files to Panel
To upload a backup file to the Panel repository, use the Account tab > Back Up My Account and
Websites > Upload Files to Server Repository wizard. Before starting the upload, Panel will prompt
you to enter the following backup parameters:


Backup file location.



Password.
This is the password that you used for protecting the backup data. If you did not use
password-protection, leave the corresponding field blank.
Note: If the password you provide is incorrect, Panel will warn you, but will upload the
backup to the server anyway. During the backup restoration, you will be prompted to
enter the password again.

Removing Backup Files
To remove a backup file from the Panel repository, select a checkbox corresponding to the
backup file you want to remove in Account tab > Back Up My Account and Websites and сlick
Remove.
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Uploading and Downloading Database Backup Files (Windows)
 To upload a backup file to backup repository:
1. Go to the Websites & Domains tab > Backup Manager > Database Backup Repository
and click Upload Backup File.
2. Select the database in whose repository you want to upload the backup file
to in the Database name menu.
3. Click Browse... and select the required backup file.
4. Leave the Restore database backup immediately upon uploading checkbox selected if
you want the database contents to be restored immediately after the backup
file is uploaded.
5. Click OK.
The database backup file will be uploaded to the backup repository of the specified
database.

 To download a backup file from backup repository:
1. Go to the Websites & Domains tab > Backup Manager > Database Backup Repository.
2. In the Database menu, select the database whose backup files you want to
browse. Leave All domain databases selected if you want to browse backup files
of all databases on a domain.
3. Click the icon
download.

corresponding to the database backup file you want to

4. Select the location where you want to save the backup file and click Save.
The backup file will be downloaded from the backup repository.

 To remove a backup file from backup repository:
1. Go to the Websites & Domains tab > Backup Manager > Database Backup Repository.
2. In the Database menu, select the database whose backup files you want to
remove. Leave All domain databases selected if you want to browse backup files
of all databases on a domain.
3. Select a checkbox corresponding to the database backup file you want to
remove. Click Remove, confirm removal and click OK.
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Restoring Data
Next in this section:
Restoring Backups ............................................................................................ 286
Restoring Databases (Windows) ....................................................................... 287

Restoring Backups
You can restore data from backup files kept in:


The Panel internal repository.
To restore backup files from Panel repository, choose the backup file name you want to
restore on the Account tab > Back Up My Account and Websites > Server Repository tab.



An external FTP repository.
To restore backup files from Panel repository, choose the backup file name you want to
restore on the Account tab > Back Up My Account and Websites > Personal FTP Repository tab.

After you choose the backup file, Panel will start the restoration wizard. You will be prompted
to specify the following restoration parameters:


Types of data to be restored.



Suspend website until restoration task is completed. Select this if you want to avoid possible
conflicts that may occur when users modify site content or settings while they are being
restored.



Send an e-mail notice when restoration task is completed. Type your e-mail address if you want
the control panel to notify you when restoring is completed.
Conflicts resolution policy. Specify what to do if any conflicts occur during restoration.




Backup security settings. If the backup was protected with a password, enter the password
into the Password field. Note that Panel is unable to check whether the password you
enter is wrong: The backup will be successfully restored but the data will be corrupted.
If you wish to reset user passwords, clear the Provide the passwords option.

If any errors or conflicts occur during restoration of data, the wizard will prompt you to select
an appropriate resolution. Follow the instructions provided on the screen to complete the
wizard.
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Restoring Databases (Windows)
 If the database already exists and you only need to restore its contents:
1. Go to the Websites & Domains tab > Backup Manager > Database Backup Repository.
2. Select the required backup file from the list and click Restore Selected.
If you do not have the backup file on the server, you can upload the backup file to the
server repository from your local machine. For more information, refer to the section
Uploading, Downloading, and Removing Database Backup Files.

3. Confirm the restoration by selecting the corresponding checkbox and click
OK.
If you are restoring an MS SQL database, there is a possibility that some database users
will be orphaned. In order to provide the ability to access and use the database for these
users, you need to repair them. For more information, refer to the section Recovering
Orphaned Database Users.

Next in this section:
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Post-Restoration Database Repair
If you are restoring an MS SQL database, there is a possibility that some database users will
be orphaned. In order to provide the ability to access and use the database for these users,
you need to repair them.

 To check if a database has orphaned users and to repair them:
1. Go to Websites & Domains tab > Databases > database name.
2. If you see a warning saying that there are several orphaned users that
should be repaired in order to function properly, you have orphaned users
who need to be repaired.
3. To repair orphaned users, click the Repair now button corresponding to the
users you want to repair.
4. Provide password for the users and click Repair.
If a user is supposed to be a system user without a password, run repair with empty
password field.

